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1 GETTING STARTED 1.1 IMPORTANT PROCEDURES

1
1 GETTING STARTED 1.1IMPORTANT PROCEDURES 1.1.1 CAUTIONS AND WARNINGS

To help ensure years of trouble free operation, please read through the following chapter for informa-
tion to help guide you through the initial installation procedures of your new relay.

BEFORE ATTEMPTING TO INSTALL OR USE THE RELAY, IT IS IMPERATIVE THAT ALL WARNINGS
AND CAUTIONS IN THIS MANUAL ARE REVIEWED TO HELP PREVENT PERSONAL INJURY,
EQUIPMENT DAMAGE, AND/OR DOWNTIME.
CAUTION: THE OPERATOR OF THIS INSTRUMENT IS ADVISED THAT IF THE EQUIPMENT IS USED IN
A MANNER NOT SPECIFIED IN THIS MANUAL, THE PROTECTION PROVIDED BY THE EQUIPMENT
MAY BE IMPAIRED

Figure 1–1: FRONT VIEW OF F650 UNITS

a) COMMUNICATION BOARDS WITHDRAWAL / INSERTION

WARNING: MODULE WITHDRAWAL AND INSERTION SHALL ONLY BE PERFORMED BY DULY QUAL-
IFIED SERVICE PERSONNEL. FOR PERSONAL SECURITY PURPOSES, BEFORE ACCOMPLISHING
ANY WITHDRAWAL OR INSERTION OPERATION, THE RELAY MUST BE POWERED OFF AND ALL
THE REAR TERMINALS MUST BE POTENTIAL FREE. THE RELAY MUST BE GROUNDED USING THE
REAR GROUNDING SCREW.

The modular design of the relay allows withdrawal and insertion of the communication module.

Figure 1–2:: MODULE WITHDRAWAL/INSERTION shows the location of communication modules on the rear part of the
relay. Skilled personnel must carry out the insertion or extraction of communication boards only after interrupting the relay
auxiliary voltage and ensuring that all the rear terminals are potential free.



1-2 F650 Digital Bay Controller GE Multilin

1.1 IMPORTANT PROCEDURES 1 GETTING STARTED

1
Communication boards are installed on the rear of the unit, the upper port being reserved for the asynchronous
communications board and CAN, and the lower port for the ETHERNET board in any of its configurations.

Figure 1–2: MODULE WITHDRAWAL/INSERTION

Before performing any of these actions, control power must be removed from the relay and all the relay rear terminals
must be potential free. A grounded antistatic wristband must be used when manipulating the module in order to avoid
electrostatic discharges that may cause damage to the electronic components.

WITHDRAWAL: Loose the small screws that keep the faceplate in place and extract the module. 

INSERTION: Insert the module and press it firmly in the case, until it is completely fixed. After this, bolt the faceplate
screws and replace the control power. Check that the relay is fully operative.

GE Multilin will not be responsible for any damage in the relay, connected equipment or personnel whenever this safety
rules are not followed.
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b) MAGNETIC MODULE TERMINALS

Figure 1–3: REAR VIEW OF F650 UNIT

GE Multilin will not be responsible for any damage in the relay, connected equipment or personnel 
whenever this safety rules are not followed.

Magnetic Module for AC 
Currents and Voltage Inputs 
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1.1.2 INSPECTION CHECKLIST

Open the relay packaging and inspect the relay for physical damage.

Refer to the label on the side of the relay verifies that the model number is the correct model ordered.

Figure 1–4: IDENTIFICATION LABEL (A4455P6)

- Please ensure that you receive the following items with your relay:

• Mounting screws for rear terminals and for fixing the relay to a cabinet

• CD containing EnerVista F650 Setup software

• Wiring diagram

• Certificate of Compliance

For product information, instruction manual updates, and the latest software updates, please visit the GE
Multilin Home Page www.geindustrial.com/multilin.
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Note: If there is any physical damage detected on the relay, or any of the contents listed are missing, please 

contact GE Multilin immediately at:

EUROPE, MIDDLE EAST AND AFRICA:

GE MULTILIN

Av. Pinoa, 10

48170 Zamudio, Vizcaya (SPAIN)

Tel.: (34) 94-485 88 54, Fax: (34) 94-485 88 38

E-mail: multilin.tech.euro@ge.com

AMERICA, ASIA AND AUSTRALIA:

GE MULTILIN

215, Anderson Avenue

L6E 1B3 Markham, ON (CANADA)

Tel.: +1 905 294 6222, Fax: +1 905 201 2098

E-mail: multilin.tech@ge.com

The information provided herein does not intend to cover all details of variations of the equipment nor does it take 
into account the circumstances that may be present in your installation, operating or maintenance activities.

Should you wish to receive additional information, or for any particular problem that cannot be solved by referring 
to the information contained herein, please contact GENERAL ELECTRIC MULTILIN.
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1.1.3 SAFETY INSTRUCTIONS

The F650 ground screw shown in Figure 1–5:: LOCATION OF GROUNDING SCREW must be correctly
grounded.

Figure 1–5: LOCATION OF GROUNDING SCREW

Before establishing the communication with a F650 unit through the front serial port, please ensure that the computer is
grounded.

In case of using a laptop, it is recommended not to have it connected to its power supply. The reason for this is that in many
cases it might not be correctly grounded either due to the power supply or to the connector cables used. 

This is required not only for personal protection, but also for avoiding a voltage difference between the relay serial
port and the computer port, which could produce permanent damage either to the computer or the relay.

GE Multilin will not be responsible for any damage in the relay or connected equipment whenever this elemental
safety rule is not followed. 
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1.2OVERVIEW 1.2.1 INTRODUCTION TO 650 FAMILY OF RELAYS

This platform of relays has been designed to meet the goals that are appearing nowadays in the environment of new
substations.

Historically, protection, control and metering functions have been performed by electromechanical elements at the
beginning, then static devices, and finally by digital equipment able to integrate all these functions in a single device, called
IED (Intelligent Electronic Device).

These IEDs not only must be able to perform all functions related to system protection and control, but also, using high
speed communications, they must share information among them and send this information to control dispatch centers,
thus reducing the quantity of auxiliary elements and wiring up to 70%.

The F650 relay belongs to this new generation of devices, and can be easily incorporated in substation automation
schemes.

1.2.2 HARDWARE ARCHITECTURE

F650 units incorporate a series of interconnected modules to perform protection and control functions. Firstly, it includes a
group of AC transformers for retrieving current and voltage. These magnitudes, once digitized, are sent to a digital signal
processor (DSP), which performs metering functions and communicates with the main processor via a wide band bus. This
architecture liberates the main processor from performing real time metering, allowing a high sampling rate, of up to 64
samples per cycle, without interfering with global performance.

F650 relays are digital devices that include a CPU that can control multiple types of input and output signals.

Figure 1–6: F650 CONCEPT BLOCK DIAGRAM

Contact Inputs/Outputs are signals associated to physical input/output contacts in the relay

Analog Inputs are signals coming from the inputs of current and voltage transformers, used for monitoring the
power system signals.

Remote CAN Bus Inputs/Outputs: are signals associated to physical input/output contacts from independent
modules connected to the 650 unit via a fiber optic CAN Bus.

PLC: Programmable Logic Controller. Control module that enables the unit configuration (assignment of
inputs/outputs) and the implementation of logic circuits.

Protection Elements: Relay protection elements, for example: Overcurrent, overvoltage, etc. 

       INPUTS           CPU   OUTPUTS 

BUS CAN BUS CAN 

LAN

Protection Elements 

PLC
(logic) 

Virtual Outputs 

Contact Outputs 

Remote CAN Bus 
Outputs

Virtual Inputs 

Contact Inputs 

Analog inputs 
Voltage & Current 

Remote CAN Bus 
Inputs
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1.2.3 SOFTWARE ARCHITECTURE

The firmware (software embedded in the relay) has been designed using object oriented programming
techniques (OOP). These techniques are based on the use of objects and classes, and provide the software
architecture with the same characteristics as the hardware architecture, i.e., modularity, scalability and
flexibility.

1.2.4 COMMUNICATIONS ARCHITECTURE

The main processor performs protection, control, and communication functions, incorporating two internal pro-
cessors, one for generic use and a second one dedicated for communications.

A dedicated serial port is used for communication between the main processor and the human-machine inter-
face. Serial connection provides great immunity against electromagnetic disturbances, thus increasing system
safety.

All F650 units incorporate an RS232 serial port on the front of the relay. There is also a possibility to incorpo-
rate up to two additional communication modules on the rear.

One of the modules provides asynchronous serial communications, using different physical media (RS485,
plastic or glass fiber optic) depending on the selected model. The module incorporates two identical ports,
COM1 and COM2. COM2 port is multiplexed with the front port. Additionally, this module may incorporate a
glass fiber optic port for CAN BUS communications, used for the connection to the Remote CAN BUS I/O mod-
ule. This feature allows increasing up to 100% the I/O capability, when the maximum number of I/Os available
inside the relay (up to 32 inputs and 16 outputs) is not enough for a specific application.

Available options are:
Table 1–1: TABLE  1-1 REAR SERIAL COMMUNICATIONS BOARD 1

The other module provides Ethernet communications (COM3 port), using 10/100BaseTX (self-negotiable speed) or
100BaseFX connectors, depending on the selected model. Most complete models include a double redundant 100BaseFX
fiber optic port. Redundancy is provided at a physical media level; the unit incorporates internally duplicated and
independent controllers for extended system reliability and accessibility.

Board Code Functionality

F Without additional communication ports

A Two RS485 ports

P Two Plastic F.O. ports

G Two Glass F.O. ports

X Two RS485 ports and a CAN port for remote CAN Bus Inputs/Outputs 

Y Two Plastic F.O. ports and a CAN port for remote CAN Bus Inputs/Outputs 

Z Two Glass F.O. ports and a CAN port for remote CAN Bus Inputs/Outputs 
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Available Options are:
Table 1–2: REAR ETHERNET COMMUNICATIONS BOARD 2

For options C and D it is required to select the active physical media, by means of an internal selector inside the module.
The factory configuration for this selection is the 10/100BaseTX port. 

Finally, internal communication with input and output modules is performed via an internal CAN bus, independent from the
one used for remote CAN BUS I/Os. This fact provides increased communication speed, as well as the possibility of
acknowledgement of modules, abnormalities, etc. As this is a serial port supporting a communications protocol, it provides
extraordinary immunity against external or internal disturbances.

Figure 1–7: COMMUNICATIONS ARCHITECTURE (B6816F1)

Board 
Code

Functionality

B One 10/100BaseTX port (self-negotiable speed)

C One 10/100BaseTX port and one 100BaseFX port.

D One 10/100BaseTX port and two 100BaseFX ports
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1.3ENERVISTA 650 SETUP SOFTWARE 1.3.1 SYSTEM REQUIREMENTS

The EnerVista F650 Setup software interface is the preferred method to edit settings and view actual values
because the PC monitor can display more information in a simple comprehensible format.

The following minimum requirements must be met for the EnerVista F650 Setup software to properly operate 
on a PC: 
• Pentium® class or higher processor (Pentium® II 300 MHz or higher recommended)

• Windows® NT 4.0 (Service Pack 3 or higher), Windows® 2000, Windows® XP

• Internet Explorer® 5.0 or higher

• 64 MB of RAM (128 MB recommended)

• 40 MB of available space on system drive and 40 MB of available space on installation drive

• RS232C serial and Ethernet port for communications to the relay

1.3.2 INSTALLATION

After ensuring the minimum requirements for using EnerVista F650 Setup are met (see previous section), use 
the following procedure to install the EnerVista F650 Setup from the GE EnerVista CD.

1. Insert the GE EnerVista CD into your CD-ROM drive.

2. Click the Install Now button and follow the installation instructions to install the no-charge EnerVista software.

3. When installation is complete, start the EnerVista Launchpad application.

4. Click the IED Setup section of the Launch Pad window.

Figure 1–8: LAUNCHPAD WINDOW

5. In the EnerVista Launch Pad window, click the Add Product button and select the “F650 Bay Controller” relay from the
Install Software window as shown below. Select the “Web” option to ensure the most recent software release, or select
“CD” if you do not have a web connection, then click the Add Now button to list software items for the F650.
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Figure 1–9: ADD PRODUCT WINDOW

6. If “Web” option is selected, chose the F650 software program and release notes (if desired) from the list and click the
Download Now button to obtain the installation program. 

Figure 1–10: WEB UPGRADE WINDOW

7. EnerVista Launchpad will obtain the installation program from the Web or CD. Once the download is complete, double-
click the installation program to install the EnerVista F650 Setup software.

8. Select the complete path, including the new directory name, where the EnerVista F650 Setup will be installed.
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9. Click on Next to begin the installation. The files will be installed in the directory indicated and the installation program

will automatically create icons and add EnerVista F650 Setup to the Windows start menu.

10. Follow the on-screen instructions to install the EnerVista F650 Setup software. When the Welcome window appears,
click on Next to continue with the installation procedure. 

Figure 1–11: ENERVISTA F650 SETUP INSTALLATION

11. When the Choose Destination Location window appears, and if the software is not to be located in the default
directory, click Change… and type in the complete path name including the new directory name and click Next to
continue with the installation procedure.

Figure 1–12: ENERVISTA F650 SETUP INSTALLATION CONT.
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12. The default program group where the application will be added to is shown in the Selected Program Folder window.

Click Next to begin the installation process, and all the necessary program files will be copied into the chosen directory. 

Figure 1–13: SELECT PROGRAM FOLDER

13. To finish with the installation process, select the desired language for startup.

Figure 1–14: LANGUAGE WINDOW

14. Click Finish to end the installation. The F650 device will be added to the list of installed IEDs in the EnerVista
Launchpad window, as shown below.
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Figure 1–15: ENERVISTA LAUNCHPAD

1.3.3 CONNECTING WITH THE UNIT

This section is intended as a quick start guide to using the EnerVista F650 Setup software. Please refer to sec-
tion 4.1  in this manual for more information about the EnerVista F650 Setup software interface.

a) CONFIGURING AN ETHERNET CONNECTION

Before starting, verify that the Ethernet network cable is properly connected to the Ethernet port on the back of
the relay. 

1. Install and start the latest version of the EnerVista F650 Setup software (available from the GE
EnerVista CD or online from http://www.GEindustrial.com/multilin (see previous section for instal-
lation instructions).

2. Go to “Communication>Computer” and enter the following data referred to communications:

3. Select Control Type as MODBUS TCP/IP from the drop-down list. This option will display a num-
ber of interface parameters that must be entered for proper Ethernet communications.

4. Enter the relay IP address (from “Setpoint>Product Setup >Communication Settings>Net-
work>IP ADDRESS”) in the IP Address field in MODBUS TCP/IP SETUP.

5. Enter the relay ModBus address (from “Setpoint>Product Setup >Communication Set-
tings>ModBus Protocol>ModBus Address COM1/COM2 setting”) in the Unit Identifier (Slave
Address) field.

6. Enter the ModBus port address  (from “Setpoint>Product Setup >Communication Set-
tings>ModBus Protocol>ModBus Port Number” setting) in the ModBus Port field.

7. The Device has now been configured for Ethernet communications. Proceed to press the ON but-
ton to begin communicating.
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b) CONFIGURING AN RS232 CONNECTION

Before starting, verify that the RS232 serial cable is properly connected to the RS232 port on the front panel of
the relay.

1. Install and start the latest version of the EnerVista F650 Setup software (available from the GE
EnerVista CD or online from http://www.GEindustrial.com/multilin (see previous section for instal-
lation instructions).

2. Go to “Communication>Computer” and enter the following data referred to communications:

3. Select Control Type as No Control Type from the drop-down list. This option will display a number
of interface parameters that must be entered for proper serial communications.

4. Enter the relay Slave Address (“Setpoint>Product Setup >Communication Settings>ModBus
Protocol” menu) in the Slave Address field.

5. Enter the physical communications parameters (Baudrate and parity settings) from “Set-
point>Product Setup >Communication Settings>Serial Ports” menu, in their respective fields.

6. The Device has now been configured for RS232 communications. Proceed to press the ON but-
ton to begin communicating.

1.3.4 COMMUNICATIONS

To communicate with the relay via the faceplate RS232 port, a standard “straight through” serial cable is used. The DB9
male end is connected to the relay and the DB9 or DB25 female end is connected to the PC COM1 or COM2 port as
described in the figure below.

Direct connection to the Ethernet port will be carried out using a crossover cable. If this connection is performed through a
hub or switch, we will use direct Ethernet cable.

To communicate with the relay rear RS485 port from a computer RS232 port, an RS232/RS485 converter box is needed.
We recommend using the F485 converter, manufactured by GE. This converter box is connected to the computer using a
straight through serial cable. A shielded twisted pair (20, 22 or 24 AWG according to the American standards; 0.25, 0.34 or
0.5 mm2 according to the European standards) cable is used to connect the converter box to the relay rear communications
terminals. In order to minimize communication errors that could be caused by external noise, it is recommended to use a
shielded twist pair. In order to avoid loops where external currents could flow, the cable shield must be grounded only at
one end.

The converter box (-, +, GND) terminals are connected to the relay (SDA, SDB, GND) terminals respectively. For long
communications cables (longer than 1 km), the RS485 circuit must be terminated in a RC network (i.e. 120 ohm, 1 nF). This
circuit is shown on Figure 1–17:: RS485 CONNECTION FOR F650 UNITS, associated to text Zt(*).
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enervista 650 setup

Figure 1–16: RELAY- PC CONNECTION FOR RS232 FRONT PORT

To minimize errors from noise, the use of shielded twisted pair wire is recommended. For a correct operation, polarity must
be respected, although if it is not so, there is no danger to damage the unit. For instance, the relays must be connected with
all RS485 SDA terminals connected together, and all SDB terminals connected together. This may result confusing
sometimes, as the RS485 standard refers only to terminals named “A” and “B”, although many devices use terminals
named “+” and “-“. 

As a general rule, terminals “A” should be connected to terminals “-“, and terminals “B” to “+”. The GND terminal should be
connected to the common wire inside the shield, when provided. Otherwise, it should be connected to the shield. Each
relay should also be daisy chained to the next one in the link. A maximum of 32 relays can be connected in this manner
without exceeding driver capability. For larger systems, additional serial channels must be added. It is also possible to use
commercially available repeaters to increase the number of relays on a single channel to more than 32. Do not use other
connection configuration different than the recommended.

Lightning strikes and ground surge currents can cause large momentary voltage differences between remote ends of the
communication link. For this reason, surge protection devices are internally provided. To ensure maximum reliability, all
equipment should have similar transient protection devices installed.
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Figure 1–17: RS485 CONNECTION FOR F650 UNITS



1-18 F650 Digital Bay Controller GE Multilin

1.3 ENERVISTA 650 SETUP SOFTWARE 1 GETTING STARTED

1



GE Multilin F650 Digital Bay Controller 2-1

2 PRODUCT DESCRIPTION 2.1 OVERVIEW

2

2 PRODUCT DESCRIPTION 2.1OVERVIEW 2.1.1 F650 OVERVIEW

The F650 is a protection, control, monitoring, metering and registering unit, suitable for many different applications, such as
main protection for distribution feeders and transmission lines, as well as backup protection for transformers, busbars,
capacitor banks, etc. The main features of F650 devices include:

• Directional overcurrent protection for phases, neutral, ground and sensitive ground

• Under and overvoltage protection

• Under and overfrequency protection

• Autorecloser

• Synchronism

• Metering

• Oscillography registers, fault reports, data logger

• Bay control (open/close commands, etc.)

• Bay mimic.

• Communications (RS232/RS485/fibre optic/Ethernet)

• Fully programmable front buttons, 15 LED’s and input/output contacts

Figure 2–1:  FUNCTIONAL BLOCK DIAGRAM
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2.2SUMMARY

2.2.1 ANSI DEVICE NUMBERS AND FUNCTIONS

Table 2–1: OTHER DEVICE FUNCTIONS

DEVICE 

NUMBER

FUNCTION DEVICE 

NUMBER

FUNCTION

25 Synchronism 51PV Phase Time Overcurrent with Voltage
Restraint (two elements, High and Low)

27P Phase Undervoltage 51SG Ground Time Overcurrent for sensitive
ground systems (measured from 5th

current transformer)
27X Auxiliary Undervoltage 59N Neutral Overvoltage (two elements, High

and Low)
32 Sensitive Directional Power 59P Phase Overvoltage
32FP Forward Power 59X Auxiliary Overvoltage
46 Negative Sequence Time Overcurrent 67P Phase Directional
47 Negative Sequence Overvoltage 67N Neutral directional
48 Locked Rotor 67G Ground Directional
49 Protection against Overload by thermal model 67SG Sensitive Ground Directional
50G Ground Instantaneous Overcurrent (measured

from 4th current transformer)
79 Automatic Recloser (Four shot recloser)

50N Neutral Instantaneous Overcurrent (calculated
from the phase currents)

810 Overfrequency

50P Phase Instantaneous Overcurrent (two
elements, High and Low)

81U Underfrequency

50SG Ground Instantaneous Overcurrent for
sensitive ground systems (measured from 5th

current transformer)

I2/I1 Broken Conductor

50ISG Isolated Ground Instantaneous Overcurrent
(measured from 5th current transformer)

50BF Breaker Failure

51G Ground Time Overcurrent (measured from 4th

current transformer)
VTFF  VT Fuse Failure

51N Neutral Time Overcurrent (calculated from the
phase currents)

INPUTS/OUTPUTS METERING COMMUNICATIONS
9 Analog Inputs: 5 current inputs (3 for
phases, 1 for ground, 1 for sensitive
ground), 4 voltage inputs (3 for phases, 1
for busbar or auxiliary voltage)

Metering Current for phases, ground
and sensitive ground inputs

Front RS232 port, Two rear
RS485/fibre optic ports,  10/100 TX
and 100 FX Mbps Ethernet port

Digital Programmable Contact Inputs  (up
to 32)

Voltages phase to phase and phase
to ground

ModBus Communications RTU
and over TCP/IP

Digital Programmable Contact Outputs
(up to 16)

Real, Reactive and Apparent Power
and Power Factor

DNP Multimaster (3.0 Level 2)

32 Latched Virtual Inputs

32 Self-Reset Virtual Inputs

Three Phase Energy IEC 870-5-104

Virtual Outputs (up to 512) Frequency ModBus User Map
Tripping and closing circuit supervision Sequence components of currents

and voltages
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USER INTERFACE RECORDS OTHERS
Alphanumerical display (4x20) Data Logger Breaking Arcing Current (I2t)
Graphic display (16 x 40) Demand Breaker Control
User Programmable LEDs (15) Event Recorder (up to 128

configurable events)
IRIG-B synchronization

User Programmable Keys (up to 5) Fault Locator and Fault report     (up
to 10 records)

Logic Equations (PLC Editor)

Easy menu management thanks to
shuttle key

Oscillography (up to 20 records) Settings Groups (up to 3)

Configurable One-Line Diagram (Graphic
model only)

Snapshot Events (up to 479) Operations (up to 24)

Phasor Diagram (available in EnerVista
F650 Setup)

Web Server Application
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2.3ORDERING CODE

F650 units are supplied as ½ 19” rack, 6 units high devices, containing the following modules: power supply, CPU, I/O
modules, communication modules. Each of these modules can be supplied in different versions that must be specified
when ordering. The required information to completely define an F650 model is shown on TABLE  2-1.

Table 2–2: ORDERING CODE

SPECIAL MODELS: MOD001: 6A output contacts instead of 16A.

(*) Note: Russian language available only for basic display models.

For those applications requiring a high number of inputs and outputs, F650 units can be connected to a CIO module
(Remote CAN Bus I/O module) for using up to 2 additional boards.

F650 - - - F - G - - DESCRIPTION
B Basic display (4x20 characters)
M Graphic display (240x128 pixels)

REAR SERIAL COMMUNICATIONS BOARD 1
F None
A Redundant RS485 
P Redundant plastic fiber optic 
G Redundant glass fiber optic
X Redundant RS485 + fiber remote CAN bus I/O
Y Redundant plastic fiber optic + fiber remote CAN bus I/O
Z Redundant glass fiber optic +  fiber remote CAN bus I/O
C Cable remote CAN Bus I/O
M RS485 + cable remote CAN Bus I/O

REAR ETHERNET COMMUNICATIONS BOARD 2 
B 10/100 Base TX
C 10/100 Base TX + 100 Base FX
D 10/100 Base TX + Redundant 100 Base FX
E Redundant 10/100 Base TX

I/O BOARD IN SLOT F
1 16 Digital Inputs + 8 Outputs
2 8 Digital Inputs - 8 Outputs + 2 trip/close circuit supervision

circuits
I/O BOARD IN SLOT G

0 None
1 16 Inputs + 8 Outputs

AUXILIARY VOLTAGE
LO 24-48 Vdc (range 19.2 – 57.6)
HI 110-250 Vdc (range 88 – 300)

120-230 Vac (range 96 – 250)
LOR Redundant LO 
HIR Redundant HI 

LANGUAGE
English/English

F French/English
P Russian/English (*)
S Spanish/English
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F650 units allow monitoring and configuring these I/O boards as if they were internal boards, located on slots F and G. In
this case, slots are labeled as H y J.

The required information to completely define a CIO Module is shown on TABLE  2-2.

Table 2–3: ORDERING CODE FOR CIO MODULE

CIO H - J - - DESCRIPTION
I/O BOARD IN SLOT H

1 16 inputs + 8 outputs
2 8 inputs + 4 circuit supervision circuits + 6 outputs + 2 outputs with

tripping current supervision (latching)
I/O BOARD IN SLOT J

0 None
1 16 inputs + 8 outputs
2 8 inputs + 4 circuit supervision circuits + 6 outputs + 2 outputs with

tripping current supervision (latching)
AUXILIARY VOLTAGE

LO 24-48 Vdc (range 19.2 – 57.6)
HI 110-250 Vdc (range 88 – 300)

120-230 Vac (range 96 – 250)
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2.4TECHNICAL SPECIFICATIONS

NOTE: TECHNICAL SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT NOTICE

2.4.1 PROTECTION UNITS

Phase and ground units use as operation magnitude the current value received by the unit in current inputs, while the
neutral unit uses the calculated current value from the three phase currents.

The isolated ground unit will be used only for those applications where the neutral is completely isolated, and it uses the
fifth CT of the unit. This CT has a sensitivity that is 10 times higher than the universal model (connected to 1A or 5A
transformers). Therefore, it does not admit such a high permanent overload.

a) PHASE TIME OVERCURRENT WITH VOLTAGE RESTRAINT (51PH/51PL)

b) GROUND TIME OVERCURRENT (51G)

Current Input Phasor (without harmonics) or RMS
Rated current For connection to 1 or 5 A CTs.
Pickup level 0.05 to 160.00 A in steps of 0.01 A
Reset level 98% of the pickup level
Level Accuracy ±0.5% of the reading ± 10 mA from 0.05 to 10 A

±1.5% of the reading for higher values.
Curve Shapes IEEE extremely / very / moderately inverse 

IEC A/B/C/long-time inverse/short time inverse curve
IAC extremely / very / normally / moderately inverse
ANSI extremely / very / normally / moderately inverse
I2t
Definite time
Rectifier curve
FlexCurve™ A/B/C/D user curve

Curve Multiplier (Time Dial) 0.00 to 900.00 s in steps of 0.01 s
Reset type Instantaneous or time delayed according to IEEE
Timing accuracy Operate at > 1.03 times the pickup ±3.5% of operate time or

30 ms. (whichever is greater)
Voltage restraint Selectable by setting 
Saturation Level 48 times the pickup level
Snapshot Events Selectable by setting 

Current Input Phasor (without harmonics) or RMS
Rated current For connection to 1 or 5 A CTs.
Pickup level 0.05 to 160.00 A in steps of 0.01 A
Reset level 98% of the pickup level
Level Accuracy ±0.5% of the reading ± 10 mA from 0.05 to 10 A

±1.5% of the reading for higher values.
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c) NEUTRAL TIME OVERCURRENT (51N)

d) SENSITIVE GROUND TIME OVERCURRENT (51SG)

Curve Shapes IEEE extremely / very / moderately inverse 
IEC A/B/C/long-time inverse/short time inverse curve
IAC extremely / very / normally / moderately inverse
ANSI extremely / very / normally / moderately inverse
I2t
Definite time
Rectifier curve
FlexCurve™ A/B/C/D user curve

Curve Multiplier (Time Dial) 0.00 to 900.00 s in steps of 0.01 s
Reset type Instantaneous or time delayed according to IEEE
Timing accuracy Operate at > 1.03 times the pickup ±3.5% of operate time or

30 ms. (whichever is greater)
Saturation Level 48 times the pickup level
Snapshot Events Selectable by setting 

Current Input Fundamental Phasor (without harmonics)
Rated current For connection to 1 or 5 A CTs.
Pickup level 0.05 to 160.00 A in steps of 0.01 A
Reset level 98% of the pickup level
Level Accuracy ±0.5% of the reading ± 10 mA from 0.05 to 10 A

±1.5% of the reading for higher values.
Curve Shapes IEEE extremely / very / moderately inverse 

IEC A/B/C/long-time inverse/short time inverse curve
IAC extremely / very / normally / moderately inverse
ANSI extremely / very / normally / moderately inverse
I2t
Definite time
Rectifier curve
FlexCurve™ A/B/C/D user curve

Curve Multiplier (Time Dial) 0.00 to 900.00 s in steps of 0.01 s
Reset type Instantaneous or time delayed according to IEEE
Timing accuracy Operate at > 1.03 times the pickup ±3.5% of operate

time or 30 ms. (whichever is greater)
Saturation Level 48 times the pickup level
Snapshot Events Selectable by setting 

Current Input Phasor (without harmonics) or RMS
Rated current For connection to 1 or 5 A CTs.
Pickup level 0.005 to 16.000 A in steps of 0.001 A
Reset level 98% of the pickup level
Level Accuracy ±1.5% of the reading ± 1 mA from 0.005 to 16 A
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e) PHASE AND GROUND INSTANTANEOUS OVERCURRENT (50PH/50PL/50G)

f) NEUTRAL INSTANTANEOUS OVERCURRENT (50N)

Curve Shapes IEEE extremely / very / moderately inverse 
IEC A/B/C/long-time inverse/short time inverse curve
IAC extremely / very / normally / moderately inverse
ANSI extremely / very / normally / moderately inverse
I2t
Definite time
Rectifier curve
FlexCurve™ A/B/C/D user curve

Curve Multiplier (Time Dial) 0.00 to 900.00 s in steps of 0.01 s
Reset type Instantaneous or time delayed according to IEEE
Timing accuracy Operate at > 1.03 times the pickup ±3.5% of operate

time or 30 ms. (whichever is greater)
Saturation Level 48 times the pickup level
Snapshot Events Selectable by setting 

Current Input Phasor (without harmonics) or RMS
Rated current For connection to 1 or 5 A CTs.
Pickup level 0.05 to 160.00 A in steps of 0.01 A
Reset level 97% of the pickup level
Level Accuracy ±0.5% of the reading ± 10 mA from 0.05 to 10 A

±1.5% of the reading for higher values
Overreach < 2%
Trip delay 0.00 to 900.00 s. in steps of 0.01 s.
Reset delay 0.00 to 900.00 s. in steps of 0.01 s.
Operate time 20 ms at 3 x Pickup at 50 Hz, typically
Timing accuracy ±3% of operate time or 30 ms. (whichever is greater)
Snapshot Events Selectable by setting 

Current Input Fundamental Phasor (without harmonics)
Rated current For connection to 1 or 5 A CTs.
Pickup level 0.05 to 160.00 A in steps of 0.01 A
Reset level 97% of the pickup level
Level Accuracy ±0.5% of the reading ± 10 mA from 0.05 to 10 A

±1.5% of the reading for higher values
Overreach < 2%
Trip delay 0.00 to 900.00 s. in steps of 0.01 s.
Reset delay 0.00 to 900.00 s. in steps of 0.01 s.
Operate time 20 ms at 3 x Pickup at 50 Hz, typically
Timing accuracy ±3% of operate time or 30 ms. (whichever is greater)
Snapshot Events Selectable by setting 
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g) SENSITIVE GROUND INSTANTANEOUS OVERCURRENT (50SG)

h) ISOLATED GROUND INSTANTANEOUS OVERCURRENT (50IG)

i) NEGATIVE SEQUENCE (46)

Current Input Phasor (without harmonics) or RMS
Rated current For connection to 1 or 5 A CTs.
Pickup level 0.005 to 16.000 A in steps of 0.001 A
Reset level 97% of the pickup level
Level Accuracy ±1.5% of the reading ± 1 mA from 0.005 to 16 A
Overreach < 2%
Trip delay 0.00 to 900.00 s. in steps of 0.01 s.
Reset delay 0.00 to 900.00 s. in steps of 0.01 s.
Operate time 20 ms at 3 x Pickup at 50 Hz
Timing accuracy ±3% of operate time or 30 ms. (whichever is greater)
Snapshot Events Selectable by setting 

Current Input Fundamental Phasor (without harmonics)
Voltage Input Fundamental Phasor (without harmonics)
Current Pickup level 0.005 to 0.400 A in steps of 0.001 A
Voltage Pickup level 2 to 70 V in steps of 1 V
Reset level 97-98% of the pickup level
Level Accuracy ±1.5% of the reading ± 1 mA from 0.005 to 16 A
Trip delay 0.00 to 900.00 s. in steps of 0.01 s.
Time to instantaneous 0.00 to 900.00 s. in steps of 0.01 s.
Timing accuracy ±3% of operate time or 30 ms. (whichever is greater)
Snapshot Events Selectable by setting 

Current Input Fundamental Phasor (without harmonics)
Pickup level 0.05 to 160.0 A in steps of 0.01 A
Reset level 98% of the pickup level
Level Accuracy ±0.5% of the reading ± 10 mA from 0.05 to 10 A

±1.5% of the reading for higher values
Curve Shapes IEEE extremely / very / moderately inverse 

IEC A/B/C/long-time inverse/short time inverse curve
IAC extremely / very / normally / moderately inverse
ANSI extremely / very / normally / moderately inverse
I2t
Definite time
Rectifier curve
FlexCurve™ A/B/C/D user curve

Curve Multiplier (Time Dial) 0.00 to 900.00 s in steps of 0.01 s
Reset type Instantaneous or time delayed according to IEEE
Timing accuracy Operate at > 1.03 times the pickup ±3.5% of operate

time or 30 ms. (whichever is greater)
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j) PHASE DIRECTIONAL (67P)

k) GROUND DIRECTIONAL (67G)

l) NEUTRAL DIRECTIONAL (67N)

Saturation Level 48 times the pickup level
Snapshot Events Selectable by setting 

Directionality Forward and reverse selectable by setting
Polarizing Quadrature Voltage:

ABC seq: Phase A (VBC), Phase B (VCA), Phase C
(VAB)
ACB seq: Phase A (VCB), Phase B (VAC), Phase C
(VBA)

Polarizing voltage threshold 0 to 300 Vac in steps of 1 V
Characteristic angle -90º to +90º in steps of 1º
Block Logic Permission or Block selectable by setting
Angle accuracy ±2º for I>0.1 A and V>5 Vac
Operate time <30ms, typically 

Directionality Forward and reverse selectable by setting
Polarizing Voltage, current, dual
Polarizing Voltage VN (measured or calculated, selected by setting)

Polarizing Current Isg (measured from 5th current transformer)
Operating Current Ig (measured from 4th current transformer)
Polarizing Voltage threshold 0 to 300 Vac in steps of 1 V
Polarizing Current threshold 0.005 A
Characteristic angle -90º to +90º in steps of 1º
Block Logic Permission or Block selectable by setting
Angle accuracy ±2º for I>0.1 A and V>5 Vac
Operate time <30ms, typically 

Directionality Forward and reverse selectable by setting
Polarizing Voltage, current, dual
Polarizing Voltage VN (measured or calculated, selected by setting)

Polarizing Current Isg (measured from 5th current transformer)
Operating Current IN
Polarizing Voltage threshold 0 to 300 Vac in steps of 1 V
Polarizing Current threshold 0.005 A
Characteristic angle -90º to +90º in steps of 1º
Block Logic Permission or Block selectable by setting



GE Multilin F650 Digital Bay Controller 2-11

2 PRODUCT DESCRIPTION 2.4 TECHNICAL SPECIFICATIONS

2
m) SENSITIVE GROUND DIRECTIONAL (67SG)

n) THERMAL MODEL (49)

o) PHASE OVERVOLTAGE (59P)

Angle accuracy ±2º for I>0.1 A and V>5 Vac
Operate time <30ms, typically 

Directionality Forward and reverse selectable by setting
Polarizing Voltage
Polarizing Voltage VN (measured or calculated, selected by setting)

Operating Current Isg (measured from 5th current transformer)
Polarizing Voltage threshold 0 to 300 Vac in steps of 1 V
Characteristic angle -90º to +90º in steps of 1º
Block Logic Permission or Block selectable by setting
Angle accuracy ±2º for I>0.1 A and V>5 Vac
Operate time <30ms, typically 

Current Input Fundamental Phasor (without harmonics)
Rated current For connection to 1 or 5 A CTs.
Pickup level 0.05 to 160.0 A in steps of 0.01 A
Reset level 97% of the pickup level
Level Accuracy ±0.5% of the reading ± 10 mA from 0.05 to 10 A

±1.5% of the reading for higher values
Timing accuracy ±3.5% of operate time or 30 ms. (whichever is greater)
Heating constant Between 3 and 600 minutes
Cooling constant 1 to 6 times the heating constant
Snapshot Events Selectable by setting 

Voltage Input Fundamental Phasor (without harmonics) of phase-to-phase
voltages

Pickup level 3 to 300 in steps of 1 V
Reset level 97% of the pickup level
Level Accuracy ±1% reading ±0.1% Full Scale from 10 to 275 V
Trip delay 0.00 to 900.00 s. in steps of 0.01 s.
Reset delay 0.00 to 900.00 s. in steps of 0.01 s.
Timing accuracy ±3.5% of operate time or 30 ms. (whichever is greater)
Logic Any/Two/All phases logic selectable by setting
Snapshot Events Selectable by setting 
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p) PHASE UNDERVOLTAGE (27P)

q) NEUTRAL OVERVOLTAGE (59NH/59NL)

r) NEGATIVE SEQUENCE OVERVOLTAGE (47)

s) AUXILIARY OVERVOLTAGE (59X)

Voltage Input Fundamental Phasor of phase-to-ground or phase-to-
phase voltages (selectable by setting)

Pickup level 3 to 300 in steps of 1 V
Reset level 103% of the pickup level
Level accuracy ±1% reading ±0.1% Full Scale from 10 to 275 V
Curve Shapes Fixed time or inverse curve
Reset type Instantaneous 
Curve Multiplier (Time Dial) 0.00 to 900.00 s. in steps of 0.01 s.
Timing accuracy ±3.5% of operate time or 30 ms. (whichever is greater)
Minimum Voltage Threshold 0 to 300 in steps of 1 V
Logic Any/Two/All phases logic selectable by setting
Supervised by Breaker Selectable by setting
Snapshot Events Selectable by setting

Voltage Input Fundamental Phasor of the neutral voltage
Pickup level 3 to 300 in steps of 1 V
Reset level 97% of the pickup level
Level accuracy ±1% reading ±0.1% Full Scale from 10 to 275 V
Trip delay 0.00 to 900.00 s. in steps of 0.01 s
Reset delay 0.00 to 900.00 s. in steps of 0.01 s
Timing accuracy ±3.5% of operate time or 30 ms. (whichever is greater)
Snapshot Events Selectable by setting

Voltage Input Fundamental Phasor
Pickup level 3 to 300 in steps of 1 V
Reset level 97% of the pickup level
Level accuracy ±1% reading ±0.1% Full Scale from 10 to 275 V
Trip delay 0.00 to 900.00 s. in steps of 0.01 s
Reset delay 0.00 to 900.00 s. in steps of 0.01 s
Timing accuracy ±3.5% of operate time or 30 ms. (whichever is greater)
Snapshot Events Selectable by setting

Voltage Input Fundamental Phasor
Pickup level 3 to 300 in steps of 1 V
Reset level 97% of the pickup level
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t) AUXILIARY UNDERVOLTAGE (27X)

u) UNDERFREQUENCY (81U)

v) OVERFREQUENCY (81O)

Level accuracy ±1% reading ±0.1% Full Scale from 10 to 275 V
Trip delay 0.00 to 900.00 s. in steps of 0.01 s
Reset delay 0.00 to 900.00 s. in steps of 0.01 s
Timing accuracy ±3.5% of operate time or 30 ms. (whichever is greater)
Snapshot Events Selectable by setting

Voltage Input Fundamental Phasor
Pickup level 3 to 300 V in steps of 1 V
Reset level 97% of the pickup level
Level accuracy ±1% reading ±0.1% Full Scale from 10 to 275 V
Curve Shapes Fixed time or inverse curve
Reset type Instantaneous 
Curve Multiplier (Time Dial) 0.00 to 900.00 s. in steps of 0.01 s
Timing accuracy ±3.5% of operate time or 30 ms. (whichever is greater)
Snapshot Events Selectable by setting

Pickup level 20.00 to 65.00 Hz in steps of 0.01 Hz
Reset level Pickup + 0.03 Hz
Level accuracy ±0.01 Hz of the reading
Trip delay 0.00 to 900.00 s. in steps of 0.01 s
Reset delay 0.00 to 900.00 s. in steps of 0.01 s
Minimum voltage threshold 30 to 300V in steps of 1 V
Timing accuracy ±3.5% of operate time or 100 ms. (whichever is greater)
Snapshot Events Selectable by setting

Pickup level 20.00 to 65.00 Hz in steps of 0.01 Hz
Reset level Pickup - 0.03 Hz
Level accuracy ±0.01 Hz of the reading
Trip delay 0.00 to 900.00 s. in steps of 0.01 s
Reset delay 0.00 to 900.00 s. in steps of 0.01 s
Minimum voltage threshold 30 to 300V in steps of 1 V
Timing accuracy ±3.5% of operate time or 100 ms. (whichever is greater)
Snapshot Events Selectable by setting
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w) FORWARD POWER (32FP)

x) SENSITIVE DIRECTIONAL POWER (32)

y) BROKEN CONDUCTOR (I2/I1)

Note: The I2/I1 current inhibition level for the different
firmware versions is as follows

Current, Voltage Fundamental Phasor (primary values)
Number of stages 2
Pickup level (two stages) 0.00-10000.00 MW in steps of 0.01 MW
Reset level 97% of the pickup level
Level accuracy for primary magnitudes ±3% complete range.
Trip delay (two stages) 0.00 to 900.00 s in steps of 0.01 s
Timing accuracy ±3.5% of operate time or 30 ms. (whichever is greater)
Block Time after close 0.00 to 900.00 s in steps of 0.01 s
Snapshot Events Selectable by setting

Current, Voltage Fundamental Phasor (primary values)
Number of stages 2
Pickup level (two stages) -10000.00 to 10000.00 MW (primary values) in steps of

0.01 MW
Characteristic Angle (two stages) 0.00 to 359.99 in steps of 0.01
Reset level 97% of the pickup level
Accuracy for primary magnitudes ±3% complete range
Trip delay (two stages) 0.00 to 900.00 s in steps of 0.01 s
Timing accuracy ±3.5% of operate time or 30 ms. (whichever is greater)
Block Time after close 0.00 to 900.00 s in steps of 0.01 s
Snapshot Events Selectable by setting

Pickup level 20.0-100.0% (I2/I1 ratio) in steps of 0.1% 
Reset level 97% of the pickup level
Trip delay 0.00 to 900.00 s in steps of 0.01 s
Timing accuracy ±3.5% of operate time or 30 ms. (whichever is greater)
Minimum Phase Current Threshold 0.05 A
Snapshot Events Selectable by setting
Operation Threshold 0.000 to 1.000 A in steps of 0.001 A

Firmware Version Current Inhibition Level
1.50 or Lower 10 mA
1.60 or Higher 50 mA
1.80 or Higher Selectable by setting from 0.000 to 1.000 in steps of 0.001 A
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z) LOCKED ROTOR (48)

2.4.2 CONTROL

a) AUTORECLOSE (79)

b) SYNCHROCHECK (25)

Current Input Phasor (without harmonics) or RMS
Rated current For connection to 1 or 5 A CTs.
Full Load Current 0.10 to 10.00 KA in steps of 0.01 KA
Pickup level 1.01 to 109.00 in steps of 0.01
Reset level 97% of the pickup level
Level accuracy for primary magnitudes ±3% complete range.
Trip delay 0.00 to 900.00 s. in steps of 0.01 s.
Reset delay 0.00 to 900.00 s. in steps of 0.01 s.
Operate time 20 ms at 3 x Pickup at 50 Hz, typically
Timing accuracy ±3.5% of operate time or 30 ms. (whichever is greater)
Snapshot Events Selectable by setting 

Schemes Three-pole tripping schemes
Number of shots Up to 4 reclose attempts before lockout
Dead time Independent dead time setting before each shot adjust-

able between 0 and 900 s in steps of 0.01 s
Reclaim time 0.00 to 900.00 s in steps of 0.01 s
Condition permission Selectable by setting
Hold time 0.00 to 900.00 s in steps of 0.01 s
Reset time 0.00 to 900.00 s in steps of 0.01 s
Snapshot Events Selectable by setting
Possibility to modify protection settings after each shot programmable through PLC (block signals available after each
shot)

Dead/live levels for line and bus 0.00 to 300.00 in steps of 0.01 V
Maximum voltage difference 2.00 to 300.00 V in steps of 0.01 V
Maximum angle difference 2.0º to 80.0º in steps of 0.1º
Maximum frequency slip 10 to 5000 mHz in steps of 10 mHz
Synchronism time 0.01 to 600.00 s in steps of 0.01 s
Angle accuracy 2º
Dead Source function None

(DL-DB) Dead Line - Dead Bus
(LL-DB) Live Line-Dead Bus
(DL-LB) Dead Line – Live Bus 

Snapshot Events Selectable by setting
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c) FUSE FAILURE

d) BREAKER FAILURE (50BF)

e) BREAKER SETTINGS

f) BREAKER MAINTENANCE

g) SWITCHGEAR

Algorithm based on positive sequence of voltage and current
Activation by V2/V1 ratio

Current Input Fundamental Phasor (without harmonics)
Rated current For connection to 1 or 5 A CTs.
Pickup level for supervision 0.05 to 160.00 A in steps of 0.01 A
Pickup level for high level 0.05 to 160.00 A in steps of 0.01 A
Pickup level for low level 0.05 to 160.00 A in steps of 0.01 A
Pickup level for internal arcing 0.05 to 160.00 A in steps of 0.01 A
Reset level 97% of the pickup level
Level Accuracy ±0.5% of the reading ± 10 mA from 0.05 to 10 A

±1.5% of the reading for higher values.
Timing accuracy ±3.5% of operate time or 30 ms. (whichever is greater)
Snapshot Events Selectable by setting 

Number of Switchgear 1 to16 (selection of switchgear for breaker control)

Maximum KI2t 0.00 to 9999.99 in steps of 0.01 (kA)2 s

KI2t integration Time 0.03 to 0.25 s in steps of 0.01 s

Maximum openings 0 to 9999 in steps of 1
Maximum Openings in one hour 1 to 60 in steps of 1
Snapshot Events Selectable by setting 

KI2t Breaker Counters for Phases A, B, C 0.00 to 9999.99 in steps of 0.01 (kA)2 s
Breaker Openings Counter 0 to 9999 in steps of 1
Breaker Closings Counter 0 to 9999 in steps of 1

Switchgear 1 to16 (configurable in “relay configuration” screen).
Snapshot Events Selectable by setting (for each switchgear in “system

setup”) 
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2.4.3 MONITORING

a) OSCILLOGRAPHY

b) FAULT LOCATOR

Maximum Records: Up to 20 Oscillography records.
Sampling rate: Programmable to 4, 8, 16, 32 or 64 samples per power cycle

Capacity per record: 27592 samples
No of Oscillos * No of samples/cycle

Trigger position: 5% to 95% of total length
Trigger: Programmable via PLC
Data: 5 current channels and 4 voltage channels

Up to 16 digital channels programmable through PLC

Data Storage: In non volatile memory (flash) without battery
Format: International Standard COMTRADE ASCII - IEEE C37.111-1999.
Automatic Overwrite: Selectable by setting. (Oscillography records can be concatenated)
Snapshot Events: Selectable by setting

Method: Single-ended
Positive Sequence Module: 0.01 to 250.00 Ohm in steps of 0.01 Ohms
Positive Sequence Angle: 25 to 90º in steps of 1º
Zero Sequence Module: 0.01 to 750.00 Ohms in steps of 0.01 Ohm
Zero Sequence Angle: 25 a 90º in steps of 1º
Line Length: 0.0 to 2000.0 in steps of 0.1 (miles or km)
Accuracy: 5% (typical)
Display Fault on HMI: Selectable by setting
Snapshot Events: Selectable by setting

Maximum Records: Up to 10 fault report records.
Data: Fault date and time, pre-fault currents and voltages, fault currents and voltages, 

fault type, distance to the fault (fault location), line parameters, recloser and 
breaker status information.

Data Storage: In non volatile memory (flash) without battery available through communications
In volatile memory (ram) available through HMI (if selectable by setting)

Format: Text in ASCII format
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c) SNAPSHOT EVENTS

d) CONTROL EVENTS

e) DEMAND

f) DATA LOGGER

Capacity: 479 scrolling events
Time-tag 1 ms using an internal clock of 100 μs
Timing Accuracy: 1 ms (using the IRIG-B synchronization input)
Triggers: Any element pickup, dropout

Digital input /output change of state

By virtual inputs and control events

Data Storage In non volatile memory (flash) without battery
The snapshot event recording procedure can be enabled or disabled by setting for each protection function

Capacity: 128 events programmable through PLC
Time-tag: 1 ms using an internal clock of 100 μs
Timing Accuracy: 1 ms (using the IRIG-B synchronization input)
Triggers: By any digital signal programmable through PLC 
Alarm Possibility to display the event as an alarm on the alarms panel. 

Information available always through Communications for all models and also in 
HMI for models with graphical display (M in ordering code).

Data Storage: In non volatile memory (flash) without battery
Control events are also displayed in the snapshot events recording

Channels: 9
Parameters: Ia (kA RMS), Ib (kA RMS), Ic (kA RMS), Ig (kA RMS), Isg (kA RMS), I2 (kA), P

(MW), Q (MVAr) and S (MVA)
Current and Power Method Thermal Exponential, Block Interval, Rolling Demand
Measurements: Each channel shows the present and maximum measured value, with date and

time for the maximum recorded value. 
Samples: 5, 10, 15, 20, 30, 60 minutes.
Accuracy: ±1%
Trigger Input Selectable by setting (operation mode selection for the Block Interval calculation

method)
Snapshot Events: Selectable by setting

Number of Channels: 1 to 16
Parameters Any available analog actual value
Samples 1 sec., 1, 5, 10, 15, 20, 30, 60 min.
Storage Capacity Fixed, 32768 measures



GE Multilin F650 Digital Bay Controller 2-19

2 PRODUCT DESCRIPTION 2.4 TECHNICAL SPECIFICATIONS

2

2.4.4 USER –PROGRAMABLE ELEMENTS

a) PLC LOGIC

b) FLEXCURVES

c) USER-PROGRAMMABLE LEDS

d) USER-DEFINABLE DISPLAYS

Programming language: The logical configuration is performed using graphical functions based on the 
IEC 61131-3 standard.

Lines of code: 512
Supported operations: NOT, XOR, OR (2 to 8 inputs), AND (2 to 8 inputs), NOR (2 to 8 inputs), 

NAND (2 to 8 inputs), Latch (Reset Dominant), Edge Detectors, Timers.
2 inputs default gates, from 3 to 8 inputs provided in library format.

Libraries: Logical gates fully programmable by user. To create user-programmable logic to
be distributed as a single object.

Inputs: Any logical variable, contact or virtual input
Number of timers: 8 maximum in each logic scheme (provided in library format)

Number: 4 (A through D)
Reset points: 40 (0 through 1 of pickup)
Operate points: 80 (1 through 20 of pickup)
Time delay: 0 to 65535 ms in steps of 1
Saturation Level 20 times the pickup level

Number: 15 configurable LEDs plus a ready non configurable LED
Programmability: from any logical variable, contact, or virtual input
Reset mode: Self-reset or Latched. 

The first 5 LED’s are latched by hardware (red color ones), usually configured for 
trip signals.
The following 10 ones (yellow and green) are self-reset but can be latched 
through PLC configuration.

Reset Signal: The LED’s can be reset by hardware, pressing the front “esc” key during more 
than 3 seconds or using the LED reset signal through PLC configuration.

Number of configurable displays: 1 (one line diagram fully configurable). In graphical displays only
Number of fixed displays: 6, Metering (in primary values), Snapshot events (all and new), Alarms, Inputs 

and outputs screen with test functionality for inputs and outputs. In graphical dis-
plays only

Number of selectable displays: Logotype, metering or both in scrolling mode, can be selectable as default 
screen in text display for all models (basic and mimic). The metering screen con-
tains current and voltages for phases and ground in primary values.
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e) USER-PROGRAMMABLE FRONT KEYS

2.4.5 METERING

a) CURRENT

b) VOLTAGE

c) REAL POWER (WATTS)

d) REACTIVE POWER (VARS)

e) APPARENT POWER (VA)

f) WATT-HOURS (POSITIVE AND NEGATIVE)

g) WAR-HOURS (POSITIVE AND NEGATIVE)

h) POWER FACTOR

Number of configurable Keys: 5
Operation: drive PLC operands

Accuracy: ±0.5% of the reading ± 10 mA from 0.05 to 10 A (for phases and ground)

±1.5% of the reading ± 1 mA from 0.005 to 5 A (for sensitive ground)

±1.5% of the reading for higher values

Accuracy: ±1% reading ±0.1% Full Scale from 10 to 275 V

Accuracy: ±1% of the reading at-0.8 < PF = -1 and 0.8 <PF=1

Accuracy: ±1% of the reading at-0.2 = PF = 0.2

Accuracy: ±1% of the reading

Accuracy: ±1% of the reading
Range: ±0 to 2147 MWh
Parameters: 3-phase only
Update rate: 100 ms

Accuracy: ±1% of the reading
Range: ±0 to 2147 MVArh
Parameters: 3-phase only
Update rate: 100 ms

Accuracy: 0.02
Parameters: 3-Phase and single phase
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i) FREQUENCY

j) ANGLE

2.4.6 INPUTS

a) AC CURRENT INPUTS

b) AC VOLTAGE INPUTS

c) DIGITAL INPUTS

Accuracy: ±10 mHz at 50 Hz 
±12 mHz at 60 Hz

Accuracy: 2º

CT Ratio: 1.0 to 6000.0 in steps of 0.1
Rated currents: Appropriate for 1 or 5 A. F650 has universal range for CT (valid for 1 or 5 A to

only one terminal).
Relay Burden: < 0.04 Ohm
Current Withstand Continuous at 20 A

1 second at 500 A for phases and ground
1 second at 50 A for sensitive ground

VT Ratio 1.0 to 6000.0 in steps of 0.1
Rated Voltages 275 Vac
Metering range: From 2 to 275 Vac
Relay Burden: 0.05 VA at 120 Vac (50 or 60 Hz)
Voltage Withstand: Continuous at 260 V to neutral

1 min/hr at 420 to neutral

VAC inputs do not need varistors, as the impulse test is applied to 100% of the transformers

Input Activation Voltage Threshold: 1 to 255 Vdc in steps of 1 V (selectable by setting)
Impedance: > 100 kOhm
Maximum error: ±10% setting ± 2.5 V
Load for voltage supervision inputs: 2 mA + V/100 kOhm
Voltage threshold for voltage supervi-
sion inputs

< 10 V (fixed)

Debounce Time: 1 to 50 in steps of 1 ms
Recognition time: < 1ms
Timing resolution: 1 ms
For Input Activation Voltage Threshold and Debounce Time there is a single setting for all inputs in the same
group (inputs sharing the same common). In mixed and supervision boards there are two groups of inputs,
called A and B.
Input Type and Delay Input Time are not grouped; there is a different setting for each input.
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d) IRIG-B INPUT

2.4.7 REAL TIME CLOCK

2.4.8 OUTPUTS

Input Type Positive-Edge / Negative-Edge / Positive/ Negative
Delay Input Time 0 to 60000 ms in steps of 1 ms (Input signal time delay)

Amplitude modulation: DC SHIFT = Demodulated input (no carrier) 

Input Voltage: TTL

Input Burden: 1.5 mA
Input Impedance: 3.3 kOhm
Minimum Input Voltage: 2.4 V
Maximum Input Voltage: +/- 24 V
Formats: B000 (*) B001, B002 and B003 (*)

(*) Signal combinations recognized in accordance with IRIG Standard 200-95
Isolation: 2 kV

Accuracy: Typical ±20 ppm
Backup energy: More than 1 week

Carry continuous: 16 A
Make and Carry for 1 sec 60 A
Break at L/R of 40 ms: 0.3 A DC max. at 125 Vdc

0.25 A DC max. at 250 Vdc
Operate Time: < 8 ms
Contact material: Silver Alloy

Output Logic Type, Output Type and Pulse Output Time are selectable by setting for each output
Output Logic Type Positive / Negative
Output Type Normal / Pulse / Latch (Selectable by setting for each output)
Pulse Output Time 0 to 60000 ms in steps of 1 ms (applicable only to signals set as pulse type)
Separate operate and reset signal can be configured by any digital signal programmable through PLC

Contact Outputs (F31-F33, F34-
F36) for board type 2 (supervi-
sion) in slot F:

The current seal-in circuit is used for verifying the current condition in a circuit dur-
ing the time that the tripping contact remains closed. If the current in the tripping
circuit is maintained over 100 mA, the function is sealed independently of the sta-
tus of the function that caused the trip.
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2.4.9 CONTROL POWER SUPPLY

2.4.10 COMMUNICATIONS

LOW RANGE (LO)
Nominal DC Voltage: 24 to 48 V
Min/Max DC Voltage 19.2 / 57.6 V
Note: Low range is DC only
HIGH RANGE (HI)
Nominal DC Voltage: 110 to 250 V
Min/Max DC Voltage 88 / 300 V
Nominal AC Voltage: 120 to 230 V
Min/Max AC Voltage 102 / 250 V
ALL RANGES
Voltage Loss hold-up time 200 ms typical, worst case 100 ms without unit reset
Power consumption Typical =25 VA, Maximum =45 VA
Display backlight auto power-off mode after 15 minutes without touching any key, in order to ensure long life and minimum 
consumption.

FRONT PORT:
Front port: COM2
Type RS232
Baud Rate 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600 y 115200 bauds
Default Baud Rate 19200
Protocols available: ModBus® RTU / DNP 3.0
Typical distance: 1200 m
Isolation: 2 kV
ASYNCHRONOUS REAR PORTS:
None or two rear ports (depending on 
model):

COM1, COM2

(rear COM2 multiplexed with front port)
Type (depending on model):

Model F None
Model A Two RS485 ports
Model X Two RS485 ports with CAN for inputs/outputs module
Model P Two 1mm-plastic F.O. ports
Model Y Two 1mm-plastic F.O. ports with CAN for inputs/outputs module
Model G Two multimode glass F.O. ports with ST connectors 
Model Z Two multimode glass F.O. ports with ST connectors with CAN for inputs/outputs 

module
Optic Features for ST connectors 
devices:

Wave length: 1300nm

Fiber type: multimode 62.5/125 μm or 50/125 μm
Baud Rate: 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600 y 115200 bauds
Default Baud Rate 19200
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2.4.11 ENVIRONMENTAL CHARACTERISTICS

2.4.12 PACKAGING AND WEIGHT

Protocols available: ModBus® RTU / DNP 3.0
Typical distance: 1200 m
Isolation: 2 kV
CAN PORT: 
Rear port: CAN port in models X, Y, Z for asynchronous rear ports
Type: Multimode glass F.O. port with ST connectors
Wave length: 1300 nm
Fiber type: multimode 62.5/125 μm or 50/125 μm
Isolation: 2 kV
ETHERNET PORT:
Rear port: COM3
Type (depending on model):

Model B: 10/100BaseTX self-negotiable
Model C: 10/100BaseTX + 100Base FX 
Model D: 10/100BaseTX + Double 100BaseFX (Physical media redundancy)
10/100BaseTX RJ45 connector
100BaseFX ST connectors
Wave length: 1300 nm
Fiber type: multimode 62.5/125 μm or 50/125 μm
Protocols available: ModBus® TCP/IP

DNP over TCP/IP and UDP/IP

IEC 870-5-104

Http, ftp, tftp (allow the use of a standard Internet browser)
Typical distance: 1.65 km
Response time to ModBus commands: 10 ms Typical
Isolation: 2 kV
In Models C and D, the 10/100BaseTX port is selected by an internal switch (see 3.3.3)
Two witness LED’s for transmission and reception are included

Operating temperature: - 10°C to + 60°C
Storage temperature: - 40°C to + 80°C
Humidity (non condensing): 95%
Altitude Up to 2000 m
Installation category II

Net weight: 5 kg
Packaged: 6 kg
Package dimensions: 30x40x40 cm (DxWxH)
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2.4.13 TYPE TESTS

Type test report available upon request.

F650 has been designed to comply with the highest existing requirements. More specifically, UNIPEDE recommendations
for high voltage substations are followed, even if for most applications such high classes are not required.

The relay complies with ANSI C37.90 standards, and has been designed to comply with international standards.

2.4.14 APPROVALS

Category Standard Class Test
EMC IEC 61000-4-1 IEC 60255-22-1 III Oscillatory waves immunity

IEC 61000-4-2 IEC 60255-22-2 IV Electrostatic discharge immunity test

IEC 61000-4-3 IEC 60255-22-3 III Radiated electromagnetic field disturbance 
test

IEC 61000-4-4 IEC 60255-22-4 IV Electrical fast transient

IEC 61000-4-5 IEC 60255-22-5 IV Surge immunity test

IEC 61000-4-6 IEC 60255-22-6 III Conducted electromagnetic field distur-
bance test

IEC 61000-4-8 EN 61000-4-8 IV Power frequency magnetic field immunity

ENV50204 III Radiated electromagnetic field 
disturbance test – 1890 MHz.

EMC Emisivity IEC 60255-25 EN 61000-6-4 A Conducted and radiated emissions
Product IEC 60255-5 2 kV Insulation resistance – dielectric test

IEC 60255-5 6kV .5J Impulse test

IEC 60255-11 100 ms Power supply Voltage dips/interruptions/vari-
ations:

Mechanical IEC 60255-21-1 I Vibration test (sinusoidal)
IEC 60255-21-2
IEC 60255-21-3

I
II

Shock and bump 
Seismic 

ISO9001 Registered system.
CE marking: Meets the CE standards relevant for protections.
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2.5EXTERNAL CONNECTIONS

F650 units can hold two different options for F module:

Option 1:Board with 16 inputs and 8 outputs. 

Option 2: Board with 8 digital inputs, 4 circuit supervision outputs, 6 conventional outputs, and two current sensing outputs 

Each model has a different wiring diagram, as follows:

Figure 2–2: WIRING DIAGRAM FOR MODELS WITH OPTION 1 (189C4216H3)
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The option 2 wiring diagram is shown below:

Figure 2–3: WIRING DIAGRAM FOR MODELS WITH OPTION 2 (189C4216H2)
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3 HUMAN INTERFACES  3.1ENERVISTA 650 SETUP SOFTWARE INTERFACE 3.1.1 OVERVIEW

This software package uses ModBus protocol, and it is designed to communicate with a single relay at a time. GE offers
different communication software packages, such as GE-POWER, which can be used to communicate simultaneously with
several relays.

EnerVista 650 Setup software provides an easy way to configure, monitor and manage all F650 features.

a )Setting files

EnerVista 650 Setup software provides two ways of working with setting files:

1.OFF LINE Mode: Creating or editing setting files not connected to the relay, to be stored later in the proper unit.

2. ON LINE Mode: Connecting to the relay. This on line mode allows settings modifications, reading metering
values, internal status, oscillography records, event records, etc. 

b) Configuration

The relay allows to fully program all the inputs, outputs, LEDs, control events, operations, block signals in
protection elements, switchgear, one line diagram in HMI, and create internal logic. 

For simple relay configurations a direct configuration can be used (Relay configuration screen), and for more
complex configurations a PLC Editor tool is provided (Logic Configuration screen).

c) Monitoring of all metering values, internal states, inputs and outputs provided by F650 device.

d) Performing the previously configured operations 

e) Updating of operating system, firmware version and web server utility.

f) One line diagrams configuration (bay mimics) for its use in models with graphical display only.

g) Registering data info for control events, snapshot events, alarms, fault reports, oscillography files, data logger, etc. 
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3.1.2 MAIN SCREEN

EnerVista 650 Setup software provides the following areas:

• Title

• Main menu bar

• Main icon bar

• Working area

• Status bar

Figure 3–1: ENERVISTA 650 SETUP MAIN SCREEN
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3.1.3 STARTING COMMUNICATION

To start communicating with the relay go to “Communication>Computer>Computer settings” section in the main
EnerVista 650 Setup menu. 

Safety instructions must be followed before connecting the computer to the relay. Safety instructions are detailed in section
1.1.3 SAFETY INSTRUCTIONS. Connect the relay ground terminal and the communicating computer to a good grounding.
Otherwise, communication may not be viable, or even, in worst cases, the relay and/or the computer could result damaged
by overvoltages.

For on-line working, previously ensure that all relay communication parameters, such as baudrate, slave ModBus address,
etc, match the computer settings. 

Figure 3–2: COMMUNICATION PARAMETERS MENU

The “Communication > computer” screen is divided in several subsections:

Computer settings: Main communication parameters for serial communication and control type selection.

ModBus/TCP Setup (if ModBus /TCP is selected as control type): Communication parameters for ModBus TCP
communication.

Communication control: Device communication status (communicating or not communicating).

Communication optimization: allows optimizing the communication time outs and failure establishing.
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COMPUTER SETTINGS: 

Shows the communication parameters necessary in order to establish communication with the unit. Such as slave address,
communication port, baud rate, parity, control type and startup mode.

Baud rate, parity, data bits, stop bits and ModBus slave address for com2 (RS232 front port and second serial port in the
rear communication board) are displayed in the default text logotype main screen.

ModBus Slave Address: ModBus addresses used for serial and Ethernet communication. These parameters can be
accessed through the relay HMI and EnerVista 650 Setup software. In Relay HMI: go to “Main screen>View or Change
Settings menu >Product Setup>Communication> ModBus Protocol”.

To move through the HMI, press intro (press in shuttle key) to enter in the internal menus and “esc” to exit.

In EnerVista 650 Setup go to “Setpoint>Product Setup>Communication Settings>ModBus Protocol”

Communication ports: port used in the computer for serial communication.

Baud Rate: Baud rate for serial communication (from 1200 up to 115200 bauds in EnerVista 650 Setup, from 300 to
115200 in relay). 

Parity: parity for serial communication. None, odd or even can be selected.

Baud rate and parity are serial communication parameters located both in serial ports menu. In relay HMI: go to “Main
screen>View or Change Settings menu >Product Setup>Communication> Serial Ports”. In EnerVista 650 Setup, go
to “Setpoint>Product Setup>Communication Settings>Serial Ports”.

Control Type: The available control modes are:

• No Control Type, this option selects the serial communication mode, for use with serial communication ports (front
port, RS485, or plastic or glass fiber optic).

• MODBUS/TCP, this option selects ModBus TCP/IP communication mode, for communication through the Ethernet
port. In this case, the top right window will show the typical parameters to be programmed; IP address, port address
and unit identifier in the MODBUS TCP SETUP section.

To access the relay IP address in relay HMI, go to “Main screen>View or Change Settings menu >Product
Setup>Communication> Ethernet>Ethernet 1 or 2”. In EnerVista 650 Setup, go to “Setpoint>Product
Setup>Communication Settings>Network (Ethernet)>Ethernet 1 or 2”.

For port address and unit identifier, in relay HMI go to “Main screen>View or Change Settings menu >Product
Setup>Communication>ModBus Protocol”. In EnerVista 650 Setup, go to “Setpoint>Product
Setup>Communication Settings>ModBus Protocol”.

• MODEM, this option displays the parameter to set in case of using a modem for the communication, such as Phone
number, Time out (sec), init. command, type of dialing (tones or pulses).

COMMUNICATION CONTROL:

The Communication Control subsection is located on the bottom left communication window and shows the communication
status in the relay. There are two legends, “Status” in which the communication text status will be displayed and
“Communication” which includes two buttons to start (ON) and stop (OFF) the communication with the relay.

Relay NOT communicating: In status, a message will be displayed with the communication status, e.g. 650 Setup is not
talking to an F650. The ON button will be available to press and the OFF button will be disabled (in grey color). In this stage
the relay is not communicating to the computer and the communication parameters can be modified to establish the
communication lately by pressing in the ON communication button.

http://xxx.xxx.xx.xxx
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Relay communicating: In status, a message will be displayed with the communication status, e.g. 650 Setup is now talking
to an F650. The ON button will be disabled (in grey color) and the OFF button will be available to press. In this stage the
relay communicating to the computer and the communication parameters cannot be modified. In the example on Figure 3–
2: COMMUNICATION PARAMETERS MENU , communication has not been established yet.

EnablingSecurity.htm
EnablingSecurity.htm
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COMMUNICATION OPTIMIZATION:

The parameters shown on the bottom right window (Communication optimization) can improve communication, although it
is recommended to leave the default values indicated by the EnerVista 650 Setup. These parameters are the maximum
time to wait for a response in the relay (in ms) and the maximum attempts to perform before assuming communications
failure.

The rest of options available in the Communication menu in EnerVista 650 Setup are:

• Modem: Allows configuring the unit for remote communications via modem, using telephonic line. It is only available if
the relay is not communicating and if modem has been select on Communication>computer control type selection. Go
to “Communication>Modem”

• Troubleshooting (Serial or Ethernet connection): Lets the user to perform reading or writing in ModBus addresses, for
verifying communications and access to different positions in the ModBus memory map. Only available if the
communication has already been established. Go to “Communication>Troubleshooting”. An example is provided in
Figure 3–3:

Figure 3–3: COMMUNICATION TROUBLESHOOTING SCREEN

• Calibration (Serial or Ethernet connection): Allows retrieving the unit calibration settings and storing them in a file (with
extension *.cal). For reading or storing the calibration settings in the relay go to “Communications>Calibration>Get
or Set calibration settings” and select the intended calibration file. The calibration retrieval process is necessary to
be performed before updating the unit boot code, when the operating system is updated all the data in the relay is
deleted, including the factory calibration settings. When only the firmware is updated (for versions higher than 1.50),
the calibration settings are automatically saved in the relay.

• Upgrade firmware version (Ethernet connection): Go to “Communications>Upgrade firmware version”, this menu
allows the user to update the firmware version of the relay through Ethernet communication. Firmware is related to the
relay internal program, designed by GE Multilin, which performs the protection and control functions, and which is run
by the relay main microprocessor.

• Upgrade operating system (Serial and Ethernet connection): Go to “Communications>Upgrade operating system”.
This option allows the user to update the relay boot code. This is the program that supports the firmware and provides
auxiliary services for access to electronic devices included in the relay.
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IMPORTANT NOTE: 

Thanks to the use of a double flash memory, one with the Bootcode startup program and the boot code, and a second one
with the application program (firmware), a high reliability is guaranteed when updating the unit firmware, as even in the
case of a communication breakdown during the firmware upgrade process, we can retry the process for an unlimited
number of times.

• Upgrade 650 web server (Ethernet connection): Go to “Communications> Upgrade 650 web server”. The relay web
server application can be updated to further versions (if available) using this menu without modifying the relay boot
code.

• Upload info files to relay (Ethernet connection): Go to “Communications>Upload info files to relay”. This
functionality is used to store setting files (*.650) inside the relay, as well as auxiliary files used by the programmable
logic graphical editor (*.pep, *.aut, *.lib).

• Download info files from relay (Ethernet connection): Go to “Communications>Download info files from relay”.
This functionality is used for retrieving the files (*.650 and *.pep, *.aut, *.lib) that have been previously stored in the
relay flash memory.

IMPORTANT NOTE: 

READ CAREFULLY THE FLASH MEMORY UPDATE PROCEDURE AND CLOSE
ALL THE RUNNING APPLICATIONS BEFORE PERFORMING FIRMWARE AND boot
code UPDATING PROCCESS

Before updating firmware check that the firmware version that is going to be updated
match the boot code version of the relay. Otherwise it is necessary to update the boot
code before proceeding to update the firmware. Other combinations of firmware and
boot code different from the listed below will not be operative

The boot code version is available in the logotype main screen in HMI; it is the number
between brackets in the first line, e.g. F6501.70 (2.35). The boot code version is 2.35

Firmware version up to 1.5X must be used with Boot Code 2.30 (or 2.20 and 2.35)

Firmware version from 1.6X up to 1.7X must be used with Boot Code 2.35

*.650 files contain protection, control settings, relay configuration and compiled logic
equations. This file can be retrieved from the relay, using the “File>Get info from
relay” option in EnerVista 650 Setup (through serial or Ethernet communication).
“File>Send info to relay” option stores this *.650 file in the relay.

*.pep, *.aut and lib files contain the logic configuration projects necessary to modify the
logic (virtual outputs) in the relay. These files can be stored in the relay, using the
“Communication>Upload info files to relay” option in EnerVista 650 Setup (through
Ethernet communication). They can be retrieved using “Communication>Download
info files to relay” option in EnerVista 650 Setup program (Ethernet communication).
Take into account that the *.pep, *.aut and library files are necessary to modify the PLC
logic (virtual outputs). Without these files setting and configuration can be modified but
not logic equations (virtual outputs). It is advisable to use the
“Communication>Upload info files to relay” option to store these logic configuration
files into the relay.

It is important to distinguish between “Send / Get info to relay” and “Upload /
Download info files to/from relay”. “File>Send/Get info to relay” sends/gets
settings and configuration and compiled logic equation to/from the relay (*.650 format),
and the relay automatically starts working with the new settings once they are stored.
“Communications>Upload/Download info files to relay“, stores/retrieves in the
relay flash memory: settings, configuration and compiled logic equations (*.650) besides
the PLC files (*.pep, *.aut, *.lib). This is only a physical storage (file backup).
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3.1.4 FILE MANAGEMENT

File management with EnerVista 650 Setup software:

3.1.4.1   OFF LINE MODE WITHOUT CONNECTION TO THE RELAY

Figure 3–4: OFF-LINE MODE FILE MANAGEMENT

 R u n   E n e r V i s t a  F 6 5 0  S e t u p

O p e n  a  * . 6 5 0  f i l e  
( “ F i l e > O p e n ”  m e n u )

M o d i f y  p r o t e c t i o n  S e t t i n g s  
a n d  r e l a y  c o n f i g u r a t i o n

I s  i t  n e c e s s a r y  t o  
p r o g r a m  

a d d i t i o n a l  l o g i c ?

L a u n c h  t h e  L o g i c  C o n f i g u r a t i o n  t o o l  i n  E n e r V i s t a  
F 6 5 0  S e t u p  ( “ S e t p o i n t > L o g i c  C o n f i g u r a t i o n ” )  

C r e a t e  n e w  o r  m o d i f y  t h e  e x i s t i n g  l o g i c :  
( “ F i l e > O p e n  P r o j e c t ” )  

C o m p i l e  a n d  s a v e  l o g i c  f i l e  ( * . p e p )  a n d  d r a w i n g  
d e s i g n  ( * . a u t )  i n  L o g i c  C o n f i g u r a t i o n  t o o l  

E x i t  P L C  G r a p h i c  E d i t o r  a n d  s a v e  t h e  * . 6 5 0  f i l e  
f r o m  t h e  m a i n  a p p l i c a t i o n  m e n u  

I s  t h e  r e l a y  
c o m p l e t e l y  

c o n f i g u r e d ?  

S a v e  * . 6 5 0  s e t t i n g s  &  c o n f i g u r a t i o n  f i l e  
 

S t o r e  i n  t h e  c o m p u t e r  t h e  L o g i c  c o n f i g u r a t i o n  f i l e s  ( * . p e p ,  * . a u t ,  * . l i b )  a s  
w e l l  a s  t h e  * . 6 5 0  f o r  f u r t h e r  l o g i c  c h a n g e s .  

Y E S

Y E S

N O  N O  
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NOTE 1: Depending on the type of Inputs/Outputs incorporated in relay slots F and G, configuration options will be different.
There are 2 template files available for working off-line with any F650 available model: 

F650_F1G0_V200.650: Board 1 in slot F and without any board in slot G.

F650_F1G1_V200.650: Board 1 in slot F and board 1 in slot G.

F650_F1G4_V200.650: Board 1 in slot F and board 4 in slot G.

F650_F1G5_V200.650: Board 1 in slot F and board 5 in slot G.

F650_F2G0_V200.650: Board 2 in slot F and without any board in slot G.

F650_F2G1_V200.650: Board 2 in slot F and board 1 in slot G.

F650_F2G4_V200.650: Board 2 in slot F and board 4 in slot G.

F650_F2G5_V200.650: Board 2 in slot F and board 5 in slot G.

Table 3–1:  TYPES OF FILES GENERATED BY ENERVISTA 650 SETUP SOFTWARE OPERATION MODE OFF-LINE: 

FILE TYPE SETTINGS & CONFIGURATION FILE *.650
LOGIC CONFIGURATION FILES (*.PEP, *AUT, *.LIB)

*.PEP *.AUT *.LIB

Relevant 
sections inside 
the file

Protection Settings and 
Configuration Section

Compiled logic equations 
section

Header for 
Logic project

Graphical edition 
container. Logic 
equations in FDB 
format.

User programmable 
logic objects

Created by EnerVista 650 Setup Logic configuration graphic 
editor (PLC Editor)

Logic 
configuration 
graphic editor 
(PLC Editor)

Logic configuration 
graphic editor (PLC 
Editor)

Logic configuration 
graphic editor (PLC 
Editor)

Definition and 
contents

Relay configuration file 
containing all 
protection elements 
Settings, input/output 
and LEDs 
configuration, graphic 
display configuration, 
etc.

Equations corresponding to 
the logic created and compiled 
in the PLC Editor

PLC project file 
containing the 
necessary 
information 
relative to the 
relay model, 
logic libraries 
included in the 
project (*.lib), 
graphic file 
name (*.aut), 
etc.

PLC Project file 
containing all the 
drawings used by the 
logic, required by F650 
relay based on IEC 
61131-3 standard. 
Functional block 
diagram (FDB).

Library file to be 
included as an object 
in a PLC project. 
Logic packages that 
can be stored into 
libraries and be 
distributed in different 
PLC projects.

File storage in 
the PC

EnerVista 650 Setup:
“File>Save *”

EnerVista 650 Setup:
“File>Save *”
It is necessary to store the 
logic configuration files used to 
create the PLC project for 
further logic modifications.

PLC Editor:
“File>Save 
Project”

PLC Editor:
“File>Save Project”

PLC Editor: 
“File>Save Library”

File Retrieval 
of previously 
stored files in 
PC

EnerVista 650 Setup:
“File>Open *”

EnerVista 650 Setup:
“File>Open *”
It is necessary to have the 
logic configuration files used to 
create the PLC project

PLC Editor:
“File>Open 
Project”

PLC Editor:
“File>Open Project”

PLC Editor:
“File>Library>New 
Library”

Basic 
information 
transfer mode 
to the relay

Connect with the relay 
(“Communications>Computer”)
Open the created file (“File>Open *”)
Send to relay from the menu: “File>Send info to relay”
Note that texts used in the configuration of inputs, 
outputs, etc. are not sent to the relay. The only texts 
sent to relay are operations, events, and LEDs.

Connect with the relay (“Communications>Computer”)
Launch F650 PLC Editor (“Setpoint>Logic Configuration”)
Open the created PLC project (“File>Open Project”)
Compile the project (“Run>Compile”)
Now the logic (virtual outputs) can be sent directly to relay 
(“Run>Send Equations to Relay”). Texts of virtual outputs are 
not stored in the relay, only in the logic configuration files to be 
edited.
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In case of using element libraries (either existing (“File Library>Open Library”) or created by the user (“File Library>New
Library”)), the program will create and manage the corresponding files (*.lib) in a folder named FDB (Functional Block
Diagram). These files are used for the PLC project compilation. It is necessary to store them with the other logic
configuration files that built the PLC project (*.pep, *.aut, *.lib).

Besides sending basic information to the relay (Settings + configuration) in *.650 format, it is recommended to store *.650,
*.pep, *.aut and *.lib files inside the relay (“Communication>Upload info files to relay”), to ensure that logic configuration
files will be available in the future for further logic modifications; either if these files are not used by the relay, they are
required for connecting to a relay and analyzing its configuration. The program manages the logic configuration files
globally, so that when the user selects to save file *.pep in the relay, the associated *.aut and *.lib files are also stored.

File storage inside the relay  
(RECOMMENDED) “Communication > Upload info files to relay” through Ethernet 

Retrieval of files stored in the relay  
(RECOMMENDED) “Communication > Download info files from relay” through Ethernet
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3.1.4.2   ON LINE MODE CONNECTED TO THE RELAY

Figure 3–5:  ON LINE MODE FILE MANAGEMENT

 

N O  

R u n   E n e r V i s t a  F 6 5 0  S e t u p

C o n n e c t  t o  t h e  r e l a y  
( “ C o m m u n i c a t i o n > C o m p u t e r > O N ” )

M o d i f y  a n d  s e n d  t o  t h e  
r e l a y  p r o t e c t i o n  S e t t i n g s  
a n d  r e l a y  c o n f i g u r a t i o n

I s  i t  n e c e s s a r y  t o  
p r o g r a m  

a d d i t i o n a l  l o g i c ?

L a u n c h  t h e  L o g i c  C o n f i g u r a t i o n  t o o l  i n  E n e r V i s t a  
F 6 5 0  S e t u p  ( “ S e t p o i n t > L o g i c  C o n f i g u r a t i o n ” )

C r e a t e  n e w  o r  m o d i f y  t h e  e x i s t i n g  l o g i c  
( “ F i l e > O p e n  P r o j e c t ” )  

C o m p i l e  ( “ R u n > C o m p i l e ” )  
a n d  s a v e  l o g i c  f i l e  ( * . p e p )  a n d  d r a w i n g  d e s i g n  

( * . a u t )  i n  6 5 0  P L C  E d i t o r  l  ( “ F i l e > S a v e  P r o j e c t ” )

S e n d  l o g i c  t o  r e l a y  ( “ R u n > S e n d  E q u a t i o n s  t o  
R e l a y ” )  a n d  E x i t  P L C  G r a p h i c  E d i t o r  

I s  t h e  r e l a y  
c o m p l e t e l y  

c o n f i g u r e d ?  

S a v e  a l l  s e t t i n g s  &  c o n f i g u r a t i o n  ( “ F i l e > G e t  i n f o  f r o m  r e l a y ” )  
 

S t o r e  i n  t h e  r e l a y  t h e  L o g i c  c o n f i g u r a t i o n  f i l e s  ( * . p e p ,  * . a u t ,  * . l i b )  a s  w e l l  a s  t h e  
* . 6 5 0  f o r  f u r t h e r  l o g i c  c h a n g e s .  ( “ C o m m u n i c a t i o n > U p l o a d  i n f o  f i l e s  t o  r e l a y ” )

N O  

Y E S

Y E S
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Table 3–2:   TYPES OF FILES CREATED BY ENERVISTA 650 SETUP– ONLINE OPERATION MODE 

FILE TYPE SETTINGS & CONFIGURATION FILE *.650
LOGIC CONFIGURATION FILES (*.PEP, *.AUT, *.LIB)

*.PEP *.AUT *.LIB

Relevant 
sections 
inside the file

Protection Settings and 
Configuration Section

Compiled logic equations 
section (relay configuration 
and logic configuration)

Header for Logic 
project

Graphical edition 
container. Logic 
equations (Virtual 
Outputs) in FDB 
format.

User programmable 
logic objects

Created by EnerVista 650 Setup
Logic configuration graphic 
editor (PLC Editor) and relay 
configuration screen

Logic configuration 
graphic editor (PLC 
Editor)

Logic configuration 
graphic editor (PLC 
Editor)

Logic configuration 
graphic editor (PLC 
Editor)

Definition and 
contents

Relay configuration file 
containing all protection 
elements, settings, input/
output and LEDs 
configuration, graphic 
display configuration, etc.

Equations corresponding to 
the logic created and 
compiled in the PLC Editor

PLC project file 
containing the 
necessary 
information relative 
to the relay model, 
logic libraries 
included in the 
project (*.lib), 
graphic file name 
(*.aut), etc.

PLC Project file 
containing all the 
drawings used by 
the logic, required 
by F650 relay 
based on IEC 
61131-3 standard. 
Functional block 
diagram (FDB).

Library file to be 
included as an object 
in a PLC project. 
Logic packages that 
can be stored into 
libraries and be 
distributed in different 
PLC projects.

Basic 
information 
transfer mode 
to the relay

Connect with the relay (“Communications>Computer”) Connect with the relay (“Communications>Computer”)
Send settings and configuration from file: Launch 650 PLC Editor (“Setpoint>Logic Configuration”)

Send protection and 
control settings to relay: 
“File>Send info to 
relay”, select *.650 file, 
choose Protection and 
Control settings option in 
screen and press send

Send configuration and logic 
compiled equation to relay: 
“File>Send info to relay”, 
select *.650 file, choose 
“Relay and Logic 
Configuration” option in 
screen and press send.
When the message 
“Configuration stored” 
appear in the relay HMI the 
configuration has been 
stored.

Open the created PLC project (“File>Open Project”)
Compile the project (“Run>Compile”)

Now the logic (virtual outputs) can be sent directly to relay 
(“Run>Send Equations to Relay”). Texts of virtual outputs are 
not stored in the relay, only in the logic configuration files to be 
edited.

Modify settings and configuration directly in the relay:

Go to “Setpoint>
>>Product Setup
>>System Setup
>>Protection Elements
>>Control Elements
>>Inputs/Outputs” in 
EnerVista 650 Setup and 
modify the selected 
settings and press store 
to send them to the relay.

Go to “Settings>Relay 
Configuration>
>>Outputs
>>LEDs
>>Operations
>>Protection Elements
>>Oscillography
>>Operations
>>Control Events
>>Switchgear
>>Inputs
>>Virtual Inputs
>>Operations
>>MMI (HMI)”
in EnerVista 650 Setup, 
modify the selected values 
and press store to send them 
to the relay.

File storage in 
PC

EnerVista 650 Setup:
“File>Get info from 
relay”. User definable 
texts retrieved are 
operations, events, and 
LEDs.

EnerVista 650 Setup:
The relay provides this 
information in a basic format 
(compiled equations). It is 
necessary to have the logic 
configuration files used for 
creating the PLC project to 
view the logic in a graphical 
way (FDB) and be able to 
modify it (virtual outputs).

PLC Editor:
“File>Save Project” “File>Save Library”

The relay will not 
provide this 
information unless 
the *.pep file is 
stored in the relay 

The relay will not 
provide this 
information unless 
the *.pep file is 
stored in the relay.

The relay will not 
provide this 
information unless 
the *.pep file is stored 
in the relay.

To store the logic configuration files in the relay use the 
“Communication>Upload info files to relay” option

File storage inside the relay in a flash memory  (RECOMMENDED): “Communication>Upload info files to relay” through Ethernet 

File Retrieval of relay hard disk stored files (RECOMMENDED): “Communication/Download info files from relay” through 
Ethernet
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3.1.5 ENERVISTA 650 SETUP MENUS STRUCTURE

The EnerVista 650 Setup menus structure is shown in EnerVista 650 SETUP MENUS STRUCTURE. 

Unless specified, options are available in both On-line and Off-line mode.

Options enabled only in On-line mode are marked as (*)

Options enabled only  in Off-line mode are marked as (**)

The “View > Language” submenu allows the user to change the default language for the EnerVista 650 Setup program and
it is only enabled when the relay is not communicating and no file has been opened.

Table 3–3:  ENERVISTA 650 SETUP MENUS STRUCTURE

REMINDER:

Logic programming support files (*.pep, *.aut, *.lib) CANNOT be retrieved directly from the relay.

It is necessary 

* Either to have stored these files in the PC 

* Or to have uploaded previously the files into the relay (“Communication>Upload info files to relay”)

FILE SETPOINT ACTUAL OPERATIONS
(*) COMMUNICATION SECURITY VIEW HELP

Open (**) Product Setup Front Panel NA Computer Login user Traces Instruction 
Manual

Save As 
(**) System Setup Status NA Modem (*) Change 

Password
ModBus 
Memory 
Map

About 
EnerVista 
650 Setup

Close (**) Protection 
Elements Metering NA Troubleshooting (*) User 

Management
Languages 
(**)

Config File 
Converter

Control 
Elements Inputs/Outputs NA Calibration (*)

Properties 
(**) Inputs/Outputs Records (*) NA Upgrade firmware 

version (*)
Get info 
from relay 
(*)

Relay 
Configuration NA Upgrade operating 

system (*)

Send info 
to relay (*)

Logic 
Configuration NA Upgrade F650 Web 

Server
Print Setup 
(**) Clock (*) NA Upload info files to 

relay
Print 
Preview 
(**)

NA Download info files 
from relay

Print (**) NA
Print to file 
(**) NA

Exit NA
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3.1.6 FILE MENU OVERVIEW

Table 3–4:   GENERAL OVERVIEW OF FILE MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

FILE

Open (**) Open a settings and configuration file for off-line working. 

Save As (**) Save *.650 settings and configuration file.

Close (**) Close the opened *.650 file in EnerVista 650 Setup. 

Config File (*.650) 
Converter Tool to convert the *.650 files from one version to another

Properties (**) File properties for *.650.

Get info from relay (*) Retrieve the *.650 settings and relay configuration compiled equations 
from the relay.

Send info to relay (*) Send and write the *.650 settings and configuration to the relay. 

Print Setup (**) To configure printer settings.

Print Preview (**) Preview of settings and configuration file printing format.

Print (**) Launch the *.650 file to be printed.

Print to file (*.xls) (**) *.650 printed to file in excel format. 

Exit Quit the application closing all the open windows.
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3.1.6.1   OPEN, SAVE AS AND CLOSE

In these options, the program opens a dialog box (with default path to Files>Config program folder) where the setting and
configuration files can be selected for their “off-line” edition. For enabling access to this menu, there must be no
communication between the PC program and the relay. (Mode off-line: “Communication>Computer>OFF”).

Figure 3–6: OPEN FILE MENU

Once the *.650 file with the appropriated relay model (FXGX) is selected, the program will enable the off-line options to fully
program the unit. The enabled menus in the EnerVista 650 Setup program are: File, Settings, Actual, Communication, View
and Help.

The off-line mode displays the File, Settings, Actual, Communication, View and Help submenus to program the unit. 

The Actual values submenus are for structure purposes only Values are not refreshed while the relay is not communicating.

The “Save as” and ”Close” submenus are used to save the *.650 file into the computer and to close the current file. To work
in off line mode for settings and configuration edition it is not necessary to use the ”Close” option, a new *.650 can be
opened without closing the previous one. The ”Close file” option is used to clear all data in EnerVista 650 Setup program,
enabling “Language”, ”Upload firmware” and “boot code” options.
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3.1.6.2   CONFIG FILE (*650) CONVERTER

Figure 3–7: CONFIG FILE (*650) CONVERTER MENU

This tool provides automatic conversion of configuration files from a firmware version to a previous or later version.

Open the source *.650 file and select the version and model to be converted to.

It is possible to change the model type (FXGX) using the conversion tool. It must be taken into account that part of the logic
can be readjusted to fit the new input and output boards selection. Notice also that the external wiring of inputs and outputs
board are different for type 1, 2, 4 and 5.

3.1.6.3   PROPERTIES

When this option is selected, the program will show a screen including the relay model information, firmware version, etc. of
the file being edited, as shown on Figure 3–8:

Figure 3–8: FILE PROPERTIES MENU

3.1.6.4   PRINTING OPTIONS (PRINT SETUP/PRINT PREVIEW/PRINT/PRINT TO FILE)

The printing options are active only in off-line mode, in “File edition”, and not in on-line mode, connected with the relay.
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3.1.6.5   PRINT SETUP

Option to configure the printing options and settings for the printing device.

3.1.6.6   PRINT PREVIEW

Option to preview the whole settings and configuration file (*.650) in paper format to be printed as shown in Figure 3–9:.

Figure 3–9: PRINT PREVIEW OF SETTINGS FILE

3.1.6.7   PRINT

In this option, the program will print the relay configuration using the PC default (active) printer on port COMx or LPT. This
option is active only in off-line mode, in file edition, and not in on-line mode, connected with the relay.

3.1.6.8   PRINT TO FILE (*XLS)

Possibility to export the configuration file to an Excel file using the “Print to file (*.xls)” option.
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3.1.7 SETTINGS MENU OVERVIEW

Table 3–5:  GENERAL OVERVIEW OF SETPOINT MENU IN ENERVISTA 650 SETUP:

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

3.1.7.1   PRODUCT SETUP 

Table 3–6:  GENERAL OVERVIEW OF PRODUCT SETUP MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

SETPOINT

Product Setup
Communications settings for all protocols and physical mediums. 
ModBus user map definition, fault report, oscillography, data logger and 
demand settings.

System Setup General Settings, Flex Curves Definition, Breaker settings and 
maintenance, and switchgear snapshot events management.

Protection Elements
Phase, Neutral, Ground, Sensitive Ground and Negative Sequence 
Current Settings. Voltage Elements settings and Power Settings 
management.

Control Elements
Setting groups, under and overfrequency settings, synchrocheck, 
autoreclose, breaker failure, VT fuse failure, broken conductor  and 
locked rotor settings management.

Inputs/Outputs Contact I/O settings for all boards available in device, Remote Comms.

Relay Configuration
Configuration of Outputs, LEDs, Operations, Protection Elements, 
Oscillography, Operations, Control Events, Switchgear, Inputs, Virtual 
Inputs, Operations and HMI. Whole relay configuration with internal relay 
signals or user-definable ones as logic (virtual outputs).

Logic Configuration
Logic configuration graphic editor (PLC Editor). It is a PLC Project file 
editor that contains all the internal drawings used to make the logic 
(virtual outputs) based on IEC 61131-3 standard. Functional block 
diagram (FDB).

Clock (*) Relay synchronization to computer clock or to user-definable date and 
time. On-line mode only.

PRODUCT 
SETUP

Communication 
Settings

Serial Ports, Network (Ethernet), ModBus Protocol, DNP Slave and IEC 
870-5-104 settings.

ModBus User Map ModBus user map definition. The ModBus user map is formed by 256 
records, selectable from the complete relay ModBus map.

Fault Report Fault report settings. Possibility to show fault reports on HMI screen.

Oscillography
Oscillography settings (trigger position, samples per cycle, etc). The 
trigger and digital channels (up to 16) must be configured in 
“Settings>Relay configuration”.

Data Logger Data logger configuration

Demand Demand settings. The demand trigger and demand reset signals must be 
configured in “Settings>Relay configuration”
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e) COMMUNICATION SETTINGS

This section details the settings related to communication parameters for the different protocols available in the F650.

Table 3–7:  GENERAL OVERVIEW OF COMMUNICATION SETTINGS MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

3.1.7.2   SYSTEM SETUP 

This section shows the settings related to the system setup definition such as shown in the following table.

Table 3–8:  GENERAL OVERVIEW OF SYSTEM SETUP MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

COMMUNICATI
ON SETTINGS

Serial Ports Baud rate and parity for COM1 and COM2 serial communication ports.

Network (Ethernet)

Ethernet communication parameters for COM3 (IP Address, Netmask, 
Gateway IP, etc.)
NOTE: The ModBus Slave address used by Ethernet ports is the one set 
for COM2.EnerVista 650 Setup software allows programming two 
different Ethernet addresses, but the first IP has always to be set as the 
second IP Address is an Alias.

ModBus Protocol ModBus Slave Addresses for serial and Ethernet communication and the 
ModBus port number used for ModBus TCP/IP

DNP3 Slave
Physical port, Slave Address for DNP, IP Addresses for Masters, TCP/
UDP Port, Unsolicited Response parameters, Analog scale factors and 
deadbands, message fragment size, Binary input block.

IEC 870-5-104, TCP Port, Common Addr of ASDU, Cyclic Meter Period and, 
Synchronization Event settings.

SNTP (*) Sinchronization over Ethernet settings

SYSTEM 
SETUP

General Settings

This screen describes and enables the settings of the power system 
where the relay will operate. Some of these settings will be used only for 
metering values presentation purposes; however, some of them apply 
directly to the sampling and analog-digital conversion process (rated 
frequency setting). Therefore, these settings need to be adjusted so that 
they fit the system settings.

Flex Curves

Flex Curves – Programmable user curves: The relay incorporates 4 user 
curves called Flex Curve A, B, C and D. The points for these curves are 
defined by the user in “Settings>System Setup>Flex Curves>Edit 
Curve” menu in EnerVista 650 Setup. User defined flex curves can be 
selected as an operation curve in all the time overcurrent functions in the 
relay.

Breaker settings

Breaker settings, maintenance and switchgear selection of the device 
configured as breaker in the F650. The selected switchgear will be used 
in recloser, breaker failure and synchronism functions. The settings are 
Number of Switchgear, Maximum KI2t, KI2t Integ. Time, Maximum 
Openings, Max.Openings 1 hour.

Breaker maintenance

These settings correspond to the initialization of (KI)2t counters, and the 
counting of number of openings and closings of the switchgear 
configured as breaker. These Counters allow the breaker Maintenance. 
They are used to cumulate the breaker ageing produced by a trip or a 
breaker opening. In order to incorporate the breaker historic, in case of 
existing breakers, the system allows assigning an initial value to 
accumulated amperes, and to the number of opening and closing 
operations.

Switchgear Configuration of snapshot events for each switchgear (enable or disable)
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3.1.7.3   PROTECTION ELEMENTS

This option shows all the protection-grouped elements available in the relay as shown in Table 3–9:. Each of these groups
includes the specific protection units of the same type. For example phase currents group includes TOC, IOC, directional
units, etc. There are three groups available, so there are three protection units of each function that can work in grouped
mode or ungrouped (altogether).

Table 3–9:  GENERAL OVERVIEW OF PROTECTION ELEMENTS MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

PROTECTION 
ELEMENTS

Phase Current All overcurrent grouped functions for phase current.

Neutral Current All overcurrent grouped functions for neutral current. (Calculated from 
phases, not measured)

Ground Current All overcurrent grouped functions for ground current. (Measured from 4th 
current input)

Sensitive Ground 
Current

All overcurrent grouped functions for sensitive ground current. 
(Measured from 5th current input)

Negative Sequence 
Current Negative sequence time overcurrent function

Voltage Elements All under and overvoltage grouped functions for phases, neutral, 
auxiliary voltage and negative sequence.

Power Forward and directional power grouped protection functions.
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Table 3–10:  DIFFERENT PROTECTION ELEMENTS INCLUDED

PHASE 
CURRENT

Phase TOC High Phase time overcurrent, high level (51PH)

Phase TOC Low Phase time overcurrent, low level (51PL)

Phase IOC High Phase instantaneous overcurrent, high level (50PH)

Phase IOC Low Phase instantaneous overcurrent, low level (50PL)

Phase Directional Phase directional unit (67P). Quadrature Voltage for polarization

Thermal Model Thermal model or Thermal image unit for phases (49)

NEUTRAL 
CURRENT

Neutral TOC Neutral time overcurrent (51N)

Neutral IOC Neutral instantaneous overcurrent (50N)

Neutral Directional Neutral directional unit (67N). Voltage, current and dual polarization.

GROUND 
CURRENT

Ground TOC Ground time overcurrent (51G)

Ground IOC Ground instantaneous overcurrent (50G)

Ground Directional Ground directional unit (67G). Voltage, current and dual polarization.

SENSITIVE 
GROUND 
CURRENT

Sensitive Ground TOC Sensitive ground time overcurrent (51SG)

Sensitive Ground IOC Sensitive ground instantaneous overcurrent (50SG)

Isolated Ground IOC Isolated ground overcurrent (50IG)

Sensitive Ground 
Directional Sensitive ground directional unit (67SG)

NEGATIVE 
SEQUENCE 
CURRENT

Negative Sequence 
TOC Negative sequence time overcurrent (46P)

VOLTAGE 
ELEMENTS

Phase UV Phase undervoltage (27P)

Phase OV Phase overvoltage (59P)

Neutral OV High Neutral overvoltage, high level (59NH)

Neutral OV Low Neutral overvoltage, low level (59NL)

Negative Sequence 
OV Negative sequence overvoltage (47)

Auxiliary OV Auxiliary overvoltage (59X)

Auxiliary UV Auxiliary undervoltage (27X)

POWER

Forward Power Forward power (32FP), in primary values.

Directional Power Directional power (32), in primary values.
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3.1.7.4   CONTROL ELEMENTS

This option shows all the control elements available in the relay as shown in Table 3–11:. Some of the elements are
grouped ones such as underfrequency, overfrequency and broken conductor. 

Table 3–11:   GENERAL OVERVIEW OF CONTROL ELEMENTS MENU:

CONTROL 
ELEMENTS

Setting Group

F650 units incorporate a flexible grouping capability for protection units. 
This means that protection units can be used in either single setting 
group (default mode-all units can operate simultaneously) or three 
setting groups (in this mode, protection units are grouped in three 
independent tables, with only one of them  active at a given time).
Protection element grouping involves only Protection elements together 
with broken conductor detection and over and under frequency, which 
are usually considered as control elements. The rest of control elements 
such as recloser, fuse failure, breaker failure, synchronism, and breaker 
settings are not involved in the tabled groups concept.

Underfrequency Underfrequency unit (81U). Grouped element

Overfrequency Overfrequency unit (81O). Grouped element

Synchrocheck Synchronism check unit (25). Not grouped, a single unit provided

Autoreclose Recloser (79). Not grouped, a single unit provided

Breaker Failure Breaker failure (50BF). Not grouped, a single unit provided

VT Fuse Failure Fuse Failure (VTFF). Not grouped, a single unit provided

Broken Conductor

Broken or fallen conductor detection function (I2/I1). Grouped element.
Ratio between the negative sequence current, I2, and the positive 
sequence current I1. In normal and balanced load situations, this ratio is 
zero, while in severe load fault conditions, an unbalance is produced and 
this ratio is increased.

Locked Rotor Locked rotor detection function (48). Grouped element.
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3.1.7.5   INPUT/OUTPUTS

Section that contains the settings for all input and output boards and the Force Outputs and Virtual inputs activation tools. 

Table 3–12:  GENERAL OVERVIEW OF “INPUTS/OUTPUTS” SETTINGS MENU. 

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

This section shows the settings related to inputs and outputs for the different boards available in F650 (F, G, H, J).

Table 3–13:  GENERAL OVERVIEW OF “INPUTS/OUTPUTS>CONTACT I/O” SETTINGS MENU. 

INPUTS/
OUTPUTS

Contact I/O
Inputs and outputs settings for all boards in F650. The I/O settings 
configuration can only be performed through EnerVista 650 Setup, not 
HMI available.

Force Outputs (*) This menu allows activating each contact output in the relay, to facilitate 
maintenance testing. On line mode only. 

Virtual Inputs (*)
This menu allows operating virtual inputs. These variables are used as 
inputs to logic schemes configured in the relay. Virtual inputs can be 
operated in a latched mode (32 latched virtual inputs) or in Self-reset 
mode (32 self reset virtual inputs).

Remote Comms. This menu allows configuring remote inputs coming from other devices 
through GSSE messages.

CONTACT I/O

Board F Board located in first slot, always connected, either type 1 or 2.

Board G Board located in second slot, depends on model definition. If model is 
type G0 there is no board in second slot.

Board H Board located in first slot of CIO Module (external inputs/outputs module)

Board J Board located in second slot of CIO Module (external inputs/outputs 
module)
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3.1.7.6   RELAY CONFIGURATION

This is the relay configuration section in which the relay can be configured using internal states or already compiled
equation on PLC Editor.

Table 3–14:  GENERAL OVERVIEW OF RELAY CONFIGURATION MENU:

RELAY CONFIG

Outputs Configuration of contact output operate and reset signals for all boards.

LEDs
15 LEDs fully configurable from any logical variable, contact or virtual 
input. First 5 LEDs are latched by hardware, the rest are self-reset but 
can be latched through PLC configuration. From the LED configuration 
screen, it is possible to print the vertical LED label for the relay

Operations Configurable operations up to 24. Operation texts, interlocks, final states, 
frontal keys, time outs and masters.

Protection Elements
This tab allows assigning operands (logic signals) as inputs to different 
protection elements. To block, reset, initiate the different protection 
elements inputs.

Oscillography

Trigger and up to 16 digital channels to be included in oscillography 
records, are programmable from any logical variable, contact or virtual 
input. Text configuration is only for off-line mode.
NOTE: This screen is used for the configuration of digital channels and 
oscillography trigger. The rest of parameters, such as function enabling/
disabling, sampling rate, number of oscillography files, etc. must be set 
on the Settings>Product Setup>Oscillography menu.

Control Events

Up to 128 user programmable events from any logical variable, contact 
or virtual input. Possibility to display the event as an alarm on the alarms 
panel. Control events are also displayed in the snapshot events 
recording. 1 ms time tagging.
A control event is a logic signal associated to an operand or combination 
of operands, that allows following the status of that signal. 

Switchgear

Up to 16 configurable switchgear elements. A switchgear element can be 
a breaker, a line selector switch, a grounding selector switch, a busbar 
selector switch, etc. This screen allows configuration of type of contacts, 
opening and closing time, contact assignation and text for events related 
to switchgear. There are 64 pre-established events for switchgear, which 
correspond to opening, closing, Error01 and Error11 of the 16 
programmable switchgear elements.

Remote outputs Up to 32 DNA bits and 6??????  bits to be transmitted to remote devices 
over CAN using GSSE messages

Inputs Text configuration for off-line mode file management for all the contact 
inputs available in device.

Virtual Inputs Text configuration for off-line mode file management. 32 latched and 32 
self reset virtual inputs.

MMI (HMI-Human 
Machine Interface)

Screen for one line diagram configuration. This menu shows a scenario 
to draw a simplified one-line diagram of a bay in a feeder, line, 
transformer, etc. The menu includes a library for power elements, 
metering elements, text and drawings. See an example in Figure 3–11:
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The following figures show an example of the default factory configuration for F650.

Figure 3–10: RELAY CONFIGURATION

Figure 3–11: HMI CONFIGURATION 
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3.1.7.7   LOGIC CONFIGURATION

This logic configuration allows creating more complex configurations, using the graphical PLC, than using the tables from
Relay Configuration. For file management detailed information go to section 3.1.4.

Table 3–15:  GENERAL OVERVIEW OF LOGIC CONFIGURATION MENU:

LOGIC CONFIG

*.pep
Header for Logic project: PLC project file containing the necessary 
information relative to the relay model, logic libraries included in the 
project (*.lib), graphic file name (*.aut), etc.

*.aut
PLC Project file containing all the drawings used by the logic, required by 
F650 relay based on IEC 61131-3 standard. Functional block diagram 
(FDB).

*.lib
User programmable logic objects: Library file to be included as an object 
in a PLC project. Logic packages that can be stored into libraries and be 
distributed in different PLC projects.
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3.1.7.8   CLOCK

This menu allows to update the date and time of the relay, either synchronizing them with the PC clock, or entering the
information manually. 

Figure 3–12: CLOCK

3.1.8 ACTUAL VALUES MENU OVERVIEW

The menu bar in the main screen of EnerVista 650 Setup software shows the ACTUAL menu option. This option
concentrates and displays all the status of protection, control elements, metering, counters information, oscillography,
events, fault locator, etc. This section shows only the structure of menus in EnerVista 650 Setup.

Table 3–16:  GENERAL OVERVIEW OF ACTUAL VALUES MAIN MENU:

3.1.8.1   FRONT PANEL

The front panel menu shows only the LEDs submenu where all the front LEDs can be monitored.

3.1.8.2   STATUS

The following menu includes all the available protection status in the device.

ACTUAL

Front Panel>LEDs The relay front LEDs status is shown on this menu.

Status Protection and control status signals for all available protection functions 
in device.

Metering All metering values available in device.  Primary and secondary values, 
frequency and phasor diagram provided.

Inputs/Outputs All input and output status provided. For contact inputs and contact 
outputs as well as virtual input and virtual output signals.

Records Only enabled in on line mode, retrieval of all the available records in 
device. Snapshot events, control events, oscillography and fault reports.
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Table 3–17:  GENERAL OVERVIEW OF STATUS MENU:

Table 3–18:  DIFFERENT CONTROL ACTUAL VALUES INCLUDED IN THE CONTROL ELEMENTS MENU

STATUS

Operation bits
Up to 24 elements. OPERATION BIT XX is (0) when the configured time 
out for the operation XX expires or when success conditions are met. 
And it is (1) if operation XX is executed and interlocks are fulfilled.

Breaker
Breaker status (open, closed or undefined). The rest of the status signals 
corresponding to the switchgear XX configured as breaker are in the 
“Status>Switchgear Status>Switchgear XX” menu.

Protection Status of all the protection units in the device.

Control Elements Status of all the control units available in the device.

Protection Summary This screen shows a complete list of all protection and control elements 
in the relay, showing their status (enabled or not). 

Snapshots events 
summary

Summary of the snapshot events status (enabled or disabled) for 
protection, control, inputs and outputs boards and switchgear. 

ModBus User Map
Up to 256 elements. Value in SIGNED INT 16 BIT format of the reading 
for the selected address configured in “Settings>Product 
Setup>ModBus User Map”

Switchgear Status
Up to 16 blocks of switchgear status signals for the 16 configurable 
devices. Status signals such as inputs for A and B contacts, status for A 
and B, open and close status, error 00 and error 11, open init and close 
init, fail to open and fail to close signals.

Calibration Internal states for calibration. Factory calibration and calibration error 
signals.

Flex Curves
Flex curve status for A, B, C and D user curves. (0) if it is not configured, 
(1) if it is configured. To configure a flex curve go to “Settings>System 
Setup>Flex Curves” menu.

System Info This screen can monitor the system parameters and the internal status of 
the Relay boot code. Not enabled by default, password required

Records Status
Information related to the different records stored in the Relay, such as: 
Fault reports, control events, oscillography, data logger, demand, energy, 
and breaker maintenance.

SNTP-IRIG-B Information related to synchronization via IRIG_B or SNTP

CONTROL

Frequency Status signals (pickups and operations) for under and overfrequency 
units.

Synchrocheck Status signals for synchrocheck function (25).

Autoreclose Status signals for autoreclose function (79). Close signal, recloser status 
(ready, lockout, etc), block signals after each shot.

Breaker Failure Status signals for breaker failure function (50BF).

VT Fuse Failure Fuse failure detection signal.

Broken Conductor Status signals (pickups and operations) for broken conductor (I2/I1).

Setting Groups Status signals (activations and blocks) for the relay setting group change. 
By default the “setting group” setting is disabled and all the grouped 
elements can be enabled at the same time.

Locked Rotor Status signals (pickups and operations) for locked rotor units.
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Table 3–19:  DIFFERENT PROTECTION ACTUAL VALUES INCLUDED IN THE PROTECTION MENU

Table 3–20:  SHOWS THE ACTUAL VALUES RELATED TO RECORDING FUNCTIONS IN THE RECORDS STATUS 
MENU:

PROTECTION

Protection Blocks This screen shows all the protection element blocks available. Protection 
elements block signals can be configured at “Settings>Relay 
Configuration > Protection Elements”.

Phase Current Protection status signals (pickups and operations) for time overcurrent, 
instantaneous overcurrent and directional protection functions for phase 
current.

Neutral Current Protection status signals (pickups and operations) for time overcurrent, 
instantaneous overcurrent and directional protection functions for neutral 
current (calculated from phases).

Ground Current Protection status signals (pickups and operations) for time overcurrent, 
instantaneous overcurrent and directional protection functions for ground 
current (measured from 4th current input).

Sensitive Ground 
Current

Protection status signals (pickups and operations) for time overcurrent, 
instantaneous overcurrent, isolated and directional protection functions 
for ground current (measured from 4th current input).

Negative Sequence 
Current

Protection status signals (pickups and operations) for negative sequence 
time overcurrent function.

Thermal Model Protection status signals for thermal model. Reset, alarm and operation 
signals for phases and for unit, besides the thermal image values in 
percentage for all phases and units.

Voltage Protection status signals (pickups and operations) for all voltage 
functions, undervoltage, overvoltage, neutral overvoltage, negative 
sequence overvoltage and auxiliary under and over voltage.

Power Protection status signals (pickups and operations) for forward and 
directional power units.

RECORD 
STATUS

Fault Reports This menu shows the fault report status signals, as fault report trigger, 
fault date, fault type and location, besides the fault report number.

Control Events Status of the control events (if the signal configured to launch the control 
event is active or not).

Oscillography Status of signals related to oscillography recording, such as status or 
digital channels, oscillography trigger, number of records available, etc.

Data Logger Data logger information about oldest and newest sample time stamp, 
and number of channels and days configured in data logger settings.

Demand Demand trigger and reset inputs status.

Energy Freeze, unfreeze and reset input signals for energy counters.

Breaker Maintenance All signals related to breaker maintenance, such as number of openings, 
closings, (KI)2t counters, alarm signal for  (KI)2t, etc.
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3.1.8.3   METERING

The Metering menu includes all the measurements available in the device. Primary and secondary values, and also the
data related to the recording functions in the relay.

Table 3–21:  GENERAL OVERVIEW OF METERING MENU:

3.1.8.4   INPUTS/OUTPUTS

The Inputs/Outputs menu includes all the inputs and outputs signals available in the device. Contact and virtual type.

Table 3–22:  GENERAL OVERVIEW OF INPUTS/OUTPUTS MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

3.1.8.5   RECORDS

The Records menu is only available in on line mode and includes the possibility to retrieve all the records available in the
device. By serial or Ethernet.

Table 3–23:   GENERAL OVERVIEW OF RECORDS MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

METERING

Primary Values Primary values measurements for currents, voltages, power, energy and 
demand

Secondary Values Secondary values measurements for currents, voltages and power.

Phasor Diagram Current, voltage and sequence components.

Frequency Line and Bus frequencies.

INPUTS/
OUTPUTS

Contact Inputs Status of digital inputs in the Relay for each board according to the relay 
model.

Contact Output Status Status of digital outputs in the Relay for each board according to the relay 
model.

Contact Outputs 
Operates

Status (activated or not) of the variables used to operate a contact 
output. To configure these signals go to “Settings>Relay 
Configuration>Outputs” menu.

Contact Outputs 
Resets

Status (activated or not) of the variables used to reset a contact output. 
To configure these signals go to “Settings>Relay Configuration>Outputs” 
menu. This output reset Command will only be effective if the “latch” 
option has been Selected for the “Output Type” setting on the I/O board, 
thus when the contact output has been configured to emulate function 86 
(latching relay).

IO Board Status Status of I/O boards. This status provides if the hardware it is OK (boards 
matching relay model, correctly inserted in their tracks, in good state and 
communicating through the internal CAN Bus).

Virtual Inputs Status of Virtual inputs latched (32) and self-reset (32).

Virtual Outputs Status of virtual outputs (configured in PLC Editor). Up to 512.

Remote Outputs States of remote outputs

Remote Inputs Status of remote device and remote inputs

Analog Inputs (*) Measurements coming from analog inputs (DCMA)

RECORDS (*)

Event recorder (*) Retrieval and visualization of snapshot event (all and new), control 
events and alarm panel.  By serial or Ethernet (ModBus RTU or TCP/IP)

Waveform capture (*) Retrieval of oscillography files, by serial or Ethernet.

Fault Report (*) Retrieval and visualization of fault report files, by serial or Ethernet.

Data logger (*) Retrieval and visualization of data logger files. Only by Ethernet.
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3.1.9 OPERATIONS MENU OVERVIEW

Option only available in on line mode, showing all the operations previously configured in the relay with their corresponding
texts. 

Table 3–24:  GENERAL OVERVIEW OF OPERATIONS MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

3.1.10 COMMUNICATION MENU OVERVIEW

The communication menu includes the computer screen to start communicating with the relay, the different update
procedures available in device: firmware, boot code, web server and other file storing capabilities (upload and download
info files to/from relay).

For more detail information go to section starting communication for communication menus description and refer to the
flash memory update procedures.

Table 3–25:  GENERAL OVERVIEW OF COMMUNICATION MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

OPERATIONS

Operation 1 (*) Entry to first operation (with its corresponding text)

... ...

Operation 24 (*) Entry to 24th operation (with its corresponding text)

COMMUNICATION

Computer Menu to start communication with the relay.

Modem (**) Menu to set modem communication parameters (only available if control 
type is set to modem in computer menu).

Troubleshooting (*) Menu that Lets the user to perform reading or writing in ModBus 
addresses, for verifying communications and access to different 
positions in the ModBus memory map.

Calibration (*) Retrieval and store calibration settings from/to relay.

Upgrade firmware 
version (**)

Menu to update the relay firmware version through Ethernet

Upgrade boot code (**) Menu to update the relay boot code (front RS323 and Ethernet 
connection)

Upgrade F650 web 
server

Menu to update the web server application (if available)

Upload info files to 
relay

Hard disk storage of settings and configuration files on the relay.

Download info files 
from relay

Retrieval of settings and configuration files that had been previously 
stored in the relay hard disk.
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3.1.11 SECURITY MENU OVERVIEW

The security menu includes all the menus related to security control in EnerVista 650 Setup. EnerVista 650 Setup security
users and passwords are not related to passwords in HMI. Each security level has its own access for HMI management
and EnerVista 650 Setup management.

Table 3–26:  GENERAL OVERVIEW OF SECURITY MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

3.1.12 VIEW MENU OVERVIEW

The view menu includes the computer screen to start communicating with the relay, the different update procedures
available in device: firmware, boot code, web server and other file storing capabilities (upload and download info files to/
from relay).

The ModBus memory map is detailed in the complete instruction manual (English only) and can be obtained from EnerVista
650 Setup program.

Table 3–27:  GENERAL OVERVIEW OF VIEW MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only  in Off-line mode are marked as (**)

3.1.13 HELP MENU OVERVIEW

Complete instructions manual and data about EnerVista 650 Setup release.

Table 3–28:  GENERAL OVERVIEW OF HELP MENU:

SECURITY

Login User (*) Log on menu for EnerVista 650 Setup. Enabled after security control has 
been enabled in user management menu.

Change Password (*) Menu to change passwords and establish password recovering 
questions.

User Management (*) User management dialog box.

VIEW

Traces (*) To inspect ModBus communication traces between the EnerVista 650 
Setup and the relay.

ModBus Memory map Complete ModBus memory map description.

Languages (**) Option to change the EnerVista 650 Setup default language. Only 
available if the relay is not communicating and no file (*650) is open.

HELP

Instructions Manual Instructions manual in the language selected in “View>Languages” 
menu.

About EnerVista 650 
Setup

Release version and date of EnerVista 650 Setup program.
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3.2 HUMAN MACHINE INTERFACE (HMI)T

The HMI interface consists of several functional panels. The faceplate can be unscrewed to allow easy access to the
removable modules. There is also a removable dust cover that fits over the display and other cover that protects the front
RS232 Communications port and the commands buttons that can be sealed. The following figure shows the HMI in F650.

Figure 3–13: HMI INTERFACE

3.2.1 DISPLAY

F650 units are available with two different options for the front display. The first option is an alphanumerical display of 4
lines with 20 characters each, and the second option is a graphical display of 16 lines with 40 characters each (128x240
pixels), being B the ordering code option for the text display model (basic), and M the code for the mimic display
(graphical).

The boot code and firmware versions can be seen in the relay text main screen, this screen is the default screen in the text
menu for all models: After the text “F650”, appears the relay firmware version (2.00 in the example), and between brackets
the boot program version (3.0 in the example), followed by “ General Electric”, the relay model and the default front RS232
port (COM2) communication parameters. 

Figure 3–14: TEXT MAIN SCREEN

Ergonomic programmable keys 
Shuttle control for easy navigation  
ESC key, built-in ENTER function and audio feedbac
Local / Remote / Off pushbutton with LEDs 

HMI Interface 

Graphic 16x40 or text 4x20 LCD display 
Fluorescent backlight  to improve visibility 
Multicolor programmable LEDs with label panel

DISPLAY & LEDS

KEYPAD & SHUTTLE

Electrically isolated front RS232 communication port
Transparent cover can be sealed for security 

FRONT PORT

F650 2.00(3.0)
General Electric 

F650MZDF2G1HIR 
19200N81: MODBUS: 254 
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3.2.2 FRONT LED INDICATORS

The relay provides 16 LED indicators, 15 user programmable plus one non-configurable LED (READY) that shows if the
relay is in service.

Programmable LEDs are divided into groups of 5 LEDs, each of the groups having a different color. The first group of LED
indicators is latched by hardware (red color ones), usually configured for trip signals. The second group (yellow color) and
third group (green color) of LED indicators are self-reset type and will be reset once the condition has been cleared, but can
be latched using logic through PLC configuration.

The ESC key is used to reset any latched led indicator, once the condition has been cleared. Keep the ESC button pressed
for more than 3 seconds; all LEDs will light up, verifying their correct operation. When releasing the ESC key, all indicators
programmed with memory, such as tripping LEDs, will be reset.

The latched conditions can also be reset via communications using the LED reset input (to configure this signal go to
“Settings>Relay Configuration>Protection elements>LED RESET INPUT”). By default this LED reset input signal is set
to LEDS RESET operation.

3.2.3  PUSHBUTTONS

The front panel provides:

Push buttons: keypad (5 user programmable plus ESC non configurable), shuttle key or shuttle key for easy navigation,
command pushbutton to select operations mode.

RS232 port: intended for connection to a portable PC.

3.2.3.1   KEYPAD AND SHUTTLE KEY

Figure 3–15: KEYPAD AND SHUTTLE KEY DESCRIPTION

This button can be used for closing the user programmable switchgear. It is fully
programmable by the user.

This button can be used for closing the user programmable switchgear. It is fully
programmable by the user.

User programmable

User programmable

User programmable

(ESC) Escape key. When pressed during more than 3 seconds, it will test all LEDs and
reset the trip LEDs.

shuttle key or Shuttle Key (it can be both rotated and pressed): Used for selecting
menus, submenus, settings and for confirmation. Press or rotate the shuttle key to enter
the text main menu from the text standby screen.
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3.2.3.2   COMMAND PUSH BUTTON

The unit incorporates a command pushbutton located at the bottom right side of the faceplate, with three options: local,
remote, and off. The first option (LOCAL) allows executing operations in local mode (HMI, front RS232 port, and rear
COM2 port). The second option (REMOTE) allows operation execution only through remote communications (COM1 and
COM3 - Ethernet). The third option (OFF) blocks the execution of operations. Each position is identified with an LED
indicator, as follows:

LOCAL operations (green)

REMOTE operations (green) 

OFF (red )

Press the command button to switch from local to remote operations mode and vice versa. OFF status (operation inhibited
for maintenance and safety) can be reach pressing the commands pushbutton during several seconds (local-remote-off
sequence).

3.2.4 FRONT PORT AND COVER SEALING SYSTEM

Figure 3–16: shows the detail of the front RS232 communication port and local/remote button access cover
sealing system. The sealing system is similar to the one used in energy meters, using wire and plumb seal.
High quality plastic have been used in the design to withstand extreme environmental conditions, both mechanical and
electrical, sun radiation, humidity, etc. in order to guarantee a long life for the unit. 

Figure 3–16: DETAIL OF FRONT PORT AND COVER SEALING SYSTEM 

Screen contrast regulator 

Cover sealing system  

 Electrically isolated RS232 port 

Local/remote Operations access
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3.2.5 TEXT MENUS

3.2.5.1   NAVIGATION IN TEXT MENU

Text menu is available for all models, this is the main menu for visualizing actual values, metering, changing settings, etc.
through the HMI. In models with graphical display (M in ordering code) besides this text main menu there are several
screens providing more performance for control purposes.

Press (or rotate left or right) the shuttle key to enter the main menu, starting from the standby screen (default main screen).
The default main screen can be accessed pressing ESC key till it appears. In all the navigation Press the shuttle key to
select the desired header display (top-level menu). Each press of the shuttle key advances through the main heading
pages as illustrated below. To return to previous menus press the ESC key. To move inside the top-level menu without
changing to other low levels, rotate the shuttle key left to move up and right to move down. 

When rotating the shuttle key the selected menu is marked by a single scroll bar character. The mark (>)  in the right part of
any menu means that contains more than one level.

Figure 3–17:shows an example of main menu navigation:

Figure 3–17: NAVIGATION IN MAIN TEXT MENU

Symbol  Action performed  Navigation in menu 

       Press Shuttle Key  Enter next level 
       Press Esc Key  Exit to previous level 

L–R    Rotate Shuttle Key  move up and down in the same level 
L        Rotate Left Shuttle Key move up in the same level 
R        Rotate Right Shuttle Key move down in the same level 

  Menu selection  Menu selection   
>  More menus to display More menus to display 

F650 1.72 (2.35) 
General Electric 

F650MZDF2G1HIR 
19200N81: MODBUS: 254 

  Actual Values 
    Snapshot event 
    Fault report    View 
settings

L–R

 Change Settings 
   Date & Time 
   Commands   Passwords

  Front Panel  > 
    Status  > 
    Metering  >    
Inputs/Outputs >

 Select Main Screen 
   Select Language 

  return 

 Logotype  > 
   Metering  > 
   All   > 

  return

 Product Setup > 
   System Setup > 
   Protection Element > 
   Control Elements >

L–R
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3.2.5.2   TEXT MENU HIERARCHY

The structure of HMI text menu is similar to the EnerVista 650 Setup in the actual values and settings (view and change)
menus.  

The main menu shows the following options:

Table 3–29:  GENERAL OVERVIEW OF MAIN TEXT MENU:
NAME DESCRIPTION NAVIGATION IN MENU

Actual Values Actual values of all the signals available in device. 
Status of protection and control elements, 
measurements, inputs and outputs, etc.

Press shuttle key to enter next level. Press ESC to 
return to default main screen.

Snapshot events Visualization of all snapshot events in text mode (two 
screens for each snapshot event). In graphical displays 
there can be seen in a dedicated screen.

Press shuttle key to visualize snapshot events in text 
menu. Press ESC to return to default main screen.

Fault Report Fault reports information available in HMI (two screens 
for each fault report)

Press shuttle key to enter next level. Move L-R to see 
all the available fault reports in device. Press shuttle 
key to enter particular information for fault report 
selected.

View Settings Visualization of all protection and control settings 
available in device.

Press shuttle key to enter next level. Move L-R to 
select submenu. Press ESC to return to previous 
level.

Change Settings Menu that allows changing all protection and control 
settings available in device. Inputs and outputs settings, 
relay configuration and logic configuration are not 
available in HMI, only via EnerVista 650 Setup 
software.

Press shuttle key to enter next level. Move L-R to 
select submenu. Press esc to return to previous level.

Date & Time Date and time visualization and modification by user First mode is visualization. Press again shuttle key to 
start modification in date and time. Press ESC to 
return to previous level.

Commands Operations execution in local mode. Move L-R to pre select operation. Press shuttle key to 
select and confirm. Press ESC to return to previous 
level.

Password Password menu for settings and commands Move L-R to select submenu. Press shuttle key to 
enter next level. Press ESC to return to previous 
level.

Select Main Screen Selection of default main screen in text menu. Move L-R to select the default main screen type. 
Press shuttle key to confirm.

Select Language Language selection. Between default language (see 
ordering code) and English.

Move L-R to select the default language. Press 
shuttle key to confirm selection. Switch the relay off 
and on.

< - return Return to previous level Press shuttle key to return to previous level.
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a) ACTUAL VALUES

The Actual Values menu option in HMI concentrates and displays all the status of protection, control elements, metering,
counters information, oscillography, events, fault locator, etc. 

Table 3–30:  GENERAL OVERVIEW OF ACTUAL VALUES MAIN MENU:
Front Panel   >

LEDs
Status            >

Operation Bits
Breaker
Protection        >

Protection Blocks
Phase Current
Neutral Current
Ground Current
Sens. Ground Current
Neg. Seq. Current
Thermal Model
Voltage
Power

Control Elements  >
Frequency
Synchrocheck
Autoreclose
Breaker Failure
VT Fuse Failure
Broken Conductor
Setting Groups
Locked Rotor

Switchgear Status >
Switchgear 1
Switchgear ...
Switchgear 16

Calibration
Flex Curves
System Info
SNTP/IRIG_B
Records Status >

Fault Reports
Control Events
Oscillography
Data logger
Demand
Energy
Breaker Maintenan.

Metering          >
Primary Values    >

Current
Voltage
Power
Energy
Demand

Secondary Values  >
Current
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To enter this menu press the shuttle key when the option Actual Values is selected in main menu. A secondary level will be
displayed with different sublevels as shown on Table 3–30:. Rotating the shuttle key, (left for moving up and right for moving
down) select the next level to be displayed, press the shuttle key again to enter in next level and press ESC key to return to
previous level if desired. This navigation will be performed the same for all the menus in Actual Values. Once the last
sublevel is reached, move up and down to visualize the actual values selected. 

One example of data screen for actual values is shown in Figure 3–18:. 

First Line: Header of last level in actual values (Phase Current in the example)

Second Line: Data identifier (in the example PH IOC1 HIGH A, is the pickup signal for the first instantaneous
overcurrent function level high for phase A). 

Third line: Status of the displayed actual value.

Fourth Line: Relative position in the menu (it is the first value of 114)

Figure 3–18: ACTUAL VALUES SCREEN DATA

In the Actual Values menus are different types of data, each type of data will display its particular status type (on and off, 0
or 1, ok or fail, analog values, etc.)

Voltage
Power

Phasor Diagram
Frequency

Inputs/Outputs    >
Contact Inputs    >

Board F/ Board G/ Board H/ Board J
Cont. Output St.  >

Board F/ Board G/ Board H/ Board J
Cont. Output Op.  >

Board F/ Board G/ Board H/ Board J
Cont. Output Rs.  >

Board F/ Board G/ Board H/ Board J
IO Board Status
Virtual Inputs    >

Virtual Inp.Latched
Virtual Inp.SR

Virtual Outputs
Remote Outputs  >

DNA
User St

Remote Inputs  >
Remote Input
Remote Devices

Analog Inputs  >
Board F/ Board G/ Board H/ Board J

Phase Current 
PH IOC1 HIGH A PKP 

OFF
(1/114) 
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3.2.5.3   SNAPSHOT EVENTS

To enter this menu press the shuttle key when the option Snapshot events is selected in main menu (). In this menu all the
snapshot events stored can be displayed.

Snapshot events are changes in the relay internal status. 

One snapshot event is displayed in two text screens:

The first screen display the status, date and time of the snapshot event: the snapshot event identifier, its status,
event number and the date and time of the occurrence. If the snapshot event identifier does not fit the first line, the
whole text will be shown using as well the second line alternating with the status and event number.

The second screen displays currents and voltages in primary values for that particular snapshot event. Ia, Ib, Ic
and Ig for currents and Vab, Vbc, Vca and V0 for voltages. To access the metering screen in snapshot events
menu, press shuttle key from the snapshot event first screen. To exit from the metering screen pres ESC. 

To select different snapshot events to be displayed, rotate the shuttle key to select the snapshot event and then press the
shuttle key to enter the metering screen. Press esc to exit the metering screen and return to snapshot events menu.
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Figure 3–19: shows an example of snapshot events navigation:

Press shuttle key from the default main screen and enter in the main text menu.

Move the shuttle key until a single scroll bar character appears in the left part of
Snapshot event header.

Press shuttle key to enter in the snapshot events menu

Select the snapshot event to display using the shuttle key (left and right to move up
and down inside the recorded snapshot events).

Once selected the snapshot event, identifier , status, date and time will be
displayed.

In the second line St: is showing the status and the relative snapshot index from the
whole recorded number. Third and fourth lines are used to display the time and
date of the snapshot event.

Pressing the shuttle key the metering screen for the snapshot event will be
displayed.

To exit from this screen press the ESC key and return to the snapshot events menu.

Figure 3–19: SNAPSHOT EVENTS NAVIGATION IN HMI

   Actual Values 
 Snapshot event 

   Fault report 
   View settings 

L–R

Isolated Gnd3 Block> 
 St: OFF (5/479) 
 Time: 16:35:01.995 
 Date:  04/Nov/2004

Breaker Closed ON> 
 St: ON (4/479) 
 Time: 16:35:02.027 
 Date:  04/Nov/2004

F650 1.72 (2.35) 
General Electric 

F650MZDF2G1HIR 
19200N81: MODBUS: 254 

Ia   0.000  Vab   0.000 
Ib   0.000  Vbc   0.000 
Ic   0.000  Vca   0.000 
Ig   0.000  V0     0.000
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3.2.5.4   FAULT REPORT

To enter this menu press the shuttle key when the option Fault report is selected in main menu (). This menu displays
information about the last ten faults recorded in the relay.

The Relay HMI allows two types of visualization for the fault reports stored in the Relay:

1. Showing the fault warning messages in the text display when the fault is produced. This option has to be enabled
by setting. To change from the HMI go to the menu “Change Settings >Product Setup > Fault Report > Show
Fault On HMI” and enable it.

2.Only saving and allowing viewing the information from the last ten faults recorded in the relay.

In the first option, when a fault occurs a warning message is displayed, including information about the fault in two screens,
one with general fault information, and a second one with the measured values in the moment of the fault.

The fault-warning message must be acknowledged by the user; this means that the user must press the shuttle key for this
screen to disappear, The HMI will not allow to perform any other operation until the screen is acknowledged. In the event of
several consecutive faults, the HMI will always show the most recent fault, and the user will need to acknowledge all of
them, up to a maximum of ten faults.

In the second option, viewing the fault reports in the menu available in the HMI, the Fault Report menu in the main text
screen must be accessed by pressing the shuttle key. The display will show the information about the last ten faults
produced, and both the general information and the metering screens can be viewed for each fault. Displayed information
starts in the most recent fault, and the user can switch to another fault by rotating the shuttle key.

Displayed information is stored in the relay volatile memory, so if the relay is turned off this information will be lost, as well
as if a “Clear Fault Report” command is executed.  However, fault reports stored in the relay non-volatile memory will
remain after the Fault reset, and they can be obtained from the relay using EnerVista 650 Setup software, at the
“Actual>Records>Fault report” menu.

If there is no fault report available through the display, the relay will show a “Fault report not available” message.



GE Multilin F650 Digital Bay Controller 3-43

3 HUMAN INTERFACES 3.2 HUMAN MACHINE INTERFACE (HMI)

3

The format of the displayed screens is as follows:

Select the Fault report menu in text menu

If there is more than one fault record rotate the shuttle key and select the desired
record to be displayed.

First screen with general fault information: Fault report #number, fault type, distance
and date and time.

Second screen with metering data for that fault record.  All this data is a summary
from the fault report file that can be retrieved via EnerVista 650 Setup software.

Figure 3–20:  FAULT REPORT NAVIGATION IN HMI 

Possible fault types are as follows:

GROUND Ground faults
AG      phase A to ground

ABG   phase AB to ground

BG     phase BG to ground

BCG  phase BCG to ground

CG    phase CG to ground

CAG  phase CAG to ground
PHASE Phase to phase faults

AB     phase A to phase B

BC    phase B to phase C

CA    phase C to phase A
3PHASE Three-phase faults (shown on the display as 3PH)

NAF Fault type not calculated

   Actual Values 
   Snapshot event 

 Fault report 
   View settings 

L–R

Fault Report #2 
  NAF dist: 0.00 
  Time: 09:22:03.047 
  Date:  07/Nov/2004

Fault Report #1 
  NAF dist: 0.00 
  Time: 09:21:40.545 
  Date:  07/Nov/2004

Fault Report #2 
Ia 0.00 Vab 0.00 
Ib 0.00 Vbc 0.00 
Ic 0.00 Vca 0.00
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3.2.5.5   VIEW SETTINGS

To enter this menu press the shuttle key when the option “View Settings” is selected in main menu. A secondary level will
be displayed with different sublevels as shown on Table 3–31:.Rotating the shuttle key, (left for moving up and right for
moving down) select the next level to be displayed, press the shuttle key again to enter in next level and press esc key to
return to previous level if desired. This navigation will be performed the same for all the menus in “View Settings”. Once the
last sublevel is reached, move up and down to visualize the settings selected. 

Table 3–31:  GENERAL OVERVIEW OF “VIEW/CHANGE SETTINGS” MAIN MENU
MAIN SETTINGS MENU FIRST LEVEL SECOND LEVEL THIRD LEVEL
Product Setup     >

Communication     >
Serial Ports
Ethernet          >

Ethernet 1
Ethernet 2

ModBus Protocol
DNP3 Slave        >

DNP3 Slave 1
DNP3 Slave 2
DNP3 Slave 3

IEC 870-5-104
SNTP

Fault Report
Oscillography
Demand

System Setup      >
General Settings
Breaker           >

Breaker Settings
Breaker Maintenance

Protection Element >
Phase Current     >

Phase TOC High    >
Phase TOC High 1
Phase TOC High 2
Phase TOC High 3

Phase TOC Low     >
Phase TOC Low 1
Phase TOC Low 2
Phase TOC Low 3

Phase IOC High    >
Phase IOC High 1
Phase IOC High 2
Phase IOC High 3

Phase IOC Low     >
Phase IOC Low 1
Phase IOC Low 2
Phase IOC Low 3

Phase Directional >
Phase Directional 1
Phase Directional 2
Phase Directional 3

Thermal Model     >
Thermal Model 1
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MAIN SETTINGS MENU FIRST LEVEL SECOND LEVEL THIRD LEVEL
Thermal Model 2
Thermal Model 3

Neutral Current   >
Neutral TOC       >

Neutral TOC 1
Neutral TOC 2
Neutral TOC 3

Neutral IOC       >
Neutral IOC 1
Neutral IOC 2
Neutral IOC 3

Neutral Dir        >
Neutral Dir 1
Neutral Dir 2
Neutral Dir 3

Ground Current    >
Ground TOC        >

Ground TOC 1
Ground TOC 2
Ground TOC 3

Ground IOC        >
Ground IOC 1
Ground IOC 2
Ground IOC 3

Ground Dir         >
Ground Dir 1
Ground Dir 2
Ground Dir 3

Sens. Ground Curr >
Sens. Ground TOC  >

Sens. Ground TOC 1
Sens. Ground TOC 2
Sens. Ground TOC 3

Sens. Ground IOC  >
Sens. Ground IOC 1
Sens. Ground IOC 2
Sens. Ground IOC 3

Isolated Gnd IOC   >
Isolated Gnd IOC 1
Isolated Gnd IOC 2
Isolated Gnd IOC 3

Sens. Ground Dir. >
Sens. Ground Dir. 1
Sens. Ground Dir. 2
Sens. Ground Dir. 3

Neg. Seq. Current >
Neg. Seq. TOC     >

Neg. Seq. TOC 1
Neg. Seq. TOC 2
Neg. Seq. TOC 3

Voltage Elements  >
Phase UV          >
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MAIN SETTINGS MENU FIRST LEVEL SECOND LEVEL THIRD LEVEL
Phase UV 1
Phase UV 2
Phase UV 3

Phase OV          >
Phase OV 1
Phase OV 2
Phase OV 3

Neutral OV High   >
Neutral OV High 1
Neutral OV High 2
Neutral OV High 3

Neutral OV Low    >
Neutral OV Low 1
Neutral OV Low 2
Neutral OV Low 3

Neg. Seq. OV      >
Neg. Seq. OV 1
Neg. Seq. OV 2
Neg. Seq. OV 3

Auxiliary OV      >
Auxiliary OV 1
Auxiliary OV 2
Auxiliary OV 3

Auxiliary UV      >
Auxiliary UV 1
Auxiliary UV 2
Auxiliary UV 3

Power             >
Forward Power     >

Forward Power 1
Forward Power 2
Forward Power 3

Directional Power >
Directional Power 1
Directional Power 2
Directional Power 3

Control Elements  >
Setting Group
Underfrequency    >

Underfrequency 1
Underfrequency 2
Underfrequency 3

Overfrequency     >
Overfrequency 1
Overfrequency 2
Overfrequency 3

Synchrocheck
Autoreclose
Breaker Failure
VT Fuse Failure
Broken Conductor  >

Broken Conductor 1
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MAIN SETTINGS MENU FIRST LEVEL SECOND LEVEL THIRD LEVEL
Broken Conductor 2
Broken Conductor 3

Locked Rotor  >
Locked Rotor 1
Locked Rotor 2
Locked Rotor 3

Inputs/outputs >
Remote Comms.
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3.2.5.6   CHANGE SETTINGS

To enter this menu press the shuttle key when the option “Change Settings” is selected in main menu.  A secondary level
will be displayed with different sublevels as shown on Table 3–31:. Rotating the shuttle key, (left for moving up and right for
moving down) select the next level to be displayed  press the shuttle key again to enter in next level and press ESC key to
return to previous level if desired. This navigation will be performed the same for all the menus in “Change Settings”. Once
the last sublevel is reached, move up and down to visualize the settings selected. 

To change a particular setting, press the shuttle key on the setting to be modified. After selecting the setting, the value for
that setting will appear between brackets. Choose the new value moving up and down the shuttle key. After selecting the
appropriate value press again the shuttle key to fix that value. To save the new settings, go to the end of the menu rotating
the shuttle key right, and select the menu “Press intro to save settings”. When pressing the shuttle key inside this menu the
new settings will be saved. 

Figure 3–21: shows an example of change settings navigation:
Select the menu Change settings and press the shuttle key to enter in the next
sublevel.

 

If there is more than one sublevel, select the next sublevel  by rotating and pressing
the shuttle key till the last level is reached.

Press the shuttle key in the function to be modified

-> Group of settings

-> Setting to be modified

-> Value

-> Range and step

Pressing the shuttle key, value appears between brackets and can be modified
rotating the shuttle key. Pressing again the shuttle key, the new value will be
accepted.

Once all settings inside the group have been modified, go to the last screen rotating
the shuttle key and press Intro. At this moment of time, the new settings will be
active in the relay.

Figure 3–21: CHANGE SETTINGS PROCEDURE IN HMI 

   Snapshot event 
   Fault report 
   View settings 

 Change settings 

 General Settings 
   Breaker  >

  return

   Product Setup > 
 System Setup > 

   Protection Elements > 
   Control Elements >

Phase CT Ratio
1
--
[ 1:6000:1] 

Phase CT Ratio
1
<1> 
[ 1:6000:1] 

Phase CT Ratio
1
20
[ 1:6000:1] 

    Press Intro 
    to save settings 
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3.2.5.7   DATE & TIME

The “Date & Time” menu will show the relay date and time information in the following format: 

Date:Day/Month/Year

Time:Hour:Minutes:Seconds

To modify date and time, press the shuttle key. The relay will show the year between brackets at the top of the screen. By
rotating the shuttle key, reach the desired value for the year, and press the shuttle key  to select and store that value. After
the year, the relay will show the month. Proceed as in the case of the year. The date & time modification sequence is as
follows:

Rotate the shuttle key to select the “Date and Time” menu and press to enter in it

The date and time data will appear in the format related above. 

Pressing the shuttle key the year can be modified rotating the shuttle key, after
selecting the desired value, press again the shuttle key to store the value.

‘Year’

Date: Day/Month/<Year>

Time: Hour:Minutes:Seconds

After storing the value for Year, Month will appear between brackets and can be
modified

‘Month’

Date: Day/<Month>/Year

Time: Hour:Minutes:Seconds

After storing the value for Month, Day will appear between brackets and can be
modified

‘Day’

Date: <Day>/Month/Year

Time: Hour:Minutes:Seconds

After storing the value for Day, Hour will appear between brackets and can be
modified

‘Hour’

Date: Day/Month/Year

Time: <Hour>:Minutes:Seconds

After storing the value for Hour, Minutes will appear between brackets and can be
modified

‘Minute’

Date: Day/Month/Year

Time: Hour:<Minute>:Seconds

After storing the value for Minutes, Seconds will appear between brackets and can
be modified

‘Second’

Date: Day/Month/Year

Time: Hour: Minute:<Seconds>

Once this sequence is completed, these values will remain stored in the relay, and
the display will show again the date at the bottom of the text screen.

Figure 3–22: CHANGE DATE AND TIME PROCEDURE IN HMI

   Fault report 
   View settings 
   Change settings 

 Date & Time 

  ‘Year’ 
    Date:  07/Nov/<2004>
    Time: 14:39:54

    Date:  07/Nov/2004
    Time: 14:39:54 

Sunday

  ‘Month’ 
    Date:  07/<Nov>/2004
    Time: 14:39:54

  ‘Day’ 
    Date:  <07>/Nov/2004
    Time: 14:39:54

  ‘Hour’ 
    Date:  07/Nov/2004
    Time: <14>:39:54

  ‘Minute’ 
    Date:  07/Nov/2004
    Time: 14:<39>:54

  ‘Second’ 
    Date:  07/Nov/2004
    Time: 14:39: <54>
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3.2.5.8   COMMANDS

Commands are configured using EnerVista 650 Setup, and they can be executed using the pushbuttons on the relay front.

Using EnerVista 650 Setup software, the user can configure up to 24 commands with a descriptive text. When executing
the operation from the relay front, the operation description text will be displayed.

Example of commands (operations) executions via HMI

Press the shuttle key in the menu commands when it is selected in the display ().

All the previously configured commands will be displayed. Rotate the shuttle key
move through the available commands. Press ESC to return to previous level.

Press shuttle key to pre-select the operation to be executed

When the message “Push Intro for Confirmation” appears, press the shuttle key to
confirm the commands that will be performed.

Once the commands has been performed or the time out has expired the
“Command completed” message will appear in the display.

Figure 3–23: COMMANDS IN HMI

   Change Settings 
   Date & Time 

 Commands 
   Password 

L–R

Command: 
OPEN BREAKER

Command: 
CLOSE BREAKER

Push ‘Intro” for 
Confirmation 

Command  
Completed 
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3.2.5.9   PASSWORDS

F650 units incorporate independent passwords for protection and control, in order to prevent unauthorized keypad and
display access to the relay.

Settings Password:

This password allows restricting access to settings changes in the relay protection elements.

Commands Password:

This password is required for executing operation commands through the keypad and display.

If the Commands Password is activated, when the user tries to execute an operation, the relay will request this password,
and in case of using the single-line diagram for graphical display models, all objects will not be operational until this
password is entered, either logging in Login Pwd Commands, or entering the password in the Commands menu.

Relay settings view, measures, and other monitored information are not password-protected, and they can be accessed by
all users.

Access to the password menu is located at the Password option in the relay text menu. This menu includes the following
options:

   "Login Pwd Settings"

   "Logout Pwd Settings"   

   "Change Pwd Settings"

   "Login Pwd Commands"

   "Logout Pwd Commands"

   "Change Pwd Commands"

   "Forgot Password?"   

Among the available options in this menu, there are three types of functionality:

Login: For entering the password, either for settings or commands, and enable access to settings or
commands. Once entering the password the relay is no longer password protected, and access is
enabled to settings modification or commands execution.

Logout: Once the necessary setting changes or operation commands have been executed, the user can log
out, so that the relay is password protected again.

Change: This menu allows setting or modifying the desired password.

Forgot Password: This menu provides the encrypted password, so that it can be recovered if the user loses or forgets
it. 

Passwords are restricted for Settings change and Commands execution. To password-protect the relay, it is first necessary
to set the desired password, using the corresponding “Change Pwd ...” menu. The default password is 0000. This
password provides access to the whole relay functionality. 

Once a new password has been set, the user must log in to access the protected functionality; otherwise, the relay will
request the password when trying to change settings or execute commands. Once the password is entered the relay is
unprotected (as if the user had logged in), and the user must log out to protect again the relay.

a) PASSWORD RANGE

The valid range for F650 passwords is a number from 0000 to 9999. 

The default password is 0000, which provides access to the whole relay functionality. This is the default option for enabling
relay use without using passwords.
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b) ENTERING THE PASSWORD  (LOGIN PWD)

This operation is the same for both the settings and commands passwords. The only difference will be the access menu.
For entering the password, the user must access the Login menus inside the Password menu.

Login Pwd Settings or Login Pwd Commands:

The relay requests the password with the following message on the screen:

Setting passwd.

Login:  < 1000 >

For entering the desired password, the user must rotate the shuttle key  to the left (decrease) or to the right (increase), and
establish the desired number. Once entered, the selected password between brackets has been entered, the relay will
show the message “Processing passwd. Wait...”. If the password is correct, the relay will allow access to the settings
change or command execution. It is not necessary to enter the password every time a change is to be performed. The relay
will request the password 15 minutes after the last keypad action has taken place. This period of time is the same that takes
the relay to turn off the display backlighting. 

c) LOGGING OUT  (LOGOUT PWD)

To disable access to settings and commands, the user must logout.

Logout Pwd Settings or Logout Pwd Commands:

For safety reasons, if the user does not log out, the relay will do it automatically 15 minutes after the last keypad
action.

d) CHANGING THE PASSWORD  (CHANGE PWD COMMANDS)

To set a password in the relay, both for settings and commands, the corresponding menu must be accessed inside the
Password menu:

Change Pwd Settings or Change Pwd Commands:

To modify the password, the user must first introduce the existing password; if the relay has the default factory password,
this would be 0000.

For modifying the password, the relay requests the existing password with the following message:

(Setting or Command) passwd.

Login:  < 0000 >

Once the entered password has been acknowledged, the new password must be entered:

(Setting o Command) passwd.

New passwd: < 1000 >

Once the new password has been entered, the relay returns to the general Passwords menu.

e) PASSWORD RECOVERY  (FORGOT PASSWORD?)

If the relay passwords need to be recovered, the “Forgot Password?” menu must be accessed. This menu is the last
option inside the text Passwords menu.

This menu will show two passwords, which correspond to the encrypted protection settings, and commands passwords, as
shown in the following example:

Cod Settings:      [35c0]

Cod Commands: [35c0]

<Push Intro>

In order to obtain the decoded password from the encrypted codes provided by the relay, it is necessary to contact GE
Multilin and provide these encrypted codes.
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3.2.5.10   SELECT MAIN SCREEN

The relay display offers the possibility to select the default main screen. For this purpose, the user must access the  “Select
Main Screen” menu through the HMI. This menu includes the following options:

Logotype

This option selects as main screen the relay logotype including the firmware and boot code versions, the relay model and
the communication parameters for local port COM2.

Figure 3–24: DEFAULT LOGOTYPE SCREEN

Metering

This option shows a Metering screen including the phase and ground currents as well as phase-to-phase voltage, and zero
sequence voltage values, all of them in primary values.

Figure 3–25: DEFAULT METERING SCREEN

All

This option alternates in time the two previous options.

F650 1.72 (2.35) 
General Electric 

F650MZDF2G1HIR 
19200N81: MODBUS: 254 

Ia   0.000  Vab   0.000
Ib   0.000  Vbc   0.000
Ic   0.000  Vca   0.000
Ig   0.000  V0     0.000
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3.2.5.11   SELECT LANGUAGE

Option only available for versions 1.70 or higher.

The relay display offers the possibility to select the default language for the relay. For this purpose, the user must access
the  “Select language” menu located at the end of the main menu through the HMI. This menu allows the user to set the
default language of the relay between English (always available) and second language selected in the relay model. (see
section 2.3 ORDERING CODE).

For example one relay in French language (e.g. F650MZDF2G1HIRF) can be displayed in French or in English only by
changing the language setting in HMI. It is necessary to switch off and on the relay to start working with the new language
configuration in the relay. In EnerVista 650 Setup it is possible to select the language for the software (View>Languages).

Example of language selection in HMI

Press the shuttle key to enter the select language menu.

Depending on the relay model there will be available different kind of language
selections: English/French, English/ Russian, etc.

Rotate the shuttle key to select the desired language and press it to store the
selection in the relay

Once the new language has been selected it is necessary to reboot the relay in
order to start working with the new language in the device.

Figure 3–26: LANGUAGE SELECTION IN HMI

   Commands 
   Password 
   Select Main Screen 

 Select Language 

Language changed. 
Please reboot 

the relay. 

  English 
    French 

  return
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3.2.6 GRAPHIC DISPLAY

3.2.6.1   ONE-LINE DIAGRAM

In models with graphic display (F650M) default main screen is the single-line diagram. This single-line diagram can be
configured using EnerVista 650 Setup software by choosing the HMI menu inside Relay Configuration (Settings>Relay
Configuration>HMI).

Figure 3–27: ONE-LINE DIAGRAM

The bottom of the display shows a legend that indicates the possible selections that can be made from this
screen.

Esc: Menu.Intro: Next.L-R: Select.

The meaning of these options is as follows:
Esc: Menu.
Pressing the ESC key, the user will access the relay main menu, similar to the one displayed by the text-
display model (F650B).
Pressing again the ESC key; the menu selection screen (Actual Values, Snapshot events, etc.) will be
displayed. This main menu screen is identical to the one described for the text display. Its functionality is
described in section 3.2.5 in this manual. 
Intro: Next.
Pressing the shuttle key, the user access the next graphical screen, which in this case corresponds to the
primary metering values screen.
L-R: Select
Once the different switchgear elements to be operated have been configured using EnerVista 650 Setup, the
user will be able to operate them from the graphic display. 
If a single-line diagram has been previously configured in the EnerVista 650 Setup, in the HMI option inside the
Relay Configuration menu, the different switchgear elements configured for the display will be operative from
the graphic display. By rotating the shuttle key to the left and right, the cursor moves among the elements and
blinks on each of them. When an element is selected by pressing the shuttle key, the relay will indicate the
command to be executed, and the user will need to confirm it by pressing again the shuttle key.
The following sections describe only the operation of screens that are specific for the graphic display models.

 
F650 DIGITAL BAY CONTROLLER 

 
 

 Ia = 0.000 kA  Vab =0.000 kV 
 

 Ib = 0.000 kA  Vbc =0.000 kV 
 

 Ic = 0.000 kA   Vca =0.000 kV 
 

Freq = 0.00 Hz 
         

Esc: Menu.  Intro:Next.  L-R:Select 
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3.2.6.2   METERING SCREEN

The Metering screen displays relay analog measures in their primary values. Available metering values are as follows:

Figure 3–28: METERING SCREEN

As in the rest of graphical display screens, the bottom part shows a legend that indicates the possible options for the user.
In this case, the options are:

Intro: Next.Esc: Prev.L-R: Scroll.

Intro: Next.
Pressing the shuttle key the user accesses the next screen, in this case the ALL EVENTS screen.

Esc: Prev.
Pressing the ESC key the user returns to the previous screen (One-line diagram)

L-R: Scroll.
Rotating the shuttle key to the left (L) or right (R) the user can access all the Metering values in the screen. Rotating the
shuttle key left will move up in the screen, and rotating right will move down.

METERING SCREEN ANALOG MEASURES IN PRIMARY VALUES
Phasor Ia Primary V0 Primary Phase A Real Pwr Line Frequency Primary
Phasor Ib Primary V1 Primary Phase B Reactive Pwr Bus Frequency Primary
Phasor Ic Primary V2 Primary Phase B Apparent Pwr Vx Primary
Phasor Ig Primary Vab Primary Phase B Real Pwr Positive MVarhour
Phasor Isg Primary Vbc Primary Phase C Reactive Pwr Negative MVarhour
Phasor In Primary Vca Primary Phase C Apparent Pwr Positive MWatthour
RMS Ia Primary Vn Primary Phase C Real Pwr Negative MWatthour
RMS Ib Primary Va Primary 3 Phase Reactive Pwr Pos MVarhour Cnt
RMS Ic Primary Vb Primary 3 Phase Apparent Pwr Neg MVarhour Cnt
RMS Ig Primary Vc Primary 3 Phase Real Pwr Pos MWatthour Cnt
RMS Isg Primary VBB Primary Phase A Power Factor Neg MWatthour Cnt
I0 Primary VL Primary Phase B Power Factor
I1 Primary Phase A Reactive Pwr Phase C Power Factor
I2 Primary Phase A Apparent Pwr 3 Phase Power Factor

Metering Screen. Total metering56

 Phasor Ia Primary   0.000 KA 
 Phasor Ib Primary   0.000 KA 
 Phasor Ic Primary   0.000 KA 
 Phasor Ig Primary   0.000 KA 
 Phasor Isg Primary   0.000 KA 
 RMS Ia Primary   0.000 KA 
 RMS Ib Primary   0.000 KA 
 RMS Ic Primary   0.000 KA 
 RMS Ig Primary   0.000 KA 
 RMS Isg Primary   0.000 KA 

I0 Primary    0.000 KA 
 
Intro: Next.  ESC: Prev  L-R:Scroll. 
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3.2.6.3   ALL EVENTS SCREEN

This screen shows all events that have been produced in the relay. The top of the screen shows its name (All Events), and
the relative and total number of events contained in the screen.

All Events (1/479)

This legend means that there are a total of 479 events stored in the relay, and that the cursor is located on event number 1.
The information shown on this screen for each event is as follows:

“Hour:Minute:Second:Millisecond” “Event text” “Event status(ON/OFF)”

Figure 3–29: ALL EVENTS SCREEN

The screen legend options are:

Esc: Prev. Intro: Menu. L-R: Scroll.

Esc: Prev.

Pressing the ESC key, the user returns to the previous screen (Metering screen) 

Intro: Menu.

Pressing the shuttle key, the user accesses the Events menu that offers the following options at the bottom of the screen: 

next prev reload details At

To access the different options in the snapshot events graphic menu the user must move the cursor from left to right. The
selected option will be displayed in upper case and between brackets. To access the selected option, the user must press
again the shuttle key.

<NEXT>

The user accesses the next available graphic screen (Events – New) 

<PREV>

This option returns to the general events graphic menu (All Events)

<RELOAD>

This option updates all events stored in the relay and returns to the general events screen.

All Events (1/479).
- [ Ready LED ON ] - 

16:11:08.035 Ready LED ON    ON 
16:11:08.017 Breaker Closed ON   ON 
16:11:08.005 Isolated Gnd3 Block OFF  OFF 
16:11:08.005 Isolated Gnd2 Block OFF  OFF 
16:11:08.005 Isolated Gnd1 Block OFF  OFF 
16:11:08.005 Sens Gnd TOC3 Block OFF  OFF 
16:11:08.005 Sens Gnd TOC2 Block OFF  OFF 
16:11:08.005 Sens Gnd TOC1 Block OFF  OFF 
16:11:08.005 Ground TOC3 Block OFF  OFF 
16:11:08.005 Ground TOC2 Block OFF  OFF 
16:11:08.005 Ground TOC1 Block OFF  OFF 
Esc: Prev.  Intro: Menu.  L-R: Scroll. 
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<DETAILS>

The Details screen provides access to metering values, and date and time related with the event.

The top of the screen displays a legend with the event text, followed by the date and time, the event status (ON or
OFF), and the event index number related to the complete list of events in the relay, for example (1/479). The rest of
information provided by the Details screen corresponds to the relay measures in the moment of the event. Metering
values provided in the events are secondary, and voltage values correspond to phase-to-ground voltage.

Figure 3–30: SNAPSHOT EVENTS DETAIL SCREEN

To navigate this screen the user must follow the legend at the bottom of the screen:

Intro: Meters.  ESC: Prev.L-R: Scroll.

Intro: Meters.

To access the metering values in the moment of the event, the user must press the shuttle key. A new metering screen
will be displayed, containing the primary metering values in the snapshot event, such as:

Once inside the Metering screen, a new legend will be shown for each event (Intro or ESC: Prev. L-R: Scroll); this
legend indicates that by pressing ESC or the shuttle key, the system will return to the Event Detail screen, and rotating
the shuttle key the user will access all the metering values contained in the metering screen of the considered event.

ESC: Prev.

If the user presses the ESC key from the event detail screen, the system will return to the all events screen.

Phasor Ia Primary I2 Primary
Phasor Ib Primary Vab Primary
Phasor Ic Primary Vbc Primary 
Line Frequency Primary Vca Primary
Phasor Ig Primary V1 Primary
Phasor Isg Primary V2 Primary
I0 Primary V0 Primary
I1 Primary 3 Phase Power Factor

Ready LED ON 
Date: 10/Jun/2005    St:ON 
Time: 16:11:08.035    (1/479) 
 
Phasor Ia Primary    0.000 
Phasor Ib Primary    0.000 
Phasor Ic Primary    0.000 
Line Frequency    0.000 
Phasor Ig Primary    0.000 
Phasor Isg Primary    0.000 
I0 Primary     0.000 
I1 Primary     0.000 
 
 
Intro: Meters.   ESC: Prev. L-R: Scroll.
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L-R: Scroll.

Rotating the shuttle key left (L) or right (R) moves among all the events contained in the all events screen, allowing a
preview of the details for each of them.

<AT>

When this option is selected, the system marks the event where the cursor is located. A relative time stamp is
performed, in such a way that the selected event, marked with an asterisk (*) between the time and the event name is
set with a relative time of 00:00:00:000 on the top line of the event screen, together with its relative index, and the rest
of events in the screen will show a date/time that relates to the marked event. This operation mode allows a quick
inspection of the relative time passed between several events, which is very useful for analyzing events in the field.
The corresponding legend to this relative event-marking screen is as follows:

Esc: Out At. Intro: Tag event.

Esc: Out At.

The relative event marking is eliminated and the system returns to the general events screen.

Intro: Tag event.

If the user places the cursor on a different event by rotating the shuttle key left or right, pressing the shuttle key
will change the relative mark to that new event.

3.2.6.4   NEW EVENTS SCREEN

This screen shows the new events that have been produced in the relay since the last time the New Events screen was
read. The top of the screen shows a “New Events” legend, and the relative and total number of events contained.

Navigation through the different menus in this New Events screen is similar to the one described in the previous section for
All Events. The main difference is that in the case of new events it is necessary to select the RELOAD submenu to update
the screen with new events that have been produced, while in the All Events screen, this refreshment is automatic.

After the new events have been read, if the user selects again the Reload menu, the system will show a  <No new events
available.> message, indicating that there are no more new events available since the last reading.
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3.2.6.5   ALARMS PANEL

Alarms panel can be viewed in all F650 models using communication software EnerVista 650 Setup, however, only models
with graphic display allow access to the alarms panel from the HMI.

First line shows the relative and total number of alarms existing in that screen. The relative number refers to the alarm on
which the cursor is located, and the total number refers to the total amount of alarms available. The second line on this
screen shows an index that indicates the number of the configured control event that corresponds to the displayed alarm,
followed by the alarm text configured in the Control Events menu inside the Relay Configuration option
(“Settings>Relay Configuration>Control Events”). 

Figure 3–31: ALARMS PANEL IN HMI

The rest of the screen shows the different alarms produced in the relay with the date and time when the corresponding
event was produced, followed by the alarm identification text, and its status, active (ON) or inactive (OFF).

In the previous example, the produced alarm is the change to local of the execution of operations (OPERATIONS IN
LOCAL MODE), the date and time when this event has been produced, and its status (ON):

The bottom of the screen shows the legend that indicates how to navigate through the different options available in the
screen.

ESC: Prev. Intro: Menu.

ESC: Prev.

Pressing the ESC key, the system returns to the previous New Events screen.

Intro: Menu.

Pressing the shuttle key, the user accessed the available alarms menu, which includes the following options.

next prev ack ack all

To access the different options provided by the alarms graphic menu, the user must move the shuttle key left to right. The
selected option will be displayed in upper case and between brackets. To access the selected option, the shuttle key must
be pressed.

<NEXT>

This option provides access to the next available graphic screen (I/O boards) 

<PREV>

The system returns to the previous New Events screen. 

<ACK>

This option acknowledges the alarm on which the cursor is located.

Alarm Panel (1/3).
#1 OPERATIONS IN LOCAL MODE 

 
7/11/04 16:54:16 OPERATIONS IN LO.  ON 
7/11/04 16:54:16 GENERAL PICKUP  ON 
7/11/04 16:54:16 GENERAL TRIP  ON 

 
 
 
 
 
 
 
 

Esc: Prev. Intro: Menu
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<ACK ALL>

This option acknowledges all alarms. Alarm acknowledgement through the graphic HMI is considered as through
communication port COM2, as it is considered to be Local in both cases.

When an alarm has been acknowledged, a selection mark will appear to the right of its status. Inactive alarms will
disappear from the screen once they are acknowledged.

3.2.6.6   INPUT/OUTPUT MONITORING SCREEN

This is the last screen available in the graphic display. This screen allows viewing the status of the relay inputs and outputs,
as well as  emulate inputs (for verification of the logic, or related functions), and contact outputs (to verify wiring). 

The format of this screen is shown on the figure below.

The first line shows the name of the screen “I/O Cards”, followed by the type and description of the board where the cursor
is located, which will appear between selection marks > < and blinking.

Figure 3–32: INPUTS/OUTPUTS GENERAL SCREEN

The navigation legend on this screen is as follows: 

Esc: Prev.Intro: Menu.L-R: Chg Card
Esc: Prev.

This option returns to the previous screen (Alarms Panel).

Intro: Menu.

This option provides access to the selected I/O board menu:

This menu includes the following options.

next view test input test output

As in previous screens, to access the different options provided by the inputs/outputs graphic menu, the user must move
the shuttle key left to right. The selected option will be displayed in upper case and between brackets. To access the
selected option, the shuttle key must be pressed.

IO Card.
Type: 2, Nº IN 8,  Nº OUT 8 

 
  >F< 

  G 
  H 
  J  

 
 
 
 
 
 

Esc: Prev.  Intro: Menu.  L-R: Chg Card. 
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Figure 3–33: INPUT/OUTPUT VIEWING SCREEN

<NEXT>

This option brings the system back to the one-line diagram.

<VIEW>

This option shows the real status of all inputs and outputs in the selected board. Depending on the type of board, with
or without supervision, the screen will vary to get adapted to the characteristics of each board.

The first line of this screen shows the slot where the board is located, F, G, H or J, and the type of board, 2 if it includes
supervision (8 inputs, 8 outputs, and 4 supervision circuits), or 1 if it is a mixed board (without supervision) with 16
digital inputs and 8 outputs. The view menu differentiates inputs and outputs; the active status (ON) is represented by
the lighting of the corresponding input or output.

The legend at the bottom of the screen indicates how to navigate:

Esc: Prev. Intro: Menu. L-R: Chg Card

Esc: Prev.

Returns to the general I/O screen

Intro: Menu.

Provides access to the I/O menu (next, view, test input, test output). 

L-R: Chg Card

Moving the shuttle key to the left or right provides access to the status of inputs/outputs for the different boards
available in the relay.

<TEST INPUT>

This option allows testing the input activation (in emulation mode). The displayed screen is similar to the viewing
screen, but in this case the user can operate the different relay inputs.

This screen shows the Input name lit up, showing that this is an Input emulation mode.

The first relay input will appear blinking and between brackets; the user can select a different input by rotating the
shuttle key. When the shuttle key is pressed, the selected input will be activated. Navigation through this screen is
indicated by the following legend:

Esc: Exit Text. Intro: Chg Input.

IO Card F. Type: 2, # IN 8, # OUT 8
 

Input  (ON OFF)  Output 
 
 
 
 
 
 
 
 
 
 
 

next  >VIEW< test input test output

 0 CC1   8 Va COIL1
 1 CC2   9 Vb COIL1 
 2 CC3  10 Va COIL2 
 3 CC4  11 Vb COIL2 
 4 CC5  12 Isense1 
 5 CC6  13 Isense1 
 6 CC7  14 SUP21 
 7 CC8  15 SUP22 

0 OUT1 ??
 1 OUT2 ??
 2 OUT3 ??
 3 OUT4 ??
 4 OUT5 ??
 5 OUT6 ??
 6 OUT7 ??
 7 OUT8 ??
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Esc: Exit Text.

The ESC option returns to the general I/O board menu.

Intro: Chg Input.

Pressing the shuttle key on the blinking input, this input will be activated in emulation mode.

Note: input emulation can only be executed through the TEST INPUT tool on the graphic display.

<TEST OUTPUT>

This option allows testing the output activation in emulation mode. The displayed screen is similar to the viewing
screen, but in this case the user can operate the different relay contact outputs to test the wiring.

This screen shows the Output name lit up, showing that this is an output emulation mode.

The first relay output will appear blinking and between brackets; the user can select a different output by rotating the
shuttle key. When the shuttle key is pressed, the selected output will be activated. Navigation through this screen is
indicated by the following legend:

Esc: Exit Text. Intro: Chg Output.

Esc: Exit Text.

The ESC option returns to the general I/O board menu.

Intro: Chg Output.

Pressing the shuttle keyshuttle key on the blinking output, this output will be activated in emulation mode.

Note: Output emulation can be executed through the TEST OUTPUT tool on the graphic display, and also
through communications using EnerVista 650 Setup software for all F650 models.

L-R: Chg Card

Rotating the shuttle key allows to change the selected I/O board in the main I/O screen.
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3.3 WEB SERVER 3.3.1 HOME

The web server in the F650 can be accessed running the Windows explorer, and keying http://xxx.xxx.xx.xxx, being
xxx.xxx.xxx.xxx the relay IP address, which must be configured in Setpoint > Product Setup > Communication Settings
> Ethernet . 

The main screen of the F650 web server shows the different monitoring possibilities for snapshot events, events, alarms,
oscillography, fault reports, data logger and metering values provided by the relay through the web.

In order to access the different functions provided by the web server, the user must simply click on the list name on the left
side of the screen.

The web server (for version 1.70 and higher ones) allows the user to visualize the different web server screen languages:
English, French, Spanish and Russian by pressing the language button on the top right corner of the main window. Take
into account that this selection only changes the language in the web server screen, all the relay texts, such as snapshot
events, control events, etc. will be the in the language selected in the relay (see section 3.2.5.11 in this manual).

Figure 3–34: WEB SERVER MAIN SCREEN
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3.3.2  SNAPSHOT EVENTS

The Snapshot events screen shows all Snapshot events produced in the relay. This screen is refreshed automatically every
minute.

The information provided in this screen includes: first, the relative event index, the lowest index corresponding to the most
recent event; next, the event text that shows the reason for the event, its status, active (ON) or inactive (OFF), and finally
the date and time when the event was produced.

The bottom of the screen shows a Metering screen; clicking on one of the events, the associated metering
values will be shown on that screen.

Figure 3–35: SNAPSHOT EVENTS SCREEN

3.3.3  CONTROL EVENTS

The control events screen provides access to all events that have been configured in the Control Events screen inside the
Relay Configuration menu of EnerVista 650 Setup.
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Figure 3–36: CONTROL EVENTS SCREEN

Unlike the case of Snapshot events, in this screen the highest index corresponds to the most recent event. The information
provided is the control event index, the text that has been associated to such event when configured, its status, active (ON)
or inactive (OFF), and its date and time.
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3.3.4  ALARMS

The alarms screen provides access to alarms configured in the relay. As in the case of snapshot events and control events,
this screen allows only to view the alarms, but not to acknowledge them.

Figure 3–37: ALARMS SCREEN
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3.3.5  OSCILLOGRAPHY

The oscillography screen allows obtaining from the relay available oscillography records in that moment.

This screen includes two windows. The first window shows oscillography records available in the relay,
identified by an index, being the highest index the most recent record (oscillography record No 6 in the
example below).

Figure 3–38: OSCILLOGRAPHY SCREEN

If the user clicks on the oscillo record he wants to retrieve, the window on the right will show a description of the record
header, indicating its date, time, and the most relevant parameters of the record. Once a record is selected, it is required to
press the Download button. The system will then open a window to allow saving the files in Comtrade format in the PC
hard drive. Once the records have been saved, the system will ask if the user wants to open GE-OSC tool (Comtrade
record viewer) to view the downloaded files.

Figure 3–39: GE-OSC LAUNCH SCREEN

Clicking on the Home option, the system will return to the web server main screen.
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3.3.6  FAULT REPORT

The fault report screen provides access to the last 10 fault reports obtained by the relay. These records are stored
according to an index that marks their position among all records produced in the relay, with a range from 1 to 999,
returning to 1 in case of exceeding the limit of 999. As in the case of oscillography records, the highest index corresponds
to the most recent record.

In the fault report, oscillography and data logger screens, the system will request acceptance of a safety-warning message.

Figure 3–40: FAULT REPORT SCREEN

The information provided in this screen includes the date and time when the fault was registered, fault calculations such as
distance to the fault, type of fault, date and time, and the line parameters, as well as the recloser and breaker status during
the fault.

This screen shows also prefault and fault voltage and current primary values. At the top of the screen, associated to the
trigger event number there is a button labeled as INFO. This button displays at the bottom of the screen the events
produced before and after the fault report trigger, so that the user has very useful information about the moment when the
fault was produced.

To obtain a text file with all the fault report information, press the Download option and save the file in the computer.
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3.3.7 DATA LOGGER

The data logger screen allows viewing the data logger first and last value retrieval date and allows
downloading the data record files in Comtrade format, by pressing the Download option. Stored files can be
viewed later using any Comtrade format viewer.

Figure 3–41: DATA LOGGER SCREEN
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3.3.8 METERING

This screen includes the 53 primary metering values provided by the relay display.

Figure 3–42: METERING SCREEN
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4 SECURITY 4.1 ADDING USERS

New users can only be added by users that have Administrator Access (or Admin Rights) . The Enable Security check
box located in the Security->User Management window must be enabled.

Remember: (In order to add new users and assign user rights ) 
• must be logged in with Administrator Permission 

• and Enable Security checkbox must be enabled   

4.1.1 USER RIGHTS

NOTE: Only Administrators have access to the User Management dialog box.
Following is a list of all of the User Rights Options available to be granted to users, and their functions. 

Table 4–1:  USER RIGHTS AND FUNCTIONS
RIGHT FUNCTION

Delete Entry
If this box is checked when the Administrator exits the User Management dialog box, the program will ask you to 
confirm the delete and if the Administrator chooses "yes", then the user whose "Delete Entry" box was checked 
will be permanently deleted from the list. 

Admin. WARNING: When this box is checked, the user will become an EnerVista 650 Setup Administrator, therefore 
receiving all of the Administrative rights.

Actual Values When this box is checked, the user will have the ability to view Actual Values and all records excluding event 
recorder.

Settings When this box is checked, the user will have access to view and modify Settings (Protection, control, inputs/
outputs and calibration).

Commands When this box is checked, the user will be able to use Commands.
Event Recorder When this box is checked, the user will have access to use Event Recorder.
Force IO When this box is checked, the user will be able to use Force IO application.

Logic Configuration When this box is checked, the user will have the ability to view and modify  Relay Configuration and Logic 
Configuration. 

Upgrade When this box is checked, the user will have the ability to upgrade firmware, bootware and to upload and 
download info files to/from relay. 

EnablingSecurity.htm
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4.2CHANGING PASSWORDS

Users will be prompted to change their password after the first successful log in or through clicking Security
from the toolbar, and choose Change Password.

Figure 4–1: CHANGE SECURITY

When the operator enters a new password for the first time, he/she should also enter a personal question that
only they could answer. There is a limit of 50 characters available to enter the personal question. One
example, as in the above diagram, would be "What is my mother's maiden name?". This question will be posed
to the user if the user forgets their password and would like to know what their password was. 
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4.3ENABLING SECURITY
EnerVista UR Setup Security Control is disabled by default. Users don't have to log in through user name and password
after installation and are granted access as Administrator. 

Security Control can be enabled through Security from the tool bar when logged on as an Administrator. Click on User
Management and a dialog box will show up. 

Figure 4–2: SECURITY ENABLING

Security Control is enabled by checking the ENABLE SECURITY check box. The first time the enable security option is
selected is necessary to close and open EnerVista 650 Setup to start working under security management.
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4.4 LOGING INTO ENERVISTA 650 SETUP
Users have to log on in order to use EnerVista 650 Setup program after Security Control has been enabled. After the start
up of EnerVista 650 Setup, a dialog will pop up asking for user name and password. 

Figure 4–3: LOGIN USER

The user name field will display the last log in user name as default, in this example, TestUser. For the first log in session of
any user name, the default password will be "password". User will be prompt to change the password to something else
after the first successfully log in. 

Log on can also be done by clicking Security from the toolbar and choose Login New User. User will be prompted with the
same log in dialog box for a different user name and password combination. 

In case a user has forgotten about the log in password, the Forgot Password function can be used to retrieve the
password. 

Figure 4–4: FORGOT YOUR PASSWORD?

A question, which is pre-set by the user, will be asked. The password will be retrieved for entering the right answer.
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5 BOOTCODE AND FIRMWARE UPDATE 5.1INTRODUCTION

This section describes the necessary steps to update the F650 operative system and firmware. 

The operative system and firmware versions can be seen in the relay main screen: After the text “F650”, appears the relay
firmware version (1.20 in the example), and between parenthesis the boot program version (2.20 in the example), followed
by “ GENERAL ELECTRIC”, the relay model and the default front RS232 port communication parameters. 

Figure 5–1: MAIN SCREEN

BOOT CODE RELEASE NOTES

It is mandatory to maintain version compatibility between firmware and boot code in the update procedure, otherwise the
relay will not start after the updating procedure (if the versions are wrongly matched).

WARNING

BEFORE PERFORMING THE UPDATE PROCEDURE CHECK THAT BOOT AND FIRMWARE VERSION MATCH

FIRMWARE AND BOOT VERSIONS COMPATIBILITY
FIRMWARE VERSION BOOT VERSION BOOT CODE RELEASE NOTES

2.20 4.00

Minor changes in firmware.
All models excepting:
• Options 4 and 5 for I/O boards

• Option 6 for IEC 61850 protocol

1.82 4.00

File system management enhancement in boot code 4.00
Measurements enhancement in 1.82 firmware version.
All models excepting:
• Options 4 and 5 for I/O boards

• Option 6 for IEC 61850 protocol

2.00 3.00 New hardware options supported (see ordering code).
New communication protocols supported (IEC 61850)

1.6X-1.7X-1.80
2.40 Minor changes in bootcode. No functionality change for user.

2.35 System memory tool provided. Upgrade from 2.30 required to 
work with 1.61 firmware version up to 1.80

1.3X-1.4X-1.5X 2.30 Enhanced internal watchdog usage. No functionality change for 
user. Upgrade from 2.20 not required

1.13-1.2X 2.20 Upgraded for use with version 1.13 or later firmware
1.00-1.11 2.00 Original boot code version
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NOTE

The end of this section includes a STEP LIST SUMMARY that will allow the user to control the updating process. It is
necessary to read the whole document before accomplishing the F650 UPDATE PROCEDURE related in these pages.

Notice that boot program and firmware upgrades will erase all the data contained in the relay, thus it is advisable to save
all the data, oscillography, events, settings and configuration files previously.

Backward compatibility of PLC projects, settings and configuration files is not assured for versions older than 1.13. 

NOTE

RELAYS WITH FIBER OPTIC ETHERNET

The update of the boot program (BOOTCODE) will be performed, obligatorily, by crossed copper cable connected to the
PC. It is not necessary to change the internal switch from fiber to RJ45, because the upgrade it is made at 10Mb/s and
for that reason there is not conflict between copper/fiber optic.

This does not apply to the firmware upgrade, which can be done either via Ethernet Fiber connection, or through the
RJ45 cable connection.
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5.1.1 COMMUNICATION PARAMETERS

Before proceeding with the update process, the following points should be taken into account:

Type of Ethernet connection:

If the relay is connected through a hub or to a switch, a direct 10/100 Base TX Ethernet cable should be used, or with its
fiber optic if the relay is of 100FX Ethernet. Otherwise, a direct connection from the PC to the relay (back-to-back) requires
a crossover 10/100 Base T cable.

It is highly recommended to use a crossover cable to do the update process and do a direct connection from the PC to the
relay instead of being connected through a hub or switch.

Relay IP address:

It is necessary to assign a valid IP address to the relay in the Ethernet parameters via HMI in the “Product Setup >
Communication > Ethernet > Ethernet 1” menu or via EnerVista 650 Setup in “Setpoint > Product Setup>Communication
Settings > Network (Ethernet) 1” as shown in Table 5–1: .

Table 5–1: ETHERNET PARAMETERS

In the case of relay that has updated previously its Bootcode (Sections 2), the IP address already has been assigned in the
previous process (see Figure 5–14:).

In both cases, it is necessary to check that there is no other equipment connected with the same IP address in the same
net, to avoid collision.

In case of a back-to-back connection from a PC to the relay (through a crossover Ethernet cable), the IP address of the
relay needs to be compatible with the TCP/IP configuration of the computer.

For example, if the relay settings are:

IP address: 192.168.37.240, 

Netmask: 255.255.255.0 and

Gateway: 192.168.37.10.

The computer settings have to follow the model:

IP address: 192.168.37.XXX

Netmask: 255.255.255.0 and

Gateway: 192.168.37.10 (if desired).

XXX is a number between 0 and 255 that is not assigned to any other device to avoid collisions.

PRODUCT SETUP>COMMUNICATION SETTINGS >NETWORK (ETHERNET) 1
Name Value Units Range
IP Address Oct1 192 [0 : 255]
IP Address Oct2 168 [0 : 255]
IP Address Oct3 37 [0 : 255]
IP Address Oct4 240 [0 : 255]
Netmask Oct1 255 [0 : 255]
Netmask Oct2 255 [0 : 255]
Netmask Oct3 255 [0 : 255]
Netmask Oct4 0 [0 : 255]
Gateway IP Oct1 192 [0 : 255]
Gateway IP Oct2 168 [0 : 255]
Gateway IP Oct3 37 [0 : 255]
Gateway IP Oct4 10 [0 : 255]
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If there are not TCP/IP settings according to this model in the computer, it should be added (in order to communicate with
the relay) following these steps:

Go to the Control Panel of the computer and select the Network option (the name of this option may depend on the PC
operative system).

Figure 5–2: NETWORK IN CONTROL PANEL

In Network, enter in Protocols and select TCP/IP protocol by clicking on Properties. 

Figure 5–3: TCP/IP PROPERTIES

In IP address tab, select Advanced... (Figure 5–3: TCP/IP PROPERTIES) and add a new address in the PC that
corresponds to the same LAN that the relay has (in the example bellow 192.168.37.54).
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Figure 5–4:  IP ADDRESS FOR COMPUTER 

Windows allows Multihosting, so it permits having as many directions as desired. It is necessary to turn off and on the
computer to activate the new address that has been assigned to the PC.
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5.2BOOT CODE UPDATE 

Operating system update is performed using EnerVista 650 Setup. For this purpose, it is required that there is no
communication between the program and the relay, and that no configuration file is open.

In this case, menu option Upgrade Operating System will be enabled under the EnerVista 650 Setup Communication
menu.

During the operative system updating process, all the data stored in the relay will be lost, so it is required to save all
calibration, settings, oscillography, etc. from the relay before the upgrade. It is extremely important to save the relay
settings and calibration before continuing with the process. In this step of the updating process if the user do not want to
continue, click on the NO option and no change will be perform to the relay.

Figure 5–5: LOST DATA WARNING MESSAGE

For upgrading the operative system, it is required to connect an RS232 cable to the front of the relay, and an Ethernet cable
to the rear port (COM3). The serial communication parameters will be the ones selected in the Communications >
Computer menu, where the COMX port (the port to be used in the upgrade) must be selected. As regards Ethernet
communication, if the upgrade is to be performed through a hub or switch, it is required to connect the relay to the hub or
switch through a direct 10/100 base T cable.

If the connection is made directly from the PC to the relay it is necessary to use a 10/100 Base T crossover cable. This last
connection will be obligatory for relays with Fiber Optic Ethernet, although it will not be necessary to change the internal
switch. During the upgrade, the system will show the following message indicating the procedure to be followed.

Figure 5–6: SERIAL AND ETHERNET CONNECTIONS FOR BOOT UPDATE

NOTE

To obtain more information about the Relay network configuration, please refer to section 5.1.1 COMMUNICATION
PARAMETERS
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After accepting to proceed, a window will open up for selecting a temporary IP Address for the boot update. It is advisable
to set the IP Address that is going to be used lately in the relay for Ethernet connection.

Figure 5–7: TEMPORARY IP ADDRESS SELECTION FOR BOOT UPDATE

After entering the temporary IP address, a window will open up for selecting the appropriate  file from the GE Multilin web
site or Product CD.

Figure 5–8:  BOOT FILE SELECTION

Once the appropriate boot program file has been selected, the program will proceed to load and update the relay’s boot
memory.

Figure 5–9: LOADING BOOT FILE
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After the boot memory loading, the program shows a message requiring turning off and back on the relay while the
progress bar is in course.

Figure 5–10: SWITCH THE RELAY OFF AND ON TO START THE BOOT PROCEDURE

It is important to turn the Relay off and on again during the time shown by the progress bar; in case this time expires, the
program will offer the option to continue with the process or to postpone, verify the correct RS232 connections and try again
later. Notice that the serial port used in the boot update procedure is the one selected in the “Communication>computer“
menu.

Figure 5–11: ERROR MESSAGE FOR COMMUNICATIONS PROBLEMS

If the serial communication between EnerVista 650 Setup and the relay has been successful the program shows a
message to select to update the current version to the new one.

Figure 5–12: UPDATE CURRENT VERSION?

At this moment, selecting “YES” in the “Update current version?” option will start, beginning with the relay flash memory
deletion, so at this point all the information stored in the relay will be lost. 

Until now, no important change has been made to the relay, the boot memory updating process has simply been prepared. 

The process of flash memory erasing and boot memory file loading can take some minutes, during which a progress bar is
displayed.
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Figure 5–13: ERASING FLASH MEMORY

Once the memory has been erased and the files updated in the relay, the parameters for the Ethernet communications
parameters must be assigned (Figure 5–14:). The requested values are the IP address and the gateway 

Figure 5–14: ETHERNET PARAMETERS

These values should match the LAN structure in which the relay will be connected. 

The gateway must be the one used in the LAN structure connecting the relay. The relay IP address should have the first
three octets corresponding with the Gateway and the last octet must be a free IP address reserved to the relay to avoid
possible collisions with other devices. 

After assigning the Ethernet parameters, the update of the boot memory program has been completed successfully .

Figure 5–15: BOOT PROGRAM UPDATED

After boot memory update, the equipment firmware must also be updated (Section 5.3).
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5.3FIRMWARE VERSION UPDATE 

The F650 equipment includes a mechanism that allows the update of the internal program called firmware, to new versions
that are periodically published in the GE Multilin web. 

The relay settings and configuration will be lost, so it is advisable to save them to a file. For firmware revisions
lower than 1.50, it is required to save calibration settings in a file before updating the F650 to a new firmware
version. In case of versions higher than 1.50, the calibration retrieval process is automatic and it is not necessary to save
them to a file (nevertheless is always advisable to do it). Take into account that if the operative system (bootcode) has been
previously updated, all the data (including calibration settings) would be lost.

In case of error during the firmware updating process, the user could repeat the whole process as many times as
necessary, this is possible thanks to an independent boot memory (bootcode).

The firmware updating process should be done through the EnerVista 650 Setup software, after connecting the relay by
Ethernet port (COM3).

5.3.1 FIRMWARE UPDATE

Once the communication with the relay through Ethernet connection has been verified1, enter the EnerVista 650 Setup
program, select Communication and the Upgrade Firmware Version option.

At this point, proceeding with the update will erase all the data stored in the equipment, including the calibration settings in
firmware version previous to 1.50. Therefore, it is necessary to save all settings to a file before following with the process.

After accepting to proceed, a window will open up for the update parameter for the F650 firmware update process. In
firmware version previous to 1.70 the EnerVista 650 Setup program asked for the IP address of the relay to be updated and
its serial number. In versions 1.70 and higher it is also necessary to enter the ordering code for the relay. See figure below:

This change is due to the multilingual implementation in F650 devices. See ordering code section in product description
chapter in this manual.

Figure 5–16: FIRMWARE SELECTION WINDOW

1. Calibration settings should be stored in a file before updating the firmware.

Go to EnerVista 650 Setup main menu “Communication > Calibration > Get Calibration Settings”

Store the file in the PC using the relay serial number, for instance, as the name of the file.
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Once the upgrade parameters have been entered, relay IP address, serial number and ordering code, press the “Upgrade
Firmware” button. When communication has been established, the program will show a message requesting to turn off
and back on the relay to continue with the upgrade process.

Once the relay has been turned off and on again, a new screen allows selecting the folder that contains the firmware
update files (“update.txt” file must be located in this folder). This Update.txt file is located in the folder where the desired
firmware upgrade files are. This firmware update files can be found in the GE Multilin web site. 

If the files are downloaded from the web, they are compressed in a zip file. It should be decompressed in a temporary
directory from which the update.txt file will be selected.

Once the Update.txt file is selected, the “Upgrade Firmware” button will be enabled. Press this button to initiate the relay
firmware upgrade process. A voltage range selection window will appear, this voltage range is connected to the serial
number of the relay. The EnerVista 650 Setup program automatically pre-selects the appropriate voltage range for the unit.
If the voltage range is not selected correctly the error in voltage measurements will be 20 %.

Figure 5–17: VOLTAGE RANGE SELECTION

During the process, the program displays the files that are being updated. When the file transfer is finished, a message
appears noticing that it is necessary to wait sometime before resetting the unit, in order to start working with the new
firmware version in the relay. When the whole process has finished a message will be displayed asking to reboot the F650.

At this point, the firmware upgrade procedure is finished and the relay ready to be powered down and back up to check that
the firmware has been upgraded properly. 

When upgrading the firmware the entire settings and relay configuration are reset to factory default value. 

Once the equipment has been properly checked, the F650 is ready to be used.

Remember that calibration settings and configuration must be loaded to the relay. To recover the relay calibration:

Go to EnerVista 650 Setup main menu:

Communication > Calibration > Set calibration Settings to store in the relay the calibration settings if necessary.

File > Config file (*.650) Converter to convert the setting and configuration file *.650 for the relay (if is was in a previous
version format) to the new version (see section 3.1.6 File MENU OVERVIEW  in human interfaces in this manual)

File > Send info to relay to send the new settings and configuration file to the unit.
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5.4STEP LIST SUMMARY FOR VERSIONS 1.70 AND LATER

5.4.1 BOOT MEMORY UPDATE (*)

1. NSTALL THE PROPER VERSION OF THE ENERVISTA 650 Setup PROGRAM.

2. CONNECT AN RS-232 CABLE IN THE FRONT PORT OF THE RELAY AND ETHERNET ONE AT THE REAR
ETHERNET PORT (CROSSOVER CABLE FOR BACK-TO-BACK CONNECTION AND DIRECT ETHERNET CABLE
FOR  HUB OR SWITCH).

3. GET CALIBRATION SETTINGS (AND SAVE IT TO A FILE).

4. SAVE ALL THE DATA FROM THE RELAY (SETTINGS, OSCILLOGRAPHY, EVENTS).

5. FROM THE ENERVISTA 650 Setup PROGRAM SELECT COMMUNICATION/UPGRADE OPERATING SYSTEM.

6. FOLLOW THE INDICATIONS OF THE PROGRAM AND SELECT THE BOOT PROGRAM BIN FILE.

7. WHEN REQUIRED BY THE PROGRAM SWITCH OFF AND BACK ON THE RELAY.

8. CONTINUE WITH THE PROCESS AND SET THE IP ADDRESS AND GATEWAY WHEN REQUIRED.

5.4.2 FIRMWARE UPDATE (*)

1. SET THE APPROPRIATE IP ADDRESS IN THE RELAY.

2. SET THE APPROPRIATE IP ADDRESS IN THE PC.

3. FROM THE ENERVISTA 650 Setup PROGRAM SELECT “COMMUNICATION/UPGRADE SOFTWARE VERSION”.

4. ENTER THE IP ADDRESS, SERIAL NUMBER AND ORDERING CODE OF THE RELAY TO UPDATE.

5. WHEN REQUIRED BY THE PROGRAM SWITCH OFF AND BACK ON THE RELAY.

6. LOCATE THE UPDATE.TXT FILE ACCORDING TO THE MODEL OF THE RELAY.

7. PRESS UPGRADE FIRMWARE AND INITIATE THE UPGRADE PROCESS.

8. TO COMPLETE THE PROCEDURE, SWITCH OFF AND BACK ON THE RELAY WHEN REQUIRED BY THE
PROGRAM.

9. SET CALIBRATION SETTINGS (FROM THE PC TO THE RELAY) (for versions lower than 1.50).

10. THE SETTINGS AND CONFIGURATION ARE NOW SET TO FACTORY DEFAULT.

11. SEND THE NEW SETTINGS AND CONFIGURATION FILES TO THE RELAY IF NECESSARY.

 (*) The boot code upgrade must be performed using a crossed copper cable (RJ45) connected to the PC. It is not
necessary to modify the internal fiber/cable switch, as the upgrade is carried out at 10 Mb/s, and thus there is not cable/
fiber conflict.

This fact does not apply to the firmware upgrade, which can be performed either with the Ethernet fiber 
connection, or with the cable connection.

Notice that boot program and firmware upgrade will erase all the data contained in the relay, thus it is advisable 
to save all the data, oscillography, events, settings and configuration files previously.
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6 COMMISSIONING 6.1VISUAL INSPECTION

Verify that the relay has not suffered any damage during transportation, and that all screws are correctly fixed, and all relay
terminal boards are in good condition.

Verify that the information shown on the relay front plate corresponds to the data shown on the display, and to the
requested relay model.

Display information:

Firmware version 

Kernel version F650 X.XX(K.KK) 

GENERAL ELECTRIC 

F650XXXXXXXXX
19200N81 MODBUS:254

Model
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6.2GENERAL CONSIDERATIONS ON THE POWER SUPPLY NETWORK

All devices running on AC current are affected by frequency. As a non-senoidal wave is the result of a fundamental wave
plus a series of harmonics from this fundamental wave, it can be deducted that devices running on AC current are
influenced by the applied waveform.

For a correct testing of relays running on AC current, it is fundamental to use a current and/or voltage senoidal waveform.
The pureness of a senoidal wave (lack of harmonics) cannot be expressed specifically for a specific relay. However, any
relay incorporating sintonized circuits, R-L and R-C circuits, will be affected by non-senoidal waveforms, as in the case of
F650. 

These relays respond to the voltage waveform in a different way to the majority of AC current voltmeters. If the power
supply network used for the testing contains wide harmonics, the voltmeter and relay responses will be different.

Relays have been calibrated in factory using a Network of 50 or 60 Hz with a minimum harmonic content. When the relay is
tested, a power supply network with no harmonics in its waveform must be used.

The ammeters and chronometers used for testing the pickup current and relay operation time must be calibrated and their
accuracy must be better than the relay’s. The power supply used in the tests must remain stable, mainly in the levels near
the operation thresholds.

It is important to point out that the accuracy with which the test is performed depends on the network and on the
instruments used. Functional tests performed with unsuitable power supply network and instruments are useful to check
that the relay operates properly and therefore its operating characteristics are verified in an approximate manner. However,
if the relay would be calibrated in these conditions, its operational characteristics would be outside the tolerance range
values.

The following sections detail the list of tests for verifying the complete relay functionality.
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6.3ISOLATION TESTS

During all tests, the screw located on the rear of the relay must be grounded.

For verifying isolation, independent groups will be created, and voltage will be applied as follows: 

2200 RMS volts will be applied progressively among all terminals in a group, short-circuited between them and the
case, during one second.

2200 RMS volts will be applied progressively between groups, during one second.

WARNING: No communication circuit shall be tested for isolation.

Groups to be created will depend on the type of modules included in F650, selectable according to the model.

The following table shows the different groups depending on the module type:

SOURCE 1: SOURCE 2: MAGNETIC MODULE.
G1: H10, H18 G1: H1, H9 G1: A5..A12
G2: H13, H14, H15 G2: H4, H5, H6 G2: B1..B12

I/O F1 (MIXED) I/O F2 (SUPERVISION) I/O G1 (MIXED)
G1 (Inp. 1): F1..9 G1 (Spv 1): F1..4 G1 (Inp. 1): G1..9
G2 (Inp. 2): F10..18 G2 (Inp. 1): F5..9 G2 (Inp. 2): G10..18
G3 (Out.): F19..36 G3 (Inp. 2): F10..14 G3 (Out.): G19..36

G4 (Spv 2): F15..18
G5 (Out.): F19..30
G6 (Out.): F31.36
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6.4INDICATORS

Feed the relay and verify that when commanding a LED reset operation, all LED indicators light up and they are turned off
when pressing the ESC key for more than 3 seconds.
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6.5POWER SUPLY TESTING

Feed the relay to the minimum and maximum voltage. For each voltage value, verify that the alarm relay is activated when
there is voltage, and it is deactivated when there is no feed. If the power supply source incorporates AC feed, this test will
be performed also for VAC.

If the relay incorporates a redundant power supply, these tests shall be performed on both power supplies.

Voltage values to be applied will be the ones indicated below according to the relay model:

NOTE: Codes HIR and LOR correspond to a redundant power supply

SUPPLY V MIN. V MAX.

HI/HIR
110-250 Vdc
120-230 Vac

88 Vdc
96 Vac

300 Vdc
250 Vac

LO/LOR
24-48 Vdc 20 Vdc 57.6 Vdc
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6.6COMMUNICATIONS

Verify that available communication ports allow communication with the relay.

Ports to be checked are as follows:

Front:RS232

Rear:2 x RS485, 2 x Fiber Optic - Serial, 2 x Fiber Optic - Ethernet, 1 x RJ45 - Ethernet.

A computer with EnerVista 650 Setup software and an appropriate connector must be used.
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6.7VERIFICATION OF MEASURE

Set the relay as follows

NOTE:

ALL ANGLES INDICATED ARE DELAY ANGLES 

ALL VALUES OBTAINED IN THIS TEST MUST BE THE ONES CORRESPONDING TO THE DFT

6.7.1 VOLTAGES

Apply the following current and frequency values to the relay:

Verify that the relay measures the values with an error of  +/-1 % of the applied value plus 0,1% of full scale (275V).

6.7.2 PHASE CURRENTS

Apply the following voltage and frequency values to the relay:

Verify that the relay measures the values with an error lower than +/-0.5% of the test value or+/- 10 mA, whichever is
greater, for phases and ground.

Verify that the relay measures the values with an error lower than +/-1.5% of the test value or+/- 1 mA, whichever is greater,
for sensitive ground (SG).

GENERAL SETTINGS
NAME VALUE UNITS RANGE
PHASE CT RATIO 1.0 0.1 1.0-6000.0
GROUND CT RATIO 1.0 0.1 1.0-6000.0
STV GROUND CT RATIO 1.0 0.1 1.0-6000.0
PHASE VT RATIO 1.0 0.1 1.0-6000.0
PHASE VT CONNECTION WYE N/A WYE – DELTA
NOMINAL VOLTAGE 100 V 0.1 1-250 V
NOMINAL FREQUENCY 50 Hz 1 Hz 50-60 Hz
PHASE ROTATION ABC N/A ABC – ACB
FREQUENCY REFERENCE VI N/A VI-VII-VIII
AUXILIARY VOLTAGE VX N/A VX – VN

CHANNEL ANGLE FREQUENCY
50 Hz 60 Hz 50 Hz 60 Hz 50 Hz 60 Hz

VI 0º 0 5 50 100 150 275
VII 120º 0 5 50 100 150 275

VIII 240º 0 5 50 100 150 275

VX 0º 0 5 50 100 150 275

CHANNEL ANGLE FREQUENCY
50 Hz 60 Hz 50 Hz 60 Hz 50 Hz 60 Hz

Ia (A) 45º 0 15 10 5 1 0.1
Ib (A) 165º 0 15 10 5 1 0.1

Ic (A) 285º 0 15 10 5 1 0.1

IG(A) 0º 0 15 10 5 1 0.1

ISG(A) 0º 0 5 1 0.1 0.01 0.005
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6.7.3 ACTIVE, REACTIVE POWER, AND COSϑ METERING

Equations to be applied for powers in a wye connection are as follows:

Apply the following current and voltage values:

With the indicated voltage and current values, verify that the power measure corresponds to theoretical values indicated in
the following table:

Maximum admissible error is +/-1% of the test value for P and Q, and 0.02 for cosϕ.

6.7.4 FREQUENCY

Frequency measure on channel VII (terminals A7-A8):

Apply 50 Vac at 50 Hz on channel VII. Maximum admissible error:+/- 10 mHz.

Apply 50 Vac at 60 Hz on channel VII. Maximum admissible error: +/- 12 mHz.

Frequency measure on channel Vx (terminals A11-A12):

Apply 50 Vac at 50 Hz on channel Vx. Maximum admissible error:+/- 10 mHz.

Apply 50 Vac at 60 Hz on channel Vx. Maximum admissible error: +/- 12 mHz.

Results:

POWER PER PHASE THREE-PHASE POWER
P=V*I*Cosϕ P=Pa+Pb+Pc
Q=V*I*Senϕ Q=Qa+Qb+Qc

APPLIED VOLTAGE AND CURRENT VALUES PER PHASE
PHASE A PHASE B PHASE C V-I ANGLES
VI = 50 V, 0º VII = 50 V , 120º VIII = 50V, 240º ϕ=45º
Ia = 10∠45º Ib= 10∠165º Ic = 10∠285º Cosϕ= 0.707

THEORETICAL POWER VALUES
PHASE A PHASE B PHASE C THREE-PHASE
Pa = 353.55 MW Pb = 353.55 MW Pc = 353.55 MW P = 1060.66 MW
Qa = 353.55 MVAr Qb = 353.55 MVAr Qc = 353.55 MVAr Q = 1060.66 MVAr

CHANNEL VOLTAGE (V) SET FREQUENCY (HZ) MEASURED FREQUENCY (HZ)
VII 50 50 Hz

60 Hz
VX 50 50 Hz

60 Hz
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6.8INPUTS AND OUTPUTS

During all tests, the screw on the rear of the relay must be grounded.

6.8.1 DIGITAL INPUTS

During this test, the user will determine the activation/deactivation points for every input in the relay for the set voltage value
of 30 Volts.

Verify that the error does not exceed +/- 10% (+10% on activation, -10% on deactivation)

Default board settings for the input test can be modified in EnerVista 650 Setup software in:

Settings>Inputs/Outputs>Contact I/O>Board X

X, will be substituted by the corresponding board:

F for board in first slot

G for board in second slot

H for board in first slot of CIO module

J for board in second slot of CIO module

Test settings for mixed board (type 1:16 inputs and 8 outputs) :

The inputs test is completed by groups of 8 inputs, as this type of board has 2 groups of 8 inputs with the same common.
For the first 8 inputs, the voltage threshold setting is determined by Voltage Threshold A. For the next 8 inputs, the setting
is Voltage Threshold B. Inputs (or contact converters, CC1 – CC16) must also be set to POSITIVE.

Test settings for mixed board (type 2: 8 digital inputs, 4 blocks for supervision and 8 outputs) :

The inputs test is completed by groups of 4 inputs, as this type of board has 2 groups of 4 inputs with the same common.
For the first 4 inputs, the voltage threshold setting is determined by Voltage Threshold A. For the next 4 inputs, the setting
is Voltage Threshold B. Inputs (or contact converters, CC1 – CC8) must also be set to POSITIVE.

If the relay incorporates more input modules, this test must also be applied to them.

I/O BOARD TYPE 1 (MIXED)
Voltage Threshold A_X 30 V
Voltage Threshold B_X 40 V
Debounce Time A_X 5 ms
Debounce Time B_X 5 ms
Input Type_X_CC1 (CC1) POSITIVE
... ...
Input Type_X_CC16 (CC16) POSITIVE

I/O BOARD TYPE 2 (SUPERVISION)
Voltage Threshold A_X 30 V
Voltage Threshold B_X 40 V
Debounce Time A_X 5 ms
Debounce Time B_X 5 ms
Input Type_X_CC1 (CC1) POSITIVE
... ...
Input Type_X_CC8 (CC8) POSITIVE
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6.8.2 CONTACT OUTPUTS

The correct activation of every output will be verified.

For every output, activation command of a single contact must be given, and then verify that only that contact is activated.
Go to EnerVista 650 Setup Software (Settings>Inputs/Outputs>Force Outputs).

For switched contacts, the change of state of both contacts shall be verified.

6.8.3 CIRCUIT CONTINUITY SUPERVISION INPUTS 

Supervision inputs will be tested as normal inputs, revising the voltage level that will be 19 Volts.

Coil 1:

Apply 19 Vdc to both 52/a (terminals F1-F2) and 52/b (terminals F3-F4)”Coil 1” circuit supervision inputs and verify that
they are activated.

Apply -19 Vdc to both 52/a (terminals F1-F2) and 52/b (terminals F3-F4)”Coil 1” circuit supervision inputs and verify
that they are activated.

Remove voltage from both inputs and verify that it takes them 500 ms to change state (deactivate).

Coil 2:

Apply 19 Vdc to both 52/a (terminals F15-F16) and 52/b (terminals F17-F18)”Coil 2” circuit supervision inputs and
verify that they are activated.

Apply -19 Vdc to both 52/a (terminals F15-F16) and 52/b (terminals F17-F18)”Coil 2”  circuit supervision inputs and
verify that they are activated.

Remove voltage from both inputs and verify that it takes them 500 ms to change state (deactivate).

6.8.4 LATCHING CIRCUITS

Send a closing command to the latched contact (F31-F33).

Make circulate a current of 200 mA through the contact in series with the sensing terminal.

Send an opening command and verify that the contact does not open.

Interrupt current and check than the contact is released.

Repeat the test for the other latched contact (F34-F36).

I 

200 
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6.9CONNECTIONS FOR TESTING PROTECTION ELEMENTS

Connect current sources to the relay according to the wiring diagram. Current and voltage input terminals are as follows:

PHASE CONNECTIONS
Current
IA B1-B2
IB B3-B4
IC B5-B6
IG B9-B10
ISG B11-B12
Voltage
VI A5-A6
VII A7-A8
VIII A9-A10
VX A11-A12
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6.10INSTANTANEOUS OVERCURRENT (50PH, 50PL, 50N, 50G Y 50SG)

Set the relay to trip for the protection element being tested. Configure any of the outputs to be activated only by the
protection element being tested.

Apply 0.9 times the Pickup current and check that the relay does not trip.

Gradually increase the current value and verify that the relay operates between 1 and 1.1 times the set pickup current. The
relay must trip by instantaneous in a time frame of 10 to 55 ms. All the relay trip contacts must operate, as well as the
contact set as 50.

Remove current and apply it again suddenly to a value of 4 times the pickup current. The relay should trip instantaneously
in a time frame of 10 to 45 ms.

Test one point for each phase and group of the protection element.

50 ELEMENTS TEST PARAMETERS

Element Settings (50PH, 50PL, 50G y 50SG)

Setting Value Units

Function Enabled
Input RMS NA

Pickup Level 3 A

Delay time 0 Seconds

Test Execution

Configure one output for 50 Trip

Apply times I pickup Element Trip Tripping times (ms)
0.9 x Pickup NO NA
1.1 x Pickup YES 10-55
4 x Pickup YES 10-45

Elements Phase Group

50PH and 50PL IA 0
IB 0
IC 0

50G IG 0
50SG ISG 0
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6.11INVERSE TIME OVERCURRENT (51PH, 51PL, 51N, 51G Y 46)

Set the relay to trip for the protection element being tested. Configure any of the outputs to be activated only by the
protection element being tested.

Apply 0.9 times the Pickup current and check that the relay does not trip.

Apply 1.5 times the Pickup current. The relay should trip according to the time corresponding to its set curve.

Apply 5 times the Pickup current. The relay should trip according to the time corresponding to its set curve.

PROTECTION ELEMENT SETTINGS (51PH, 51PL, 51N, 51G AND 46)
SETTING VALUE UNIT
FUNCTION ENABLED
INPUT PHASOR (DFT)
PICKUP LEVEL 1 A
CURVE MODIFY FOR EACH TEST
TD MULTIPLIER MODIFY FOR EACH TEST
VOLTAGE RESTRAINT DISABLED
ELEMENT PHASE CURVE TYPE DIAL TIMES 

IPICKUP
TRIPPING TIMES (SEC)
THEORETICA
L

ADMISSIBLE

51PH IA IEEE Ext Inv 0.5 0.9 NA
1.5 11.34 [11.00 – 11.60]
5 0.648 [0.600 – 0.710]

IB IEC Curve A 0.05 0.9 NA
1.5 0.860 [0.750 – 0.950]
5 0.214 [0.200 – 0.300]

51PL IC IEEE Ext Inv 0.5 0.9 NA
1.5 11.34 [11.00 – 11.60]
5 0.648 [0.600 – 0.710]

IB IEC Curve A 0.05 0.9 NA
1.5 0.860 [0.750 – 0.950]
5 0.214 [0.200 – 0.300]

51N IC IEEE Ext Inv 0.5 0.9 NA
1.5 11.34 [11.00 – 11.60]
5 0.648 [0.600 – 0.710]

51G IG Definite Time 2 0.9 NA
5 2.000 [1.900 – 2.100]

46 I2 IEC Curve A 0.05 0.9 NA
1.5 0.860 [0.750 – 0.950]
5 0.214 [0.200 – 0.300]
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6.12DIRECTIONAL ELEMENTS (67P, 67N, 67G, 67SG)

In order to test directional units in the relay, instantaneous trips will be commanded.

Two points will be tested, per phase, test element.

The factory default configuration of the relay makes the overcurrent elements be supervised by directional units. This way,
if the directional element is enabled and detects the fault in the block direction, then the overcurrent unit will not operate. If
the directional element is not enabled or if it is enabled and it detects a fault in a trip direction, then the overcurrent unit will
operate if the set current level is exceeded.

6.12.1 67P ELEMENT

Activate only protection elements 50PH and 67P and set the relay as follows:

Configure one of the outputs to be activated only by unit 50PH.

Apply the following tests:

6.12.2 67N ELEMENT

Activate only protection elements 50N and 67N and set the relay as follows:

Configure one of the outputs to be activated only by unit 50G.

67P Settings 50PH Settings
Function ENABLED Function ENABLED
MTA 45 Deg Input PHASOR (DFT)
Direction FORWARD Pickup Level 0.50 A
Block Logic PERMISSION Trip Delay 0.30
Pol V Threshold 30 V Reset Delay 0.00

ELEMENTS PHASE UNDER TEST POLARIZATION PHASE ELEMENT TRIP
CHANNE
L

MAGNITUDE CHANNEL MAGNITUDE
MOD ARG MOD ARG

50PH/67P IA 2 A 0º VIII 60 V 0º NO

60 V 180º YES

IB 2 A 0º VI 60 V 0º NO

60 V 180º YES

IC 2 A 0º VII 60 V 0º NO

60 V 180º YES

67N Settings 50N Settings
Function ENABLED Function ENABLED
MTA -45 Deg Input PHASOR (DFT)
Direction FORWARD Pickup Level 0.50 A
Polarization VO Trip Delay 0.30
Block Logic PERMISSION Reset Delay 0.00
Pol V Threshold 10 V
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Apply the following tests:

6.12.3 67G ELEMENT

Activate only protection elements 50G and 67G and set the relay as follows:

Configure one of the outputs to be activated only by unit 50G.

Apply the following tests:

ELEMENTS PHASE UNDER TEST POLARIZATION PHASE ELEMENT TRIP
CHANNE
L

MAGNITUDE CHANNEL MAGNITUDE
MOD ARG MOD ARG

50N/67N IA 2 A 0º VI 60 V 0º NO

60 V 180º YES

IB 0 A 0º VII 0 V 0º

IC 0 A 0º VIII 0 V 0º

67G SETTINGS 50G SETTINGS
Function ENABLED Function ENABLED
MTA -45 Deg Input PHASOR (DFT)
Direction FORWARD Pickup Level 0.50 A
Polarization VO Trip Delay 0.30
Block Logic PERMISSION Reset Delay 0.00
Pol V Threshold 10 V

ELEMENTS PHASE UNDER TEST POLARIZATION PHASE ELEMENT TRIP
CHANNE
L

MAGNITUDE CHANNEL MAGNITUDE
MOD ARG MOD ARG

50G/67G IG 2 A 0º VI 60 V 0º NO
60 V 180º YES

VII 0 V 0º

VIII 0 V 0º
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6.12.4 67SG ELEMENT

Activate only protection elements 50SG and 67SG and set the relay as follows:

Configure one of the outputs to be activated only by unit 50SG.

Apply the following tests:

67SG SETTINGS 50SG SETTINGS
Function ENABLED Function ENABLED
MTA -45 Deg Input PHASOR (DFT)
Direction FORWARD Pickup Level 0.50 A
Polarization VO Trip Delay 0.30
Block Logic PERMISSION Reset Delay 0.00
Pol V Threshold 10 V

ELEMENTS PHASE UNDER TEST POLARIZATION PHASE ELEMENT TRIP
CHANNE
L

MAGNITUDE CHANNEL MAGNITUDE
MOD ARG MOD ARG

50SG/67SG ISG 2 A 0º VI 60 V 0º NO
60 V 180º YES

VII 0 V 0º

VIII 0 V 0º
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6.13UNDERVOLTAGE ELEMENTS (27P, 27X) 6.13.1 27P ELEMENT

Set the relay to trip for the protection element being tested. Configure any of the outputs to be activated only by the
protection element being tested.

Set the relay as follows:

Apply voltage as indicated on the table over the undervoltage setting level and verify that the relay does not trip.

Decrease voltage level gradually and verify that the relay trips for the set voltage (with an admissible error of 5%).

6.13.2 27X ELEMENT

Apply voltage as indicated on the table over the undervoltage setting level and verify that the relay does not trip.

Decrease voltage level gradually and verify that the relay trips for the set voltage (with an admissible error of 5%).

PHASE UV (27P)
Function ENABLED
Mode PHASE-GROUND
Pickup Level 50 V
Curve DEFINITE TIME
Delay 2.00 sec
Minimum Voltage 30 V
Logic ANY PHASE
Supervised by 52 DISABLED

ELEMENT PHASE CURVE PICKUP 
LEVEL

DELAY APPLIED 
VOLTAGE

TRIPPING TIMES (S)
THEORETICA
L

ADMISSIBLE

27P VI DEFINITE 
TIME

50 V 2 55 V NO TRIP NA
45 V 2.000 sec [2.000 – 2.100]

AUXILIARY UV (27X)
Function ENABLED
Pickup Level 50 V
Curve DEFINITE TIME
Delay 2.00 sec

ELEMENT INPUT CURVE PICKUP 
LEVEL

DELAY APPLIED 
VOLTAGE

TRIPPING TIME (S)
THEORETICA
L

ADMISSIBLE

27X VX DEFINITE 
TIME

50 V 2 55 V NO TRIP NA
45 V 2.000 sec [2.000 – 2.100]
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6.14OVERVOLTAGE ELEMENTS (59P, 59X, 59NH, 59NL, 47) 6.14.1 59P ELEMENT

Set the relay to trip for the protection element being tested. Configure any of the outputs to be activated only by the
protection element being tested.

Set the relay as follows:

Apply voltage as indicated on the table under the overvoltage setting level and verify that the relay does not trip.

Verify that the relay trips for the set voltage (with an admissible error of 5%).

6.14.2 59X ELEMENT

Set the relay as follows:

Apply voltage as indicated on the table under the overvoltage setting level and verify that the relay does not trip.

Verify that the relay trips for the set voltage (with an admissible error of 5%).

PHSE OV (59P)
Function ENABLED
Pickup Level 120 V
Trip Delay 2.00
Reset Delay 0.00
Logic ANY PHASE

ELEMENT PHASE PICKUP LEVEL 
(VOLTS)

TRIP DELAY
(SECONDS)

APPLIED 
VOLTAGE (V)

TRIPPING TIME (S)
THEORETICA
L

ADMISSIBLE

59P VII 120 2 114 NO TRIP NA
132 2 [1.9–2.1 ]
132 2 [1.9 – 2.1]

GENERAL SETTINGS
Auxiliary Voltage VX

AUXILIARY OV (59P)
Function ENABLED
Pickup Level 120 V
Trip Delay 2.00
Reset Delay 0.00
Logic ANY PHASE

ELEMENT INPUT PICKUP LEVEL 
(VOLTS)

TRIP DELAY
(SECONDS)

APPLIED 
VOLTAGE (V)

TRIPPING TIME (S)
THEORETICA
L

ADMISSIBLE

59X VX 120 2 114 NO TRIP NA
132 2 [1.9–2.1 ]
132 2 [1.9 – 2.1]
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6.14.3 59NH AND 59NL ELEMENTS

Set the relay as follows

Apply voltage as indicated on the table under the overvoltage setting level and verify that the relay does not trip.

Verify that the relay trips for the set voltage (with an admissible error of 5%).

This element can also be tested by applying only phase voltages. For this purpose, it is necessary to set Auxiliary Voltage =
VX. In this condition, Vn voltage is calculated as a sum of the phase voltages.

GENERAL SETTINGS
Auxiliary Voltage VN

NEUTRAL OV HIGH/LOW (59NH/59NL)
Function ENABLED
Pickup Level 120 V
Trip Delay 2.00
Reset Delay 0.00

ELEMENTS INPUT PICKUP LEVEL 
(VOLTS)

TRIP DELAY
(SECONDS)

APPLIED 
VOLTAGE (V)

TRIPPING TIME (S)
THEORETICA
L

ADMISSIBLE

59NH/59NL VX 120 2 114 NO TRIP NA
132 2 [1.9–2.1 ]
132 2 [1.9 – 2.1]
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6.14.4 47 ELEMENT - NEG SEQ OV

Set the relay as follows:

Apply voltage as indicated on the table under the overvoltage setting level and verify that the relay does not trip.

Verify that the relay trips for the set voltage (with an admissible error of 5%).

NOTE: All angles mentioned on the tables are delay angles, where a balanced ABC system would be composed by: 

NEG SEQ OV (47)
Function ENABLED
Pickup Level 50 V
Trip Delay 2.00
Reset Delay 0.00

CHANNEL APPLIED VOLTAGE (V) ANGLE TRIPPING TIME (S)
THEORETICAL ADMISSIBLE

VI 65 0º NO TRIP NA
VII 65 120º
VIII 65 240º
VI 55 0º 2 [1.9–2.1 ]
VII 55 240º
VIII 55 120º
VI 45 0º NO TRIP NA
VII 45 240º
VIII 45 120º

CHANNEL APPLIED VOLTAGE (V) ANGLE

VI 65 0º
VII 65 120º
VIII 65 240º
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6.15FREQUENCY ELEMENTS (81O/81U)

Set the relay to trip for the protection element being tested. Configure any of the outputs to be activated only by the
protection element being tested.

Set the relay as follows:

Apply voltage as indicated on the table, modifying frequency from the maximum threshold (48 Hz) to the minimum (46 Hz)
for 81U, and from the minimum (52 Hz) to the maximum (54 Hz) for 81O, in steps of 10 mHz.

Verify that the relay trips at the set frequency in the corresponding element with an error of 3% ó +/-50 mHz.

Apply a voltage that is lower than the “Minimum Voltage” setting, with a frequency under (81U) or over (81O) the setting,
and verify that the relay does not trip.

GENERAL SETTINGS
Nominal Frequency 50 Hz

ELEMENT SETTINGS
FREQUENCY (81) 81U 81O
Function ENABLED ENABLED
Pickup Level 47.50 Hz 52.50 Hz
Trip Delay 2.00 sec 2.00 sec
Reset Delay 0.00 sec 0.00 sec
Minimum Voltage 30 V 30 V

ELEMENTS PHASE PICKUP LEVEL 
(HZ)

TRIP DELAY
(SECONDS)

APPLIED 
VOLTAGE (V)

FREQUENCY 
THRESHOLDS

TRIPPING TIME (S)
THEORETICA
L

ADMISSIBLE

81U VII 47.5 2 80 48 Hz No trip NA
46 Hz 2 [1.9 –2.2]

25 46 Hz No trip NA
81 O VII 52.5 2 80 52 Hz No trip NA

54 Hz 2 [1.9 –2.2]
25 54 Hz No trip NA
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6.16RECLOSER (79)

Set protection element 79 as follows:

Set the relay to trip by 50PH

6.16.1 RECLOSING CYCLE

Connect a latching relay simulating the breaker managed by the F650 unit.

Once the relay is set, close the breaker and wait for 5 seconds.

After this time, the recloser is ready to initiate the reclosing cycle.

Command a 50PH trip and verify that the breaker opens and the relay recloses in 2.1 seconds.

Command a 50PH trip and verify that the breaker opens and the relay recloses in 4.1 seconds.

Command a 50PH trip and verify that the breaker opens and the relay recloses in 6.1 seconds.

Command a 50PH trip and verify that the breaker opens and the relay recloses in 8.1 seconds.

Command a 50PH trip and verify that the breaker opens and the recloser passes to Lockout.

Verify the correct operation of programmed outputs

Tripping times must be within the following values:

RECLOSER
Function ENABLED
Max Number Shots 4
Dead Time 1 2.10 sec
Dead Time 2 4.10 sec
Dead Time 3 6.10 sec
Dead Time 4 8.10 sec
Reclaim Time 3.00 sec
Cond. Permission ENABLED
Hold Time 7.00 sec
Reset Time 5.00 sec

50PH SETTINGS
Function ENABLED
Input RMS
Pickup Level 3 A
Trip Delay 0.00 s
Reset Delay 0.00 s

Reclosing Cycle
Nº shot Theoretical time Admissible time
1 2.1 sec [1.8 – 2.3]
2 4.1 sec [3.8 – 4.3]
3 6.1 sec [5.8 – 6.3]
4 8.1 sec [7.8 – 8.3]
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6.16.2 RECLOSER STATUSES

BLOCK

Activate the block input and verify that the recloser is in BLOCK status.

Close the breaker and wait for 5 seconds.

Command a trip and verify that the breaker opens but there is no reclose.

INHIBITION BY RECLOSING CONDITIONS

Close the breaker and wait for 5 seconds.

Command a trip, verify that the breaker opens and wait for the first shot.

Activate the inhibition input and command a new trip.

Verify that the breaker opens, wait for 8 seconds and verify that the relay does not reclose.

6.16.3 EXTERNAL RECLOSE INITIATION

Close the breaker and wait for 5 seconds.

Activate the reclose initiation input and open the breaker, verify that the relay executes the first shot
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6.17THERMAL IMAGE ELEMENT (49)

Disable all protection elements except for Thermal Model (49).

Set the pickup level to 2 A.

Set the time constant τ1 to 3 minutes and τ2 t0 one time τ1.

Apply currents of 2, 5, and 10 times the tap and ensure that the operation times are within the range described on the
following table:

After each measure, the thermal element must be reset to zero in order to start the next test at a zero thermal status
condition.

Repeat the test selecting a time constant τ1 of 60 minutes. Verify that the operation time is within the range described on
the following table:

After each measure, the thermal element must be reset to zero in order to start the next test at a zero thermal status
condition.

RATED CURRENT (A) APPLIED CURRENT (A) TIMES DE SET TAP OPERATION TIME (S)
4.0 2 48.5 - 53.6

5 10.0 5 7.06 - 7.80
20.0 10 1.77 - 1.95

RATED CURRENT (A) APPLIED CURRENT (A) TIMES DE SET TAP OPERATION TIME (S)
4.0 2 960 - 1072

5 10.0 5 141 - 156
20.0 10 35.4 - 39
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7 FREQUENTLY ASKED QUESTIONS 7.1COMMUNICATIONS
Q1 Does the F650 support DNP and ModBus over the Ethernet port?

A1 F650 units support both protocols over both the asynchronous serial ports and the Ethernet LAN synchronous port
using TCP/IP and UDP/IP layers over the Ethernet. 

Q2 Does this equipment support dual IP access?

A1 Yes, it supports two independent IP addresses in aliasing mode. Those address go in the communications settings
Network0 and Network1.

Q3 Is the protocol IEC 870-103 supported by the F650?

A3 At this moment it is not supported.

Q4 Can the F650 be used as a DNP master station?

A4 Not at this moment. It works as a slave IED station for all protocols.

Q5 How many communication ports are included in the F650?

A5 The equipment has 2 different boards, one for asynchronous serial ports and another for a high-speed synchronous
Ethernet port. The first board has 2 comm ports, COM1 and COM2. COM2 is multiplexed with the front serial RS232
port, whereas the COM1 port is completely independent from COM2.

The synchronous LAN port is COM3. 

Q6 Are there one or two Ethernet ports?

A6 The equipment has only 1 Ethernet port. For redundant fiber optic versions, redundancy is done at the physical level
(fiber optic) but there is just one port. 

Q7 How many different communication Ethernet sessions can be opened through the LAN port?

A7 ModBus TCP/IP:4 sockets 

DNP TCP/IP:3 sessions (from version 1.72 on) 

Q8 Does it support peer-to-peer horizontal communications? Is this going to interface with UR relays?

A8 It is not included in the present release.

Q9 May I use the cooper 10/100 BaseTX connection included in the basic model with all protocols?

A9 Yes, it may be used with all protocols. In noisy substation environments and/or long distances, it is recommended to
use fiber optic options due to much better EMC performance and immunity. For fiber optic models, it is necessary to
adjust an internal jumper to use the copper port.

Q10 Remote I/O CAN bus. Does it support DeviceNet protocol?

A10 No it does not support DeviceNet.

Q11:  Which functions are available in the relay web server? 

A11 Currently, it includes several functions for viewing measures and retrieving information.



7-2 F650 Digital Bay Controller GE Multilin

7.1 COMMUNICATIONS 7 FREQUENTLY ASKED QUESTIONS

7
Q12: What is the web site user password and name?

A12: The password is: 7169 and user name is: GE

Q13:  May I use URPC to program the relay? 

A13 Only oscillography records may be viewed with URPC once downloaded to a file using the ENERVISTA 650 Setup
software.

Q14: May I connect URs and F650s to the same Ethernet?

A14: Yes, either in cable as in fiber, or even mix them. 

Q15: How do I connect with fiber 10-BASE-FL UR relays with 100-BASE-FX F650 relays?

A15: Take into account that an UR is never connected directly to a F650 (neither two UR nor two F650 with each other)
but they are always connected through a hub or switch. The hub or switch where the URs are connected must be
10-BASE-FL and the hub or switch for the F650 must be 100-BASE-FX.

Q16: How do I connect with cable 10_BASE-T UR relays with 10/100-BASE-TX F650 relays?

A16: The answer to this question is as described before but also in this case there is an advantage added, because the
hub 10-BASE-TX port is able to understand a 10-BASE-T port. This means that a hub 10-BASE-T port may be
connected to an UR or a F650, and a hub 10/100-BASE-TX port may be connected either to an UR or F650.

Q17: What happens with fiber optic connectors compatibility, because the hub that I have has a different
connector to the one of the F650, although both are 100-BASE-FX?

A17: Just buy fiber cables with the appropriate male connectors. For the UR and F650 side we need the same
connectors, ST type, for the hub side, the correspondent ones. And in what concerns to the fiber type, it is used the
same for 10 as for 100, it is the 50/125 or 62.5/125 multimode, this last one allows longer distances.

Q18: What is the difference between a hub and a switch?

A18: In a repeater type hub (shared hub), one unit talks and the rest listen. If all the units are talking at the same time
there may be collisions in the messages, what may produce certain communication delays.

The switch (switched hub) has very powerful processors and a lot of memory and it is much more expensive than
the hub. It directs messages to the proper destination avoiding collisions and allowing a much more efficient
communication.

Q19: Why do we have 10/100 compatibility for cable but not for fiber?

A19: The cable has some advantages that the fiber does not have, and it is that the signal attenuation in short and
medium distances, is worthless and this is truth for low and high frequency signals. By the contrary, the light in one
fiber optic is highly attenuated, being much worse in case of high frequencies than in the low ones. The 10-BASE-FL
fiber transmission is performed in a wavelength of 850nm, what allows a less expensive electronic than the 1300 nm
used in 100-BASE-FX fiber transmission. Using, in both cases, the same glass multimode fiber type, the attenuation
to 1300 nm is lower than the 850 nm ones, this way the greater attenuation of the 100 Mbits is compensated. There
is another fiber standard, the 100-BASE-SX, which uses 850 nm to 100 Mbits, being compatible with the 10-BASE-
FL one, although it sacrifices the maximum distance to 300 m. Nowadays, this standard has not had success among
Ethernet equipment manufacturers and suppliers.
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7.2PROTECTION

Q1 Does the F650 support IRIG-B signals? Which type and accuracy? How many units may be connected to the
same source?

A1 Yes, the F650 includes an IRIG-B input for all models, including the basic ones.

It uses DC level format B. Formats used are B0000, B0002 and B0003.

Actual accuracy is 1 millisecond. Internal sampling rate allows true 1 ms accuracy time tagging.

The input burden is very low. The maximum number of units that may be connected to a generator depends on its
output driving capability. Up to 60 units have been successfully connected with equipments commonly used in the
market.

Q2 Does the equipment work with dry inputs in both AC and DC?

A2 The equipment works only with DC inputs.

Inputs should be driven with externally generated DC current. No special 48 Vdc or other outputs are included in the
equipment to drive these inputs; therefore, contacts connected to the equipment should be connected to a DC
source.

Q3 Is this equipment valid for Petersen coil grounded systems and ungrounded systems?

A3 The 5th current input is a very sensitive unit that measures from 5 mA up to 1.5 A, that is used for these systems.
The present release includes 67SG (sensitive ground) as well as 67IG (isolated ground for ungrounded systems).
Petersen Coil 67PC unit will be included in future releases that will only need firmware update.

Q4 Is oscillography programmable?

A4 Yes, the sampling rate is programmable (4, 8, 16, 32 or 64 samples per input). The depth will depend on the
sampling rate.

Q5 Do I have to select a different model for 1 or 5 A?

A5 No. The same model is able to work with either /1 A or /5 A rated secondary currents. There are high accuracy
sensing transformers that allow the use of any current input through the same terminals to reduce the spares and
simplify wiring.

Q6 In my installation, several digital inputs become active when I energize the transformer. How can I reduce
sensitivity?

A6 By selecting debounce time and/or voltage threshold, the relay may adapt its sensitivity to different applications.
Please select the maximum voltage threshold and debounce time (recommended 15 ms) to minimize AC coupling
effects.
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Q1 What is the difference between Get/Send info from/to relay and Upload/Download info files to/from relay?

A1 Get/Send are used for settings and configuration storage that although both are in a unique file, are sent separately
in two times. Upload/Download are used for project or PLC files group storage. These files are the
setting_configuration file source. To operate, the F650 does not need the source files; the Upload/Download tool is
destined to serve as historic file.

Q2 Could I program interlocks?

A2 Yes, via ENERVISTA 650 Setup interlocks may be programmed from very simple to advanced schemes.

Q3 Can we rotate the display 90 degrees to show feeders vertically?

A3 No. The product has been designed to view it in horizontal mode (landscape) due to the following reasons:

It is easier to read the LCD display because it has been designed for horizontal positions.

Compatibility between text display (4x20 characters) and LCD display (16x40 characters or 128x240 pixels).

Refresh speed is better in horizontal than vertical format.

Q4 Do I need a laptop or handheld to program the unit?

A4 No, all main operations can easily be performed with just the incorporated HMI. Handheld or laptops may be
required to download large quantities of information (such as oscillograms, etc.) but they are not mandatory for a
conventional user that just needs to change settings, view measurements, states, etc.

Q5 Is there password security for protection and control?

A5 Yes, there are two passwords. An independent password for protection changes and control operations is available
since version 1.44.

Q6 Is it possible to have a remote HMI installed in the front of the panel with the rest of the relay in the rear
side?

A6 Not in the present version.

Q7 Is it possible to program a default screen for the HMI?

A7 In graphic display versions the user may program a custom screen with the single-line diagram, measurements, etc.
In text display models, there is a choice of logo, measurements, or scrolling both screens.

Q8 May I force inputs and outputs to ease commissioning and testing?

A8 Yes.

Q9 How can I disable the rotary knob buzzer?

A9 Press ESC key during more than 3 seconds and then press the knob during a short pulse.

Q10 Why do appear strange texts on the display when switching on the relay?

A10 You will have pressed any button and the HMI has entered in a test mode. 

The display messages are updated after a few minutes, once the relay has completed the starting sequence.
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Q1 Does the "Service" contact on the Power Supply board cover all possible failures or do I have to create an
output on the I/O board that includes all the internal errors I can access in the logic?

A1 The power supply ready contact only monitor hardware failures in the power supply, to monitor the internal error of
the unit it is necessary to configure a virtual output to and the assign it to the device desired (contact output, LED,
etc.).

Q2 I set an output contact as "Latched". If I do not set a "reset" condition, will it reset from the "ESC" key?

A2 No, you have to configure the contact output reset signal (in Settings>Relay Configuration>Outputs). The ESC
key only reset the LED indicators.
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8 TROUBLESHOOTING GUIDE 

F650 units have been designed and verified using the most advanced and reliable equipment. Mounting and
testing automation ensure a high consistency of the final product. Before sending a unit back to the factory, we
strongly recommend you follow the recommendations below. Even if it will not always solve the problem, at least
they will help define it better for a quicker repair.

If you need to send a unit back to the factory for repair, please use the appropriate RETURN MATERIAL AUTHORISATION
process, and follow the shipping instructions provided by our Service Department, especially in the case of international
shipments. This will lead to a faster and efficient solution of your problem.

CATEGORY SYMPTOM POSSIBLE CAUSE RECOMMENDED ACTION
Protection The relay does not trip -Function not permitted

- Function blocked

- Output not assigned

- Set the function permission to 
ENABLED

- Check Protection units block screen

- Program the output to the desired 
function using ENERVISTA 650 Setup 
logic configuration

General When feeding the unit, 
no indicator is lit up

-Insufficient power supply

- Wrong versions

-Fused fuse

- Loose fuse

-Incorrect wiring

-Verify the voltage level using a 
multimeter in the power supply 
terminals, and check that it is within 
the model range

- Check relay and ENERVISTA 650 
Setup versions are the same

-Remove power supply, dismount the 
power supply module and replace the 
fuse

- Same as above with same fuse

-Make sure that terminals labeled + 
and – are connected to the 9-pin 
connector corresponding to the power 
source

Communication The relay does not 
communicate via the 
front RS232 port

-Incorrect cable

-Damaged cable

-Relay or PC not grounded

-Incorrect baudrate, port, address, etc. 

-Make sure you are using a straight 
cable

-Replace the cable

-Ensure ground connection

-Test other ports, other baudrates, etc. 
Make sure that the communication 
parameters in the computer match the 
ones in the relay.

General After Updating the 
firmware the relay 
does not start up and 
always shows the 
message “Os 
Loading…”.

Check that the bootware version 
match with the firmware version

If there is an incompatibility between 
boot and firmware version, update to 
the corresponding boot and after that 
update the firmware version

If the boot and firmware versions are 
correct, perform the firmware update 
procedure again.

Communications Cannot see properly 
the web server in F650 
with Windows XP. 

Some windows are in 
grey with a red cross 
mark.

Disabled Java options in Advanced 
Internet Explorer properties or high 
level of security

1.- Go to Advanced in Internet options 
for Internet explorer and select the 
three selections in Microsoft VM (Java 
Virtual Machine) and deselect any 
other virtual machine not Microsoft, for 
example SUN.
In case Microsoft VM is not installed in 
the computer, the user must install it 
using the Microsoft VM installation 
program msjavx86.exe
For internet explorer 6.0 or higher it is 
not included by default.
2.- Try to set a lower level of security in 
internet explorer options.
3.-Delete temporary internet files in 
“General” screen in internet explorer 
options.



8-2 F650 Digital Bay Controller GE Multilin

 8 TROUBLESHOOTING GUIDE

8

Communication Enervista 650 Setup 
does not retrieve osc, 
fault reports and Data 
Logger files

Bad communication in TFTP using 
Windows 2000

Disable and Enable the Ethernet 
connection on Control Panel inside 
Windows 2000. Try again to retrieve 
files from relay
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APPENDIX A A.1FACTORY DEFAULT LOGIC A.1.1 FACTORY DEFAULT SETTINGS

OR3

10

OR3

11

LEDS AND OUTPUTS BOOLEANS

PICKUPS

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VO_050_50PL_PKP

44

VO_051_50PH_PKP

45

VO_053_51P_PKP

46

PH IOC1 LOW PKP

104

PH IOC2 LOW PKP

105

PH IOC3 LOW PKP

106

PH IOC1 HIGH PKP

107

PH IOC2 HIGH PKP

108

PH IOC3 HIGH PKP

109

PH TOC1 HIGH PKP

110

PH TOC2 HIGH PKP

111

PH TOC3 HIGH PKP

112

THERMAL1 ALARM

188

THERMAL2 ALARM

189

THERMAL3 ALARM

190

OR3

191

inOR1

inOR2

inOR3

outOR1

OR3

202

OR3

203

NEUTRAL IOC1 PKP

204

NEUTRAL IOC2 PKP

205

NEUTRAL IOC3 PKP

206

NEUTRAL TOC1 PKP

207

NEUTRAL TOC2 PKP

208

VO_004_50N_PKP

209

VO_005_51N_PKP

210

VO_001_THERMAL_ALARM

216

inOR1

VO_050_50PL_PKP

inOR2

217

VO_051_50PH_PKP

218

inOR3

VO_053_51P_PKP

outOR1

219

VO_007_PHASE_OVERCURRENT_PKP

220

inOR1

OR

inOR2

inOR3

outOR1

221
VO_005_51N_PKP

222

VO_004_50N_PKP

223 VO_008_NEUTRAL_OVERCURRENT_PKP

224

OR3

312

PH TOC1 LOW PKP

322

PH TOC2 LOW PKP

323

PH TOC3 LOW PKP

324

OR6

325

OVERCURRENT
PICKUPS

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

inOR4

inOR5

inOR6

outOR1

NEUTRAL TOC3 PKP

411
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A-2 F650 Digital Bay Controller GE Multilin

A.1 FACTORY DEFAULT LOGIC APPENDIX A 

A

OR3

0

OR3

1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

OVERCURRENT
PICKUPS

VO_048_50G_PKP

42

VO_049_51G_PKP

43

GROUND IOC1 PKP

98

GROUND IOC2 PKP

99

GROUND IOC3 PKP

100

GROUND TOC1 PKP

101

GROUND TOC2 PKP

102

GROUND TOC3 PKP

103

OR3

177
VO_043_50IG_PKP

178ISOLATED GND1 PKP

179

ISOLATED GND2 PKP

180

ISOLATED GND3 PKP

181

OR3

192

OR3

193

SENS GND IOC1 PKP

194

SENS GND IOC2 PKP

195

SENS GND IOC3 PKP

196

SENS GND TOC1 PKP

197

SENS GND TOC2 PKP

198

SENS GND TOC3 PKP

199

VO_002_50SG_PKP

200

VO_003_51SG_PKP

201

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

OR3

211NEG SEQ TOC1 PKP

212

NEG SEQ TOC2 PKP

213

NEG SEQ TOC3 PKP

214

VO_006_I2_TOC_PKP

215

OR

225
VO_049_51G_PKP

226

VO_009_GROUND_OVERCURRENT_PKP

227

VO_048_50G_PKP

228

VO_002_50SG_PKP

229

VO_003_51SG_PKP

230

inOR1

VO_043_50IG_PKP

inOR2

231

inOR3

OR3

outOR1

232
VO_010_SENSITIVE_GROUND_PKP

233

VO_011_ALL_OVERCURRENT_PKP

234

VO_007_PHASE_OVERCURRENT_PKP

235

VO_008_NEUTRAL_OVERCURRENT_PKP

236

VO_009_GROUND_OVERCURRENT_PKP

237

VO_010_SENSITIVE_GROUND_PKP

238

VO_006_I2_TOC_PKP

239

inOR1

inOR2

inOR3

outOR1

OR6

314

VO_001_THERMAL_ALARM

315

inOR1

inOR2

inOR3

inOR4

inOR5

inOR6

outOR1
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GE Multilin F650 Digital Bay Controller A-3

APPENDIX A A.1 FACTORY DEFAULT LOGIC

A

OR3

2

OR3

3

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VOLTAGE
PICKUPS

VO_045_27P_PKP

40

VO_046_59P_PKP

41

PHASE UV1 PKP

92

PHASE UV2 PKP

93

PHASE UV3 PKP

94

PHASE OV1 PKP

95

PHASE OV2 PKP

96

PHASE OV3 PKP

97

OR3

240NEUTRAL OV1 HIGH PKP

241

NEUTRAL OV2 HIGH PKP

242

NEUTRAL OV3 HIGH PKP

243

NEUTRAL OV1 LOW PKP

244

NEUTRAL OV2 LOW PKP

245

NEUTRAL OV3 LOW PKP

246

AUXILIARY UV1 PKP

247

AUXILIARY UV2 PKP

248

AUXILIARY UV3 PKP

249

AUXILIARY OV1 PKP

250

AUXILIARY OV2 PKP

251

AUXILIARY OV3 PKP

252

NEG SEQ OV1 PKP

253

NEG SEQ OV2 PKP

254

NEG SEQ OV3 PKP

255

OR3

256

OR3

257

OR3

258

OR3

259

VO_012_59NH_PKP

260

VO_013_59NL_PKP

261

VO_014_27X_PKP

262

VO_015_59X_PKP

263

VO_016_V2_OV_PKP

264

VO_017_ALL_VOLTAGE_PKP

265

VO_012_59NH_PKP

266

VO_013_59NL_PKP

267

VO_014_27X_PKP

268

VO_015_59X_PKP

269

VO_016_V2_OV_PKP

270

VO_045_27P_PKP

271

VO_046_59P_PKP

inOR1

272

inOR2

OR7

inOR3

outOR1

273

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

InOR1

InOR2

InOR3

InOR4

InOR5

InOR6

InOR7

OutOR1
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A-4 F650 Digital Bay Controller GE Multilin

A.1 FACTORY DEFAULT LOGIC APPENDIX A 

A

OR3

25

OR3

26

OR

27

FREQUENCY
PICKUPS

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

VO_054_81O_PKP

inOR3

47

outOR1
VO_055_81U_PKP

48

VO_054_81O_PKP

49

VO_055_81U_PKP

50 VO_056_ALL_FREQUENCY_PKP

51

VO_085_GENERAL_PKP

91

OVERFREQ1 PKP

113

OVERFREQ2 PKP

114

OVERFREQ3 PKP

115

UNDERFREQ1 PKP

116

UNDERFREQ2 PKP

117

UNDERFREQ3 PKP

118

BROKEN
CONDUCTOR

OR3

275BROKEN CONDUCT1 PKP

276

BROKEN CONDUCT2 PKP

277

BROKEN CONDUCT3 PKP

278

VO_018_BROKEN_CONDUCTOR_PKP

279

VO_011_ALL_OVERCURRENT_PKP

280

VO_017_ALL_VOLTAGE_PKP

281

VO_056_ALL_FREQUENCY_PKP

282

VO_018_BROKEN_CONDUCTOR_PKP

283
GENERAL
PICKUP

inOR1

inOR2

inOR3

outOR1

OR6inOR1

inOR2

inOR3

inOR4

348

inOR5

FWD PWR1 STG1 PKP

inOR6

outOR1

349

FWD PWR1 STG2 PKP

350

FWD PWR2 STG1 PKP

351

FWD PWR2 STG2 PKP

352

FWD PWR3 STG1 PKP

353

FWD PWR3 STG2 PKP

354

VO_023_FORWARD_POWER_PKP

355

FORWARD
POWER

DIRECTIONAL
POWER

VO_025_DIRECTIONAL_POWER_PKP

372

DIR PWR2 STG PKP

373

DIR PWR3 STG PKP

374

OR3

375

inOR1

inOR2

inOR3

VO_023_FORWARD_POWER_PKP

outOR1

376

VO_025_DIRECTIONAL_POWER_PKP

377

OR

378

POWER VO_026_POWER_PKP

380

VO_026_POWER_PKP

381

DIR PWR1 STG PKP

394

LOCKED
ROTOR

OR3

396

inOR1

inOR2

inOR3

outOR1
LOCKED ROTOR1 PKP

397

LOCKED ROTOR2 PKP

398

LOCKED ROTOR3 PKP

399

VO_029_LOCKED_ROTOR_PKP

400

OR6inOR1

inOR2

inOR3

inOR4

inOR5

inOR6

outOR1

409

VO_029_LOCKED_ROTOR_PKP

410
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GE Multilin F650 Digital Bay Controller A-5

APPENDIX A A.1 FACTORY DEFAULT LOGIC

A

OR3

7

OR3

8

OR

9

OR3

12

OR3

13

OR3

14

inOR1

inOR2

inOR3

outOR1

TRIPS

inOR1

OR3

inOR2

inOR3

outOR1

32

OVERCURRENT
TRIPS

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VO_057_51P_TRIP

52

VO_058_50PH_TRIP

53

VO_059_50PL_TRIP

54

VO_062_THERMAL_TRIP

56

VO_064_50N_TRIP

57

VO_065_51N_TRIP

58

VO_066_NEUTRAL_OVERCURRENT_TRIP

59VO_064_50N_TRIP

60

VO_065_51N_TRIP

61

VO_067_51G_TRIP

62

PH TOC1 HIGH OP

119

PH TOC2 HIGH OP

120

PH TOC3 HIGH OP

121

PH IOC1 HIGH OP

122

PH IOC2 HIGH OP

123

PH IOC3 HIGH OP

124

PH IOC1 LOW OP

125

PH IOC2 LOW OP

126

PH IOC3 LOW OP

127

THERMAL1 OP

131

THERMAL2 OP

132

THERMAL3 OP

133

NEUTRAL IOC1 OP

134

NEUTRAL IOC2 OP

135

NEUTRAL IOC3 OP

136

NEUTRAL TOC1 OP

137

NEUTRAL TOC3 OP

138
NEUTRAL TOC2 OP

139

GROUND TOC1 OP

143

GROUND TOC2 OP

144

GROUND TOC3 OP

145

VO_019_PHASE_OVERCURRENT_TRIP

285
VO_057_51P_TRIP

286

VO_058_50PH_TRIP

287

VO_059_50PL_TRIP

288

OR3

313

OR6

318

PH TOC1 LOW OP

319

PH TOC2 LOW OP

320

PH TOC3 LOW OP

321

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

inOR4

inOR5

inOR6

outOR1
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A-6 F650 Digital Bay Controller GE Multilin

A.1 FACTORY DEFAULT LOGIC APPENDIX A 

A
OR3

4

inOR1

inOR2

inOR3

outOR1

OR3

15

OR

16

OR3

17

OR3

18

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VO_061_I2_TOC_TRIP

55

VO_068_50G_TRIP

63

VO_069_GROUND_OVERCURRENT_TRIP

64VO_067_51G_TRIP

65

VO_068_50G_TRIP

66

VO_070_51SG_TRIP

67

VO_071_50SG_TRIP

68

VO_072_SENSITIVE_GROUND_TRIP

69
VO_070_51SG_TRIP

70

VO_071_50SG_TRIP

71

NEG SEQ TOC1 OP

128

NEG SEQ TOC2 OP

129

NEG SEQ TOC3 OP

130

GROUND IOC1 OP

140

GROUND IOC2 OP

141

GROUND IOC3 OP

142

SENS GND IOC1 OP

146

SENS GND IOC2 OP

147

SENS GND IOC3 OP

148

SENS GND TOC1 OP

149

SENS GND TOC2 OP

150

SENS GND TOC3 OP

151

OR3

176

OR3

182ISOLATED GND1 OP

183

ISOLATED GND2 OP

184

ISOLATED GND3 OP

185

VO_044_50IG_TRIP

186

VO_044_50IG_TRIP

187

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VO_020_ALL_OVERCURRENT_TRIP

289

VO_019_PHASE_OVERCURRENT_TRIP

290

VO_066_NEUTRAL_OVERCURRENT_TRIP

291

VO_069_GROUND_OVERCURRENT_TRIP

292

VO_072_SENSITIVE_GROUND_TRIP

293

VO_061_I2_TOC_TRIP

294

OR6

316

VO_062_THERMAL_TRIP

317

inOR1

inOR2

inOR3

inOR4

inOR5

inOR6

outOR1

OVERCURRENT
TRIPS
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GE Multilin F650 Digital Bay Controller A-7

APPENDIX A A.1 FACTORY DEFAULT LOGIC

A

OR3

5

OR3

6

inOR1

inOR2

inOR3

outOR1

OR3

inOR1

inOR2

19

inOR3

OR3

outOR1

20

OR3

21

OR3

22

VOLTAGE
TRIPS

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VO_073_27P_TRIP

72

VO_074_59P_TRIP

73

VO_075_59NH_TRIP

74

VO_076_59NL_TRIP

75

VO_077_59X_TRIP

76

VO_078_27X_TRIP

77

VO_079_ALL_VOLTAGE_TRIP

78

VO_073_27P_TRIP

79

VO_074_59P_TRIP

80

VO_075_59NH_TRIP

81

VO_076_59NL_TRIP

82

VO_077_59X_TRIP

83

VO_078_27X_TRIP

84

PHASE UV1 OP

152

PHASE UV2 OP

153

PHASE UV3 OP

154

PHASE OV1 OP

155

PHASE OV2 OP

156

PHASE OV3 OP

157

NEUTRAL OV1 HIGH OP

158

NEUTRAL OV2 HIGH OP

159

NEUTRAL OV3 HIGH OP

160

NEUTRAL OV1 LOW OP

161

NEUTRAL OV2 LOW OP

162

NEUTRAL OV3 LOW OP

163

AUXILIARY OV1 OP

164

AUXILIARY OV2 OP

165

AUXILIARY OV3 OP

166

AUXILIARY UV1 OP

167

AUXILIARY UV2 OP

168

AUXILIARY UV3 OP

169

OR3

295NEG SEQ OV1 OP

296

NEG SEQ OV2 OP

297

NEG SEQ OV3 OP

298

VO_021_V2_OV_TRIP

299

VO_021_V2_OV_TRIP

300

OR7

301

inOR1

inOR2

inOR3

outOR1

InOR1

InOR2

InOR3

InOR4

InOR5

InOR6

InOR7

OutOR1
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A-8 F650 Digital Bay Controller GE Multilin

A.1 FACTORY DEFAULT LOGIC APPENDIX A 

A

OR3

34

FREQUENCY
TRIPS

OR3

37

OR

38

GENERAL
TRIP

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VO_080_81O_TRIP

85

VO_081_81U_TRIP

86

VO_082_ALL_FREQUENCY_TRIP

87VO_080_81O_TRIP

88

VO_081_81U_TRIP

89

VO_083_GENERAL_TRIP

90

OVERFREQ1 OP

170

OVERFREQ2 OP

171

OVERFREQ3 OP

172

UNDERFREQ1 OP

173

UNDERFREQ2 OP

174

UNDERFREQ3 OP

175

BROKEN
CONDUCTOR

OR3

303BROKEN CONDUCT1 OP

304

BROKEN CONDUCT2 OP

305

BROKEN CONDUCT3 OP

306

VO_022_BROKEN_CONDUCTOR_TRIP

307

VO_020_ALL_OVERCURRENT_TRIP

308

VO_022_BROKEN_CONDUCTOR_TRIP

309

VO_079_ALL_VOLTAGE_TRIP

310

VO_082_ALL_FREQUENCY_TRIP

311

inOR1

inOR2

inOR3

outOR1

FORWARD
POWER

OR6inOR1

358

inOR2

FWD PWR1 STG1 OP

inOR3

inOR4

359

inOR5

FWD PWR1 STG2 OP

inOR6

360
outOR1

FWD PWR2 STG1 OP

361

FWD PWR2 STG2 OP

362

FWD PWR3 STG1 OP

363

FWD PWR3 STG2 OP

364

VO_024_FORWARD_POWER_TRIP

365

DIRECTIONAL
POWER

DIR PWR1 STG OP

383

DIR PWR2 STG OP

384

DIR PWR3 STG OP

385

OR3

386

inOR1

inOR2

inOR3

outOR1
VO_027_DIRECTIONAL_POWER_TRIP

387

POWER
VO_024_FORWARD_POWER_TRIP

389

VO_027_DIRECTIONAL_POWER_TRIP

390

OR

391

VO_028_POWER_TRIP

392

VO_028_POWER_TRIP

393

LOCKED
ROTOR

OR3

402

inOR1

inOR2

inOR3

outOR1
LOCKED ROTOR1 OP

403

LOCKED ROTOR2 OP

404

LOCKED ROTOR3 OP

405

VO_030_LOCKED_ROTOR_TRIP

406

OR6inOR1

inOR2

inOR3

inOR4

inOR5

inOR6

outOR1

407

VO_030_LOCKED_ROTOR_TRIP

408
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GE Multilin F650 Digital Bay Controller B-1

APPENDIX B B.1 FACTORY DEFAULT CONFIGURATION

B

APPENDIX B B.1FACTORY DEFAULT CONFIGURATION B.1.1  FACTORY DEFAULT SETTINGS

PRODUCT SETUP>COMMUNICATION SETTINGS >SERIAL PORTS

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Baud rate for COM 1 COM1 Baud Rate 19200 N/A [300 : 115200]
Baud rate for COM 2 COM2 Baud Rate 19200 N/A [300 : 115200]
Parity for serial COM ports Parity NONE N/A [NONE:ODD:EVEN]

PRODUCT SETUP>COMMUNICATION SETTINGS >NETWORK (ETHERNET)
NETWORK (ETHERNET)1 > NETWORK (ETHERNET)2

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

1st  octec of IP address IP Address Oct1 0 N/A [0 : 255]
2nd  octec of IP address IP Address Oct2 0 N/A [0 : 255]
3rd  octec of IP address IP Address Oct3 0 N/A [0 : 255]
4th  octec of IP address IP Address Oct4 0 N/A [0 : 255]
1st  octec of Netmask Netmask Oct1 0 N/A [0 : 255]
2nd  octec of Netmask Netmask Oct2 0 N/A [0 : 255]
3rd  octec of Netmask Netmask Oct3 0 N/A [0 : 255]
4th  octec of Netmask Netmask Oct4 0 N/A [0 : 255]
1st  octec of Gateway Gateway IP Oct1 0 N/A [0 : 255]
2nd  octec of Gateway Gateway IP Oct2 0 N/A [0 : 255]
3rd  octec of Gateway Gateway IP Oct3 0 N/A [0 : 255]
4th  octec of Gateway Gateway IP Oct4 0 N/A [0 : 255]

PRODUCT SETUP>COMMUNICATION SETTINGS >MODBUS PROTOCOL

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Slave address for COM1 Modbus Address 
COM1 254 N/A [1 : 255]

Slave address for COM2 Modbus Address 
COM2 254 N/A [1 : 255]

Modbus port number for Modbus TCP/
IP Modbus Port Number 502 N/A [0 : 65535]



B-2 F650 Digital Bay Controller GE Multilin

B.1 FACTORY DEFAULT CONFIGURATION APPENDIX B 

B

PRODUCT SETUP>COMMUNICATION SETTINGS >DNP3 SLAVE
DNP3 SLAVE 1 > DNP3 SLAVE 2 > DNP3 SLAVE 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Communications port assigned to the 
DNP protocol Physical Port NONE N/A [COM1:COM2:NETWORK]

DNP slave address Address 255 N/A [0 : 65534]
1st Octect of IP address of DNP 
master 1 IP Addr Client1 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 1 IP Addr Client1 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 1 IP Addr Client1 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 1 IP Addr Client1 Oct4 0 N/A [0 : 255]

1st Octect of IP address of DNP 
master 2 IP Addr Client2 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 2 IP Addr Client2 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 2 IP Addr Client2 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 2 IP Addr Client2 Oct4 0 N/A [0 : 255]

1st Octect of IP address of DNP 
master 3 IP Addr Client3 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 3 IP Addr Client3 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 3 IP Addr Client3 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 3 IP Addr Client3 Oct4 0 N/A [0 : 255]

1st Octect of IP address of DNP 
master 4 IP Addr Client4 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 4 IP Addr Client4 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 4 IP Addr Client4 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 4 IP Addr Client4 Oct4 0 N/A [0 : 255]

1st Octect of IP address of DNP 
master 4 IP Addr Client5 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 4 IP Addr Client5 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 4 IP Addr Client5 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 4 IP Addr Client5 Oct4 0 N/A [0 : 255]

TCP/UDP port number for DNP over 
Ethernet TCP/UDP Port 20000 N/A [0 : 65535]

Unsolicited responses permission Unsol Resp Function DISABLED N/A [DISABLED – ENABLED]
Time out to confirm an unsolicited 
response Unsol Resp TimeOut 5 1 s [0 : 60]

Number of retransmition of an unsol 
resp w/o confirmation Unsol Resp Max Ret 10 N/A [0 : 255]

Address to which all unsolicited 
responses are sent Unsol Resp Dest Adr 200 N/A [0 : 65519]

Scale for currents Current Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]

Scale for voltages Voltage Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]



GE Multilin F650 Digital Bay Controller B-3

APPENDIX B B.1 FACTORY DEFAULT CONFIGURATION

B

PRODUCT SETUP>COMMUNICATION SETTINGS >DNP3 SLAVE (CONT.)
DNP3 SLAVE 1 > DNP3 SLAVE 2 > DNP3 SLAVE 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Scale for power Power Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]

Scale for energy Energy Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]

Other Scale factor Other Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]

Default deadband for Current Analog 
Input points to trigger unsolicited 
responses

Current Deadband 30000 N/A [0 : 65535]

Default deadband for Voltage Analog 
Input points to trigger unsolicited 
responses

Voltage Deadband 30000 N/A [0 : 65535]

Default deadband for Power Analog 
Input points to trigger unsolicited 
responses

Power Deadband 30000 N/A [0 : 65535]

Default deadband for Energy Analog 
Input points to trigger unsolicited 
responses

Energy Deadband 30000 N/A [0 : 65535]

Default deadband for Other Analog 
Input points to trigger unsolicited 
responses

Other Deadband 30000 N/A [0 : 65535]

Size (in bytes) for message 
fragmentation Msg Fragment Size 240 1 byte [30 : 2048]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 1 CTL EVENTS 1-16 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 2 CTL EVENTS 17-32 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 3 CTL EVENTS 33-48 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 4 CTL EVENTS 49-64 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 5 CTL EVENTS 65-80 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 6 CTL EVENTS 81-96 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 7 CTL EVENTS 97-

112 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 8 CTL EVENTS 113-

128 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 9 SWITCHGEAR 1-8 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 10 SWITCHGEAR 9-

16 N/A [See DNP note2]

DNP NOTES
Note 1: Scale Factor Note that a scale factor of 0.1 is equivalent to a multiplier of 10 (i.e. the value will be 10 times 

Note 2: Binary Input Block Selection:
[NOT USED, CTL EVENTS 1-16, CTL EVENTS 17-32, CTL EVENTS 33-48,CTL EVENTS 49-
64, CTL EVENTS 65-80, CTL EVENTS 81-96, CTL EVENTS 97-112, CTL EVENTS 113-128, 
SWITCHGEAR 1-8, SWITCHGEAR 9-16]
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PRODUCT SETUP>COMMUNICATION SETTINGS >IEC 870-5-104

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Enable or disable the protocol 
operation Function DISABLED N/A [DISABLED – ENABLED]

Listening TCP port in the relay TCP Port 2404 N/A [0 : 65535]

Address in the ASDU header Common Addr of 
ASDU 255 N/A [0 : 65535]

Number of seconds for instantaneous 
meterings Cyclic Meter Period 0 1 s [0 : 3600]

Not implemented Synchronization Event 0 N/A [0 : 3600]

IEC 870-5-104 NOTES
Note 1: Cyclic Meter Period 0 value means no spontaneous meterings

SETPOINT > PRODUCT SETUP > FAULT REPORT

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Positive sequence impedance module Pos Seq Module 3.00 0.01 Ohm [0.01 : 250.00]
Positive sequence impedance angle Pos Seq Angle 75 1 Deg [25 : 90]
Zero sequence impedance module Zero Seq Module 9.00 0.01 Ohm [0.01 : 750.00]
Zero sequence impedance angle Zero Seq Angle 75 1 Deg [25 : 90]
Line length Line Length 100.0 0.1 [0.0 : 2000.0]
Display fault on HMI Show Fault On HMI DISABLED N/A [DISABLED – ENABLED]
Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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PRODUCT SETUP > MODBUS USER MAP

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Address 00 for Modbus user map Address 00 0 N/A [0000 : FFFF]
Address 01 for Modbus user map Address 01 0 N/A [0000 : FFFF]

... ... ...
Address 254 for Modbus user map Address 254 0 N/A [0000 : FFFF]
Address 255 for Modbus user map Address 255 0 N/A [0000 : FFFF]

SETPOINT > PRODUCT SETUP > OSCILLOGRAPHY

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function Permission Function ENABLED N/A [DISABLED – ENABLED]
Prefault Trigger Position 30 1% [5 : 95]
Samples per cycle Samples/Cycle 64 N/A [4 – 8 – 16 –32 – 64]
Maximum number of oscillos Max. Number Osc. 4 1 oscillo [1 : 20]
Automatic oscillography overwrite Automatic Overwrite DISABLED N/A [DISABLED – ENABLED]
Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PRODUCT SETUP > DATA LOGGER

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Data logger Rate Data Logger Rate 1 s N/A [1 s, 5 min, 10 min, 15 min, 
20 min, 30 min, 60 min.]

Data Logger analog channels X Data Logger Chnl X None N/A

SETPOINT > PRODUCT SETUP > DEMAND

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Demand Function DISABLED N/A [DISABLED – ENABLED]

Demand method for current values CRNT Demand 
Method

THERMAL 
EXPONENTIAL N/A

[BLOCK INTERVAL -
ROLLING DEMAND -
THERMAL 
EXPONENTIAL]

Demand method for Power values POWER Demand 
Method

THERMAL 
EXPONENTIAL N/A

[BLOCK INTERVAL -
ROLLING DEMAND -
THERMAL 
EXPONENTIAL]

Demand interval Demand Interval 5 Minutes N/A [5 – 10 – 15 – 20– 30–60]
Trigger Enabled Trigger Enabled DISABLED N/A [DISABLED – ENABLED]
Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > SYSTEM SETUP > GENERAL SETTINGS

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Phase CT ratio Phase CT Ratio 1.0 0.1 [1.0 : 6000.0]
Ground CT ratio Ground CT Ratio 1.0 0.1 [1.0 : 6000.0]
Sensitive ground CT ratio Stv Ground CT Ratio 1.0 0.1 [1.0 : 6000.0]
Phase VT ratio Phase VT Ratio 1.0 0.1 [1.0 : 6000.0]
Phase VT connection Phase VT Connection WYE N/A [WYE – DELTA]
Rated voltage Nominal Voltage 100.0 0.1 [1.0 : 250.0]
Rated Frequency Nominal Frequency 50 Hz Hz [50-60]
Phase rotation Phase Rotation ABC N/A [ABC – ACB]
Frequency reference Frequency Reference VI N/A [VI-VII-VIII]
Auxiliary Voltage Auxiliary Voltage VX N/A [VX – VN]
Snapshot Event generation Snapshot Events DISABLED N/A [DISABLED – ENABLED]

SETPOINT > SYSTEM SETUP > FLEX CURVES
FLEX CURVES A > FLEX CURVES B> FLEX CURVES C > FLEX CURVES D

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Values for reset points 0.00 pkp Time 0.00xPKP [RST] 0.000 0.001 s [0.000 : 65.535]
Values for reset points 0.05 pkp Time 0.05xPKP [RST] 0.000 0.001 s [0.000 : 65.535]
… … … 0.001 s [0.000 : 65.535]
Values for reset points 0.97 pkp Time 0.97xPKP [RST] 0.000 0.001 s [0.000 : 65.535]
Values for reset points 0.98 pkp Time 0.98xPKP [RST] 0.000 0.001 s [0.000 : 65.535]
Values for operation points 1.03 pkp Time 1.03xPKP [OP] 0.000 0.001 s [0.000 : 65.535]
Values for operation points 1.05 pkp Time 1.05xPKP [OP] 0.000 0.001 s [0.000 : 65.535]
… … … 0.001 s [0.000 : 65.535]
Values for operation points 19.50 pkp Time 19.50xPKP [OP] 0.000 0.001 s [0.000 : 65.535]
Values for operation points 20.00 pkp Time 20.00xPKP [OP] 0.000 0.001 s [0.000 : 65.535]
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SETPOINT > SYSTEM SETUP > BREAKER > BREAKER SETTINGS

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Number of Switchgear selected as 
breaker Number of Switchgear 1 1 [1 : 16]

Maximum value of KI2t Maximum KI2t 9999.99 0.01(KA)2 
s [0.00 : 9999.99]

KI2t integration time KI2t Integ. Time 0.03 0.01s [0.03 : 0.25]
Maximum number of openings Maximum Openings 9999 1 [0 : 9999]
Maximum Openings in one hour Max.Openings 1 hour 40 1 [1 : 60]
Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > SYSTEM SETUP > BREAKER > BREAKER MAINTENANCE

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

KI2t Counter Phase A KI2t BKR Ph A Cnt 0.00 0.01 (KA)2 
s [0.00 : 9999.99]

KI2t Counter Phase B KI2t BKR Ph B Cnt 0.00 0.01 (KA)2 
s [0.00 : 9999.99]

KI2t Counter Phase C KI2t BKR Ph C Cnt 0.00 0.01 (KA)2 
s [0.00 : 9999.99]

Openings counter BKR Openings Cnt 0 1 [0 : 9999]
Closings counter BKR Closings Cnt 0 1 [0 : 9999]

SETPOINT > SYSTEM SETUP > SWITCHGEAR

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Snapshot Event generation for 
switchgear  #1

Snapshot Events 
SWGR 1 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #2

Snapshot Events 
SWGR 2 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #3

Snapshot Events 
SWGR 3 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #4

Snapshot Events 
SWGR 4 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #5

Snapshot Events 
SWGR 5 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #6

Snapshot Events 
SWGR 6 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #7

Snapshot Events 
SWGR 7 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #8

Snapshot Events 
SWGR 8 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #9

Snapshot Events 
SWGR 9 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #10

Snapshot Events 
SWGR 10 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #11

Snapshot Events 
SWGR 11 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #12

Snapshot Events 
SWGR 12 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #13

Snapshot Events 
SWGR 13 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #14

Snapshot Events 
SWGR 14 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #15

Snapshot Events 
SWGR 15 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear  #16

Snapshot Events 
SWGR 16 DISABLED N/A [DISABLED – ENABLED]
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SETPOINT > PROTECTION ELEMENTS > PHASE CURRENT >
> PHASE TOC HIGH > PHASE TOC HIGH 1> PHASE TOC HIGH 2 > PHASE TOC HIGH 3
> PHASE TOC LOW > PHASE TOC LOW 1 > PHASE TOC LOW 2 > PHASE TOC LOW 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Input type Input PHASOR(DFT) N/A [PHASOR – RMS]
Pickup level Pickup Level 1.00 0.01 A [0.05 : 160.00]
Curve shape Curve IEEE Ext Inv N/A [See list of curves]
Time Dial TD Multiplier 1.00 0.01 s [0.00 : 900.00]

Reset type Reset INSTANTANEOUS N/A [INSTANTANEOUS – 
LINEAR]

Voltage Restraint Voltage Restraint DISABLED N/A [DISABLED – ENABLED]
Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > PHASE CURRENT >
> PHASE IOC HIGH > PHASE IOC HIGH 1> PHASE IOC HIGH 2 > PHASE IOC HIGH 3
> PHASE IOC LOW > PHASE IOC LOW 1 > PHASE IOC LOW 2 > PHASE IOC LOW 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Input type Input PHASOR(DFT) N/A [Phasor – RMS]
Pickup level Pickup Level 30.00 0.01 A [0.05 : 160.00]
Trip time Trip Delay 0.00 0.01 s [0.00 : 900.00]
Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > PHASE CURRENT > PHASE DIRECTIONAL >
PHASE DIRECTIONAL 1> PHASE DIRECTIONAL 2 > PHASE DIRECTIONAL 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Maximum Torque Angle MTA 45 1 Deg [-90 : +90]
Operation Direction Direction FORWARD N/A [FORWARD – REVERSE]
Block logic Block Logic PERMISSION N/A [BLOCK – PERMISSION]
Polarization voltage threshold Pol V Threshold 40 1 V [0 : 300]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > PHASE CURRENT > THERMAL MODEL >
THERMAL MODEL 1> THERMAL MODEL 2 > THERMAL MODEL 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Heating constant Heat Time Constant 6.0 0.1 min [3.0 : 600.0]

Cooling constant Cool Time Constant 2.00
0.01 times 
Heat Time 
Ct.

[1.00 : 6.00]

Pickup level Pickup Level 1.00 0.01 A [0.05 : 160.00]
Alarm level Alarm Level 80.0 0.10% [1.0 : 110.0]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > PROTECTION ELEMENTS > NEUTRAL CURRENT > NEUTRAL TOC
NEUTRAL TOC 1> NEUTRAL TOC 2 > NEUTRAL TOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Pickup level Pickup Level 1.00 0.01 A [0.05 : 160.00]
Curve shape Curve IEEE Ext Inv N/A [See list of curves]
Time Dial TD Multiplier 1.00 0.01 s [0.00 : 900.00]

Reset type Reset INSTANTANEOUS N/A [INSTANTANEOUS – 
LINEAR]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > NEUTRAL CURRENT > NEUTRAL IOC
NEUTRAL IOC 1> NEUTRAL IOC 2 > NEUTRAL IOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Pickup level Pickup Level 30.00 0.01 A [0.05 : 160.00]
Trip time Trip Delay 0.00 0.01 s [0.00 : 900.00]
Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > NEUTRAL CURRENT > NEUTRAL DIRECTIONAL >
NEUTRAL DIRECTIONAL 1> NEUTRAL DIRECTIONAL 2 > NEUTRAL DIRECTIONAL 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Maximum Torque Angle MTA -45 1 Deg [-90 : +90]
Operation Direction Direction FORWARD N/A [FORWARD – REVERSE]

Polarization type Polarization VO N/A [V0 – IP – V0+IP – V0*IP ]

Block logic type Block Logic PERMISSION N/A [BLOCK – PERMISSION]
Polarization voltage threshold Pol V Threshold 10 1 V [0 : 300]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > GROUND CURRENT > GROUND TOC
GROUND TOC 1> GROUND TOC 2 > GROUND TOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Input type Input PHASOR(DFT) N/A [PHASOR – RMS]
Pickup level Pickup Level 1.00 0.01 A [0.05 : 160.00]
Curve shape Curve IEEE Ext Inv N/A [See list of curves]
Time Dial TD Multiplier 1.00 0.01 s [0.00 : 900.00]

Reset type Reset INSTANTANEOUS N/A [INSTANTANEOUS – 
LINEAR]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > PROTECTION ELEMENTS > GROUND CURRENT > GROUND IOC
GROUND IOC 1> GROUND IOC 2 > GROUND IOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Input type Input PHASOR(DFT) N/A [PHASOR – RMS]
Pickup level Pickup Level 30.00 0.01 A [0.05 : 160.00]
Trip time Trip Delay 0.00 0.01 s [0.00 : 900.00]
Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > GROUND CURRENT > GROUND DIRECTIONAL >
GROUND DIRECTIONAL 1> GROUND DIRECTIONAL 2 > GROUND DIRECTIONAL 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Maximum Torque Angle MTA -45 1 Deg [-90 : +90]
Operation Direction Direction FORWARD N/A [FORWARD – REVERSE]

Polarization type Polarization VO N/A [V0 – IP – V0+IP – V0*IP ]

Block logic type Block Logic PERMISSION N/A [BLOCK – PERMISSION]
Polarization voltage threshold Pol V Threshold 10 1 V [0 : 300]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > SENSITIVE GROUND CURRENT > SENSITIVE GROUND TOC
SENSITIVE GROUND TOC 1> SENSITIVE GROUND TOC 2 > SENSITIVE GROUND TOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Input type Input PHASOR(DFT) N/A [PHASOR – RMS]
Pickup level Pickup Level 0.050 0.001 A [0.005 : 16.000]
Curve shape Curve IEEE Ext Inv N/A [See list of curves]
Time Dial TD Multiplier 1.00 0.01 s [0.00 : 900.00]

Reset type Reset INSTANTANEOUS N/A [INSTANTANEOUS – 
LINEAR]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > PROTECTION ELEMENTS > SENSITIVE GROUND CURRENT > SENSITIVE GROUND IOC
SENSITIVE GROUND IOC 1> SENSITIVE GROUND IOC 2 > SENSITIVE GROUND IOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Input type Input PHASOR(DFT) N/A [PHASOR – RMS]
Pickup level Pickup Level 0.100 0.001 A [0.005 : 16.000]
Trip time Trip Delay 0.00 0.01 s [0.00 : 900.00]
Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > SENSITIVE GROUND CURRENT > ISOLATED GROUND IOC
ISOLATED GROUND IOC 1> ISOLATED GROUND IOC 2 > ISOLATED GROUND IOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function Permission Function DISABLED N/A [DISABLED – ENABLED]
High Voltage level Vh Level 20 1 V [2 : 70]
Low Current level Il LEVEL 0.005 0.001 A [0.005 : 0.400]
Low Voltage level Vl LEVEL 2 1 V [2 : 70]
High Current level Ih LEVEL 0.025 0.001 A [0.005 : 0.400]
Operation time Delay 0.00 0.01 s [0.00 : 900.00]
Deviation time to instantaneous Time to inst 0.00 0.01 s [0.00 : 900.00]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > SENSITIVE GROUND CURRENT > SENSITIVE GROUND DIRECTIONAL >
SENSITIVE GROUND DIRECTIONAL 1> SENSITIVE GROUND DIRECTIONAL 2 > SENSITIVE GROUND DIRECTIONAL 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Maximum Torque Angle MTA -45 1 Deg [-90 : +90]
Operation Direction Direction FORWARD N/A [FORWARD – REVERSE]
Block logic type Block Logic PERMISSION N/A [BLOCK – PERMISSION]
Polarization voltage threshold Pol V Threshold 10 1 V [0 : 300]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > NEGATIVE SEQUENCE CURRENT > NEGATIVE SEQUENCE TOC >
NEGATIVE SEQUENCE TOC 1> NEGATIVE SEQUENCE TOC 2 > NEGATIVE SEQUENCE TOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Pickup level Pickup Level 1.00 0.01 A [0.05 : 160.00]
Curve shape Curve IEEE Ext Inv N/A [See list of curves]
Time Dial TD Multiplier 1.00 0.01 s [0.00 : 900.00]

Reset type Reset INSTANTANEOUS N/A [INSTANTANEOUS – 
LINEAR]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > PROTECTION ELEMENTS > VOLTAGE ELEMENTS > PHASE UV >
PHASE UV 1> PHASE UV 2 > PHASE UV 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Input mode Mode PHASE-PHASE N/A [PHASE-PHASE, PHASE-
GROUND]

Pickup Level Pickup Level 10 1 V [3 : 300]

Curve shape Curve DEFINITE TIME N/A [DEFINITE TIME – 
INVERSE TIME]

Time Dial Delay 10.00 0.01 s [0.00 : 900.00]
Minimum Voltage Threshold Minimum Voltage 5 1 V [0 : 300]

Operation logic Logic ANY PHASE N/A [ANY PHASE – TWO 
PHASES – ALL PHASES]

Supervision by breaker status Supervised by 52 DISABLED N/A [DISABLED – ENABLED]
Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > VOLTAGE ELEMENTS > PHASE OV >
PHASE OV 1> PHASE OV 2 > PHASE OV 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Pickup Level Pickup Level 10 1 V [3 : 300]
Trip time Trip Delay 10.00 0.01 s [0.00 : 900.00]
Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]

Operation logic Logic ANY PHASE N/A [ANY PHASE – TWO 
PHASES – ALL PHASES]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > VOLTAGE ELEMENTS >
>NEUTRAL OV HIGH > NEUTRAL OV HIGH 1> NEUTRAL OV HIGH 2 > NEUTRAL OV HIGH 3
>NEUTRAL OV LOW > NEUTRAL OV LOW 1> NEUTRAL OV LOW 2 > NEUTRAL OV LOW 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Pickup Level Pickup Level 10 1 V [3 : 300]
Trip time Trip Delay 10.00 0.01 s [0.00 : 900.00]
Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]
Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > PROTECTION ELEMENTS > NEGATIVE SEQUENCE OV >
NEGATIVE SEQUENCE OV 1> NEGATIVE SEQUENCE OV 2 > NEGATIVE SEQUENCE OV 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Pickup Level Pickup Level 10 1 V [3 : 300]
Trip time Trip Delay 10.00 0.01 s [0.00 : 900.00]
Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]
Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > AUXILIARY UV >
AUXILIARY UV 1> AUXILIARY UV 2 > AUXILIARY UV 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Pickup Level Pickup Level 10 1 V [3 : 300]

Curve shape Curve DEFINITE TIME N/A [DEFINITE TIME – 
INVERSE TIME]

Time Dial Delay 10.00 0.01 s [0.00 : 900.00]
Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > POWER > FORWARD POWER
FORWARD POWER 1> FORWARD POWER 2 > FORWARD POWER 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Block from off-line Blk Time After Close 0.00 0.01 s [0.00 : 900.00]
Pickup level for stage 1 Stage 1 Tap 10.00 0.01MW [0.00 : 10000.00]
Trip time for stage 1 Stage 1 Time 60.00 0.01 s [0.00 : 900.00]
Pickup level for stage 2 Stage 2 Tap 20.00 0.01MW [0.00 : 10000.00]
Trip time for stage 2 Stage 2 Time 60.00 0.01 s [0.00 : 900.00]
Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > POWER > DIRECTIONAL POWER>
DIRECTIONAL POWER 1> DIRECTIONAL POWER 2 > DIRECTIONAL POWER 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Block from off-line Blk Time After Close 0.00 0.01 s [0.00 : 900.00]
Directional Angle for stage 1 Dir Power Angle 1 0.00 1 Deg [0.00 : 359.99]
Pickup level for stage 1 Stage 1 Tap 10.00 0.01MW [-10000.00 : 10000.00]
Trip time for stage 1 Stage 1 Time 60.00 0.01 s [0.00 : 900.00]
Directional Angle for stage 2 Dir Power Angle 2 0.00 1 Deg [0.00 : 359.99]
Pickup level for stage 2 Stage 2 Tap 20.00 0.01MW [-10000.00 : 10000.00]
Trip time for stage 2 Stage 2 Time 60.00 0.01 s [0.00 : 900.00]
Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > CONTROL ELEMENTS > SETTING GROUP

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Setting Grouping Permission Function DISABLED N/A [DISABLED – ENABLED]

Active Group Active Group GROUP 1 N/A [GROUP 1 – GROUP 2 – 
GROUP 3]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > CONTROL ELEMENTS > UNDERFREQUENCY
UNDERFREQUENCY 1 > UNDERFREQUENCY 2 > UNDERFREQUENCY 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Pickup level Pickup Level 49.50 0.01 Hz [20.00 : 65.00]
Trip time Trip Delay 0.00 0.01 s [0.00 : 900.00]
Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]
Minimum voltage threshold Minimum Voltage 30 1 V [30 : 300]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > CONTROL ELEMENTS > OVERFREQUENCY
OVERFREQUENCY 1 > OVERFREQUENCY 2 > OVERFREQUENCY 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Pickup level Pickup Level 50.50 0.01 Hz [20.00 : 65.00]
Trip time Trip Delay 0.00 0.01 s [0.00 : 900.00]
Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]
Minimum voltage threshold Minimum Voltage 30 1 V [30 : 300]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > CONTROL ELEMENTS > SYNCHROCHECK

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Dead bus voltage level Dead Bus Level 10.00 0.01 V [0.00 : 300.00]
Live bus voltage level Live Bus Level 50.00 0.01 V [0.00 : 300.00]
Dead line voltage level Dead Line Level 10.00 0.01 V [0.00 : 300.00]
Live line voltage level Live Line Level 50.00 0.01 V [0.00 : 300.00]
Voltage Difference Max Volt Difference 10.00 0.01 V [2.00 : 300.00]
Angle Difference Max Angle Difference 10.0 0.1 Deg [2.0 : 80.0]
Frequency Slip Max Freq Difference 20 10 mHz [10 : 5000]
Breaker Closing time Time 0.50 0.01 s [0.01 : 600.00]
Dead Line – Dead Bus Function 
permission DL-DB Function DISABLED N/A [DISABLED – ENABLED]

Live Line – Dead Bus Function 
permission LL-DB Function DISABLED N/A [DISABLED – ENABLED]

Dead Line – Live Bus Function 
permission DL-LB Function DISABLED N/A [DISABLED – ENABLED]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > CONTROL ELEMENTS > AUTORECLOSE

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Maximum Number of shots Max Number Shots 1 N/A [1 : 4]
Dead time 1 Dead Time 1 0.00 0.01 s [0.00 : 900.00]
Dead time 2 Dead Time 2 0.00 0.01 s [0.00 : 900.00]
Dead time 3 Dead Time 3 0.00 0.01 s [0.00 : 900.00]
Dead time 4 Dead Time 4 0.00 0.01 s [0.00 : 900.00]
Reclaim time or reset lockout delay Reclaim Time 0.00 0.01 s [0.00 : 900.00]
Reclose conditions permission Cond. Permission DISABLED N/A [DISABLED – ENABLED]
Hold time Hold Time 0.00 0.01 s [0.00 : 900.00]
Reset time Reset Time 0.00 0.01 s [0.00 : 900.00]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > CONTROL ELEMENTS > VT FUSE FAILURE

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > CONTROL ELEMENTS > LOCKED ROTOR
BROKEN CONDUCTOR 1 >BROKEN CONDUCTOR 2 >BROKEN CONDUCTOR 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Tap Level in percentage of I2/I1 Tap 20 0.10% [20.0 : 100.0]
Trip Time Trip Delay 60 0.01 s [0.00 : 900.00]
Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
Current Inhibition Level setting Operation Threshold 0.005 0.001 A [0.000 : 1.000]
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SETPOINT > CONTROL ELEMENTS > LOCKED ROTOR
LOCKED ROTOR 1 >LOCKED ROTOR 2 >LOCKED ROTOR 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]
Input type Input PHASOR(DFT)  N/A [PHASOR – RMS]
Full load current Full Load Current 0.5 KA [0.10 : 10.00]
Pickup level Pickup Level 1.01  N/A [1.01 : 109.00]
Trip time Trip Delay 0 s [0.00 : 900.00]
Reset time Reset Delay 0 s [0.00 : 900.00]
Snapshot event generation Snapshot Events ENABLED  N/A [DISABLED – ENABLED]

SETPOINT > INPUTS/OUTPUTS > CONTACT I/O >
BOARD F > BOARD G > BOARD H > BOARD J

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE
USER 
VALUE

I/O board type (available only for CIO 
modules) I/O Board Type_H NONE N/A

[NONE,
16 INP + 8OUT,
8 INP + 8OUT + SUPV]

Input activation voltage threshold 
Group A

Voltage Threshold 
A_X 80 1 V [0 : 255]

Input activation voltage threshold 
Group B

Voltage Threshold 
B_X 80 1 V [0 : 255]

Debounce time for Group A Debounce Time A_X 15 1 ms [1 : 50]
Debounce time for Group B Debounce Time B_X 15 1 ms [1 : 50]

Input type Input Type_X_CCY 
(CCY) POSITIVE N/A

[POSITIVE-EDGE,
NEGATIVE-EDGE,
POSITIVE,
NEGATIVE]

Input signal time delay Delay Input 
Time_X_CCY (CCY) 0 1 ms [0 : 60000]

Output logic type Output Logic_X_0Z POSITIVE N/A
[POSITIVE,
NEGATIVE]

Output type Output Type_X_0Z NORMAL N/A
[NORMAL,
PULSE,
LATCH]

Output pulse length Pulse Output 
Time_X_0Z 10000 1 ms [0 : 60000]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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NOTE 2: DESCRIPTION OF X, Y AND Z IN INPUT/OUTPUT BOARDS

X 
F, G, H or J, the I/O board name, depending on the Relay model.
F and G are internal Relay boards, and H and J are additional boards available in CIO 
modules (remote Bus CAN I/O module). 

For the I/O board selection in the relay 
model:

I/O BOARD TYPE

ASSOCIATED DIGIT
ENERVISTA 650 
SETUP BOARD 
SETTINGS

BOARD 
TYPE

0 NONE None
1 16 INP+ 8OUT Mixed

2 8 INP +8 OUT 
+SUPV

Supervisio
n

CCY
Is the name used for inputs in I/O boards
Mixed, 16 digital inputs: CC1….CC16
Supervision: 8 digital inputs: CC1,..., CC8

0Z Is the name used for the different outputs in I/O boards, 8 outputs available for any of 
the two types of board (01,…., 08)

LIST OF TIME OVERCURRENT CURVES AVAILABLE IN 
F650
IEEE extremely/very/moderately inverse
IEC Curve A/B/C/Long-Time Inverse/ Short-Time Inverse
IAC extremely/very/normally/moderately inverse
ANSI extremely/very/normally/moderately inverse
I2t
Definite time
Rectifier curve
User Curve - FlexCurve™ A/B/C/D
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B.1.2 FACTORY DEFAULT CONFIGURATION

NOTE:
SOURCE COLUMN:
This columns allow selecting the simple or complex (OR signal or Virtual output) operand that actives the selected
elements on relay configuration
If more than one operands are selected, the relay performs an OR gate with them to activate the selected element.
SIGNAL LOGIC COLUMN:
Refers to each individual signal selected on its left. NOT legend means that the refered signal is inverted
SOURCE LOGIC COLUMN:
Refers to the whole SOURCE  signal selected on its left. NOT legend means that SOURCE signal is inverted
If more than one operand were selected, the OR gate output is inverted

SETPOINT>RELAY CONFIGURATION>OUTPUTS
OUTPUT ID OUTPUT NAME SOURCE SIGNAL

LOGIC
SOURCE
LOGIC

CONT OP OPER_F_01 79 BLOCKED AR BLOCK BY LEVEL

CONT OP OPER_F_02 27/59 PKP
VO_046_59P_PKP
VO_045_27P_PKP

CONT OP OPER_F_03 50/67G PKP VO_048_50G_PKP
CONT OP OPER_F_04 51/67G PKP VO_049_51G_PKP

CONT OP OPER_F_05 50/67P PKP
VO_051_50PH_PKP
VO_050_50PL_PKP

CONT OP OPER_F_06 51/67P PKP VO_053_51P_PKP

CONT OP OPER_F_07 RECLOSE
OPERATION BIT 1
AR CLOSE BREAKER

CONT OP OPER_F_08 TRIP
OPERATION BIT 2
VO_083_GENERAL_TRIP

CONT OP OPER_G_01 81U/81O TRIP VO_082_ALL_FREQUENCY_TRIP
CONT OP OPER_G_02 27/59 TRIP VO_079_ALL_OVERVOLTAGE_TRIP
CONT OP OPER_G_03 50/67G TRIP VO_068_50G_TRIP
CONT OP OPER_G_04 51/67G TRIP VO_067_51G_TRIP

CONT OP OPER_G_05 50/67P TRIP
VO_059_50PL_TRIP
VO_058_50PH_TRIP

CONT OP OPER_G_06 51/67P TRIP VO_057_51P_TRIP
CONT OP OPER_G_07 RCLS IN PROG AR RCL IN PROGRESS
CONT OP OPER_G_08 RCLS LOCKOUT AR LOCKOUT
CONT OP RESET_F_01 Not Configured
CONT OP RESET_F_02 Not Configured
CONT OP RESET_F_03 Not Configured
CONT OP RESET_F_04 Not Configured
CONT OP RESET_F_05 Not Configured
CONT OP RESET_F_06 Not Configured
CONT OP RESET_F_07 Not Configured
CONT OP RESET_F_08 Not Configured
CONT OP RESET_G_01 Not Configured
CONT OP RESET_G_02 Not Configured
CONT OP RESET_G_03 Not Configured
CONT OP RESET_G_04 Not Configured
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CONT OP RESET_G_05 Not Configured
CONT OP RESET_G_06 Not Configured
CONT OP RESET_G_07 Not Configured
CONT OP RESET_G_08 Not Configured

SETPOINT>RELAY CONFIGURATION>LEDS

LED ID LED NAME SOURCE SIGNAL
LOGIC

SOURCE
LOGIC

LED01 TRIP VO_083_GENERAL_TRIP
LED02 50/51P TRIP VO_019_PHASE_OVERCURRENT_TRIP
LED03 50/51G TRIP VO_069_GROUND_OVERCURRENT_TRIP
LED04 27 TRIP VO_073_27P_TRIP
LED05 59 TRIP VO_074_59P_TRIP
LED06 PICKUP VO_085_GENERAL_PKP
LED07 50/51P PICKUP VO_007_PHASE_OVERCURRENT_PKP
LED08 50/51G PICKUP VO_009_GROUND_OVERCURRENT_PKP
LED09 27 PICKUP VO_045_27P_PKP
LED10 59 PICKUP VO_046_59P_PKP
LED11 79 READY AR READY
LED12 79 IN-PROG AR RCL IN PROGRESS
LED13 79 BLOCK AR BLOCK BY LEVEL
LED14 79 INHIBIT AR CONDS INPUT NOT
LED15 79 LOCKOUT AR LOCKOUT

SETPOINT>RELAY CONFIGURATION>PROTECTION ELEMENTS

PROTECTION ELEMENT SOURCE SIGNAL
LOGIC

SOURCE
LOGIC

LED RESET INPUT OPERATION BIT 3

PH IOC1 HIGH A BLK

GROUP 1 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR1 A OP NOT
LATCHED VIRT IP 1

PH IOC1 HIGH B BLK

GROUP 1 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR1 B OP NOT
LATCHED VIRT IP 1

PH IOC1 HIGH C BLK

GROUP 1 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR1 C OP NOT
LATCHED VIRT IP 1

PH IOC2 HIGH A BLK

GROUP 2 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR2 A OP NOT
LATCHED VIRT IP 1

PH IOC2 HIGH B BLK

GROUP 2 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR2 B OP NOT
LATCHED VIRT IP 1
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PH IOC2 HIGH C BLK

GROUP 2 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR2 C OP NOT
LATCHED VIRT IP 1

PH IOC3 HIGH A BLK

GROUP 3 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR3 A OP NOT
LATCHED VIRT IP 1

PH IOC3 HIGH B BLK

GROUP 3 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR3 B OP NOT
LATCHED VIRT IP 1

PH IOC3 HIGH C BLK

GROUP 3 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR3 C OP NOT
LATCHED VIRT IP 1

PH IOC1 LOW A BLK

GROUP 1 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR1 A OP NOT
LATCHED VIRT IP 2

PH IOC1 LOW B BLK

GROUP 1 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR1 B OP NOT
LATCHED VIRT IP 2

PH IOC1 LOW C BLK

GROUP 1 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR1 C OP NOT
LATCHED VIRT IP 2

PH IOC2 LOW A BLK

GROUP 2 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR2 A OP NOT
LATCHED VIRT IP 2

PH IOC2 LOW B BLK

GROUP 2 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR2 B OP NOT
LATCHED VIRT IP 2

PH IOC2 LOW C BLK

GROUP 2 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR2 C OP NOT
LATCHED VIRT IP 2

PH IOC3 LOW A BLK

GROUP 3 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR3 A OP NOT
LATCHED VIRT IP 2

PH IOC3 LOW B BLK

GROUP 3 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR3 B OP NOT
LATCHED VIRT IP 2
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PH IOC3 LOW C BLK

GROUP 3 BLOCKED
CONT IP_F_CC2 (50P BLOCK)(CC2)
PHASE DIR3 C OP NOT
LATCHED VIRT IP 2

NEUTRAL IOC1 BLOCK
GROUP 1 BLOCKED
NEUTRAL DIR1 OP NOT

NEUTRAL IOC2 BLOCK
GROUP 2 BLOCKED
NEUTRAL DIR2 OP NOT

NEUTRAL IOC3 BLOCK
GROUP 3 BLOCKED
NEUTRAL DIR3 OP NOT

GROUND IOC1 BLOCK

GROUP 1 BLOCKED
CONT IP_F_CC5 (50G BLOCK)(CC5)
GROUND DIR1 OP NOT
LATCHED VIRT IP 3

GROUND IOC2 BLOCK

GROUP 2 BLOCKED
CONT IP_F_CC5 (50G BLOCK)(CC5)
GROUND DIR2 OP NOT
LATCHED VIRT IP 3

GROUND IOC3 BLOCK

GROUP 3 BLOCKED
CONT IP_F_CC5 (50G BLOCK)(CC5)
GROUND DIR3 OP NOT
LATCHED VIRT IP 3

SENS GND IOC1 BLK
GROUP 1 BLOCKED
SENS GND DIR1 OP NOT
LATCHED VIRT IP 4

SENS GND IOC2 BLK
GROUP 2 BLOCKED
SENS GND DIR2 OP NOT
LATCHED VIRT IP 4

SENS GND IOC3 BLK
GROUP 3 BLOCKED
SENS GND DIR3 OP NOT
LATCHED VIRT IP 4

PH TOC1 HIGH A BLK

GROUP 1 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR1 A OP NOT
LATCHED VIRT IP 5

PH TOC1 HIGH B BLK

GROUP 1 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR1 B OP NOT
LATCHED VIRT IP 5

PH TOC1 HIGH C BLK

GROUP 1 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR1 C OP NOT
LATCHED VIRT IP 5

PH TOC2 HIGH A BLK

GROUP 2 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR2 A OP NOT
LATCHED VIRT IP 5
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PH TOC2 HIGH B BLK

GROUP 2 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR2 B OP NOT
LATCHED VIRT IP 5

PH TOC2 HIGH C BLK

GROUP 2 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR2 C OP NOT
LATCHED VIRT IP 5

PH TOC3 HIGH A BLK

GROUP 3 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR3 A OP NOT
LATCHED VIRT IP 5

PH TOC3 HIGH B BLK

GROUP 3 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR3 B OP NOT
LATCHED VIRT IP 5

PH TOC3 HIGH C BLK

GROUP 3 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR3 C OP NOT
LATCHED VIRT IP 5

NEUTRAL TOC1 BLOCK
GROUP 1 BLOCKED
NEUTRAL DIR1 OP NOT

NEUTRAL TOC2 BLOCK
GROUP 2 BLOCKED
NEUTRAL DIR2 OP NOT

NEUTRAL TOC3 BLOCK
GROUP 3 BLOCKED
NEUTRAL DIR3 OP NOT

GROUND TOC1 BLOCK

GROUP 1 BLOCKED
CONT IP_F_CC6 (51G BLOCK)(CC6)
GROUND DIR1 OP NOT
LATCHED VIRT IP 7

GROUND TOC2 BLOCK

GROUP 2 BLOCKED
CONT IP_F_CC6 (51G BLOCK)(CC6)
GROUND DIR2 OP NOT
LATCHED VIRT IP 7

GROUND TOC3 BLOCK

GROUP 3 BLOCKED
CONT IP_F_CC6 (51G BLOCK)(CC6)
GROUND DIR3 OP NOT
LATCHED VIRT IP 7

SENS GND TOC1 BLOCK
GROUP 1 BLOCKED
SENS GND DIR1 OP NOT
LATCHED VIRT IP 8

SENS GND TOC2 BLOCK
GROUP 2 BLOCKED
SENS GND DIR2 OP NOT
LATCHED VIRT IP 8

SENS GND TOC3 BLOCK
GROUP 3 BLOCKED
SENS GND DIR3 OP NOT
LATCHED VIRT IP 8

PHASE UV1 BLOCK GROUP 1 BLOCKED
PHASE UV2 BLOCK GROUP 2 BLOCKED
PHASE UV3 BLOCK GROUP 3 BLOCKED
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NEG SEQ OV1 BLOCK GROUP 1 BLOCKED
NEG SEQ OV2 BLOCK GROUP 2 BLOCKED
NEG SEQ OV3 BLOCK GROUP 3 BLOCKED
THERMAL1 BLOCK GROUP 1 BLOCKED
THERMAL2 BLOCK GROUP 2 BLOCKED
THERMAL3 BLOCK GROUP 3 BLOCKED

PHASE DIR1 BLK INP
GROUP 1 BLOCKED
CONT IP_F_CC4 (67P BLOCK)(CC4)
LATCHED VIRT IP 9

PHASE DIR2 BLK INP
GROUP 2 BLOCKED
CONT IP_F_CC4 (67P BLOCK)(CC4)
LATCHED VIRT IP 9

PHASE DIR3 BLK INP
GROUP 3 BLOCKED
CONT IP_F_CC4 (67P BLOCK)(CC4)
LATCHED VIRT IP 9

NEUTRAL DIR1 BLK INP GROUP 1 BLOCKED
NEUTRAL DIR2 BLK INP GROUP 2 BLOCKED
NEUTRAL DIR3 BLK INP GROUP 3 BLOCKED

GROUND DIR1 BLK INP
GROUP 1 BLOCKED
LATCHED VIRT IP 10

GROUND DIR2 BLK INP
GROUP 2 BLOCKED
LATCHED VIRT IP 10

GROUND DIR3 BLK INP
GROUP 3 BLOCKED
LATCHED VIRT IP 10

NEUTRAL OV1 HIGH BLK
GROUP 1 BLOCKED
LATCHED VIRT IP 12

NEUTRAL OV2 HIGH BLK
GROUP 2 BLOCKED
LATCHED VIRT IP 12

NEUTRAL OV3 HIGH BLK
GROUP 3 BLOCKED
LATCHED VIRT IP 12

NEUTRAL OV1 LOW BLK GROUP 1 BLOCKED
NEUTRAL OV2 LOW BLK GROUP 2 BLOCKED
NEUTRAL OV3 LOW BLK GROUP 3 BLOCKED
AUXILIARY UV1 BLOCK GROUP 1 BLOCKED
AUXILIARY UV2 BLOCK GROUP 2 BLOCKED
AUXILIARY UV3 BLOCK GROUP 3 BLOCKED

PHASE OV1 BLOCK
GROUP 1 BLOCKED
LATCHED VIRT IP 11

PHASE OV2 BLOCK
GROUP 2 BLOCKED
LATCHED VIRT IP 11

PHASE OV3 BLOCK
GROUP 3 BLOCKED
LATCHED VIRT IP 11

AUXILIARY OV1 BLOCK GROUP 1 BLOCKED
AUXILIARY OV2 BLOCK GROUP 2 BLOCKED
AUXILIARY OV3 BLOCK GROUP 3 BLOCKED
NEG SEQ TOC1 BLOCK GROUP 1 BLOCKED
NEG SEQ TOC2 BLOCK GROUP 2 BLOCKED
NEG SEQ TOC3 BLOCK GROUP 3 BLOCKED
OVERFREQ1 BLOCK GROUP 1 BLOCKED
OVERFREQ2 BLOCK GROUP 2 BLOCKED
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OVERFREQ3 BLOCK GROUP 3 BLOCKED
UNDERFREQ1 BLOCK GROUP 1 BLOCKED
UNDERFREQ2 BLOCK GROUP 2 BLOCKED
UNDERFREQ3 BLOCK GROUP 3 BLOCKED
SETT GROUPS BLOCK Not Configured
BROKEN CONDUCT1 
BLK GROUP 1 BLOCKED
BROKEN CONDUCT2 
BLK GROUP 2 BLOCKED
BROKEN CONDUCT3 
BLK GROUP 3 BLOCKED

ISOLATED GND1 BLK
GROUP 1 BLOCKED
SENS GND DIR1 OP NOT

ISOLATED GND2 BLK
GROUP 2 BLOCKED
SENS GND DIR2 OP NOT

ISOLATED GND3 BLK
GROUP 3 BLOCKED
SENS GND DIR3 OP NOT

SENS GND DIR1 BLK IP GROUP 1 BLOCKED
SENS GND DIR2 BLK IP GROUP 2 BLOCKED
SENS GND DIR3 BLK IP GROUP 3 BLOCKED
FWD PWR1 BLOCK GROUP 1 BLOCKED
FWD PWR2 BLOCK GROUP 2 BLOCKED
FWD PWR3 BLOCK GROUP 3 BLOCKED

PH TOC1 LOW A BLK

GROUP 1 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR1 A OP NOT
LATCHED VIRT IP 6

PH TOC1 LOW B BLK

GROUP 1 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR1 B OP NOT
LATCHED VIRT IP 6

PH TOC1 LOW C BLK

GROUP 1 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR1 C OP NOT
LATCHED VIRT IP 6

PH TOC2 LOW A BLK

GROUP 2 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR2 A OP NOT
LATCHED VIRT IP 6

PH TOC2 LOW B BLK

GROUP 2 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR2 B OP NOT
LATCHED VIRT IP 6

PH TOC2 LOW C BLK

GROUP 2 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR2 C OP NOT
LATCHED VIRT IP 6

PH TOC3 LOW A BLK

GROUP 3 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR3 A OP NOT
LATCHED VIRT IP 6
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PH TOC3 LOW B BLK

GROUP 3 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR3 B OP NOT
LATCHED VIRT IP 6

PH TOC3 LOW C BLK

GROUP 3 BLOCKED
CONT IP_F_CC3 (51P BLOCK)(CC3)
PHASE DIR3 C OP NOT
LATCHED VIRT IP 6

DIR PWR1 BLOCK GROUP 1 BLOCKED
DIR PWR2 BLOCK GROUP 2 BLOCKED
DIR PWR3 BLOCK GROUP 3 BLOCKED
LOCKED ROTOR1 BLK GROUP 1 BLOCKED
LOCKED ROTOR2 BLK GROUP 2 BLOCKED
LOCKED ROTOR3 BLK GROUP 3 BLOCKED
THERMAL1 A RST OPERATION BIT 4
THERMAL1 B RST OPERATION BIT 4
THERMAL1 C RST OPERATION BIT 4
THERMAL2 A RST OPERATION BIT 4
THERMAL2 B RST OPERATION BIT 4
THERMAL2 C RST OPERATION BIT 4
THERMAL3 A RST OPERATION BIT 4
THERMAL3 B RST OPERATION BIT 4
THERMAL3 C RST OPERATION BIT 4
SYNCROCHECK BLK 
INP Not Configured

AR LEVEL BLOCK
CONT IP_F_CC8 (79 BLOCK)(CC8)
LATCHED VIRT IP 14

AR PULSE BLOCK Not Configured
AR PULSE UNBLOCK Not Configured

AR INITIATE
VO_083_GENERAL_TRIP
CONT IP_F_CC7 (79 INITIATE)(CC7)
LATCHED VIRT IP 13

AR CONDS INPUT
SYNCHK CLOSE PERM NOT

NOT
LATCHED VIRT IP 15

BKR FAIL INITIATE Not Configured
RESET KI2t COUNTERS OPERATION BIT 5
RESET BKR COUNTERS OPERATION BIT 5
GROUP 1 ACT ON Not Configured
GROUP 2 ACT ON Not Configured
GROUP 3 ACT ON Not Configured
FAULT REPORT TRIGG VO_083_GENERAL_TRIP
CLEAR FAULT REPORTSNot Configured
DEMAND TRIGGER INP Not Configured
DEMAND RESET INP OPERATION BIT 7
FREEZE ENERGY CNT Not Configured
UNFREEZE ENERGY 
CNT Not Configured

RESET ENERGY CNT OPERATION BIT 6

SETPOINT>RELAY CONFIGURATION>OSCILLOGRAPHY

DIGITAL CHANNELS NAME SOURCE SIGNAL
LOGIC

SOURCE
LOGIC
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DIG_CHANNEL#1 TRIP VO_083_GENERAL_TRIP
DIG_CHANNEL#2 50/51P TRIP VO_019_PHASE_OVERCURRENT_TRIP
DIG_CHANNEL#3 50/51G TRIP VO_069_GROUND_OVERCURRENT_TRIP
DIG_CHANNEL#4 27 TRIP VO_073_27P_TRIP
DIG_CHANNEL#5 59 TRIP VO_074_59P_TRIP
DIG_CHANNEL#6 PICKUP VO_085_GENERAL_PKP
DIG_CHANNEL#7 50/51P PICKUP VO_007_PHASE_OVERCURRENT_PKP
DIG_CHANNEL#8 50/51G PICKUP VO_009_GROUND_OVERCURRENT_PKP
DIG_CHANNEL#9 27 PICKUP VO_045_27P_PKP
DIG_CHANNEL#10 59 PICKUP VO_046_59P_PKP
DIG_CHANNEL#11 79 READY AR READY
DIG_CHANNEL#12 79 IN-PROG AR RCL IN PROGRESS
DIG_CHANNEL#13 79 BLOCK AR BLOCK BY LEVEL
DIG_CHANNEL#14 79 INHIBIT AR CONDS INPUT NOT
DIG_CHANNEL#15 79 LOCKOUT AR LOCKOUT
DIG_CHANNEL#16 Not Configured

OSCILLO TRIGGER OSCILLO TRIGGER
OPERATION BIT 8
VO_083_GENERAL_TRIP

SETPOINT>RELAY CONFIGURATION>OPERATIONS
OPERATION OPERATION TEXT SETTINGS VALUE/SOURCE

Operation1 CLOSE BREAKER

INTERLOCK(LOGIC) SYNCHK CLOSE PERM
FINAL STATES AND(LOGIC) BREAKER CLOSED
FRONT KEY I Key
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT 1000
CHANNELS ALL

Operation2 OPEN BREAKER

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) BREAKER OPEN
FRONT KEY O Key
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT 1000
CHANNELS ALL

Operation3 LEDS RESET

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT 500
CHANNELS ALL

Operation4 THERMAL RESET

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT 500
CHANNELS ALL
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Operation5 BRK COUNTERS 
RESET

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT 500
CHANNELS ALL

Operation6 ENERGY RESET

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT 500
CHANNELS ALL

Operation7 DEMAND RESET

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT 500
CHANNELS ALL

Operation8  TRIGGER OSCILLO

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT 500
CHANNELS ALL

Operation9 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation10 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation11 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured
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Operation12 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation13 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation14 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation15 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation16 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation17 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation18 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured
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Operation19 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation20 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation21 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation22 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation23 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

Operation24 Not configured

INTERLOCK(LOGIC) Not configured
FINAL STATES AND(LOGIC) Not configured
FRONT KEY Not configured
INPUT Not configured
VIRTUAL OUTPUT Not configured
TIMEOUT Not configured
CHANNELS Not configured

SETPOINT>RELAY CONFIGURATION>CONTROL EVENTS

EVENT NAME SOURCE SIGNAL
LOGIC

SOURCE
LOGIC

EV1 Not Configured
EV2 Not Configured
EV3 Not Configured
EV4 Not Configured
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EV5 Not Configured
EV6 Not Configured
EV7 Not Configured
EV8 Not Configured
EV9 Not Configured
EV10 Not Configured
EV11 Not Configured
EV12 Not Configured
EV13 Not Configured
EV14 Not Configured
EV15 Not Configured
EV16 Not Configured
EV17 Not Configured
EV18 Not Configured
EV19 Not Configured
EV20 Not Configured
EV21 Not Configured
EV22 Not Configured
EV23 Not Configured
EV24 Not Configured
EV25 Not Configured
EV26 Not Configured
EV27 Not Configured
EV28 Not Configured
EV29 Not Configured
EV30 Not Configured
EV31 Not Configured
EV32 Not Configured
EV33 Not Configured
EV34 Not Configured
EV35 Not Configured
EV36 Not Configured
EV37 Not Configured
EV38 Not Configured
EV39 Not Configured
EV40 Not Configured
EV41 Not Configured
EV42 Not Configured
EV43 Not Configured
EV44 Not Configured
EV45 Not Configured
EV46 Not Configured
EV47 Not Configured
EV48 Not Configured
EV49 Not Configured
EV50 Not Configured
EV51 Not Configured
EV52 Not Configured
EV53 Not Configured
EV54 Not Configured
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EV55 Not Configured
EV56 Not Configured
EV57 Not Configured
EV58 Not Configured
EV59 Not Configured
EV60 Not Configured
EV61 Not Configured
EV62 Not Configured
EV63 Not Configured
EV64 Not Configured
EV65 Not Configured
EV66 Not Configured
EV67 Not Configured
EV68 Not Configured
EV69 Not Configured
EV70 Not Configured
EV71 Not Configured
EV72 Not Configured
EV73 Not Configured
EV74 Not Configured
EV75 Not Configured
EV76 Not Configured
EV77 Not Configured
EV78 Not Configured
EV79 Not Configured
EV80 Not Configured
EV81 Not Configured
EV82 Not Configured
EV83 Not Configured
EV84 Not Configured
EV85 Not Configured
EV86 Not Configured
EV87 Not Configured
EV88 Not Configured
EV89 Not Configured
EV90 Not Configured
EV91 Not Configured
EV92 Not Configured
EV93 Not Configured
EV94 Not Configured
EV95 Not Configured
EV96 Not Configured
EV97 Not Configured
EV98 Not Configured
EV99 Not Configured
EV100 Not Configured
EV101 Not Configured
EV102 Not Configured
EV103 Not Configured
EV104 Not Configured
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EV105 Not Configured
EV106 Not Configured
EV107 Not Configured
EV108 Not Configured
EV109 Not Configured
EV110 Not Configured
EV111 Not Configured
EV112 Not Configured
EV113 Not Configured
EV114 Not Configured
EV115 Not Configured
EV116 Not Configured
EV117 Not Configured
EV118 Not Configured
EV119 Not Configured
EV120 Not Configured
EV121 Not Configured
EV122 Not Configured
EV123 Not Configured
EV124 Not Configured
EV125 Not Configured
EV126 Not Configured
EV127 Not Configured
EV128 Not Configured

SETPOINT>RELAY CONFIGURATION>SWITCHGEAR

SWITCHGEAR SETTING VALUE/SOURCE SIGNAL
LOGIC

SOURCE
LOGIC

SWITCHGEAR 1

CONTACTS 52b
OPENING TIME 1000
CLOSING TIME 1000
CONTACT A 
SOURCE N/A
CONTACT B 
SOURCE CONT IP_F_CC1 (52b)(CC1)

OPEN TEXT 52 OPEN
ALARM NO
CLOSED TEXT 52 CLOSE
ALARM NO
ERROR 00 TEXT 52 ERROR
ALARM N/A
ERROR 11 TEXT 52 UNDEFINED
ALARM N/A
OPENING INIT OPERATION BIT 2
CLOSING INIT OPERATION BIT 1
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SWITCHGEAR 2

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured

SWITCHGEAR 3

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured

SWITCHGEAR 4

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured
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SWITCHGEAR 5

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured

SWITCHGEAR 6

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured

SWITCHGEAR 7

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured
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SWITCHGEAR 8

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured

SWITCHGEAR 9

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured

SWITCHGEAR 10

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured
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SWITCHGEAR 11

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured

SWITCHGEAR 12

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured

SWITCHGEAR 13

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured
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SWITCHGEAR 14

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured

SWITCHGEAR 15

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured

SWITCHGEAR 16

CONTACTS Not Configured
OPENING TIME Not Configured
CLOSING TIME Not Configured
CONTACT A 
SOURCE Not Configured
CONTACT B 
SOURCE Not Configured

OPEN TEXT Not Configured
ALARM Not Configured
CLOSED TEXT Not Configured
ALARM Not Configured
ERROR 00 TEXT Not Configured
ALARM Not Configured
ERROR 11 TEXT Not Configured
ALARM Not Configured
OPENING INIT Not Configured
CLOSING INIT Not Configured
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APPENDIX C APPENDIX G. C.1MISCELLANEOUS C.1.1 F650 FIRMWARE REVISION HISTORY

FIRMWARE 
VERSION

BOOT 
PROGRAM 
VERSION

CHANGES DESCRIPTION MODELS DATE

1.00 2.00 First version of the product (Basic Model F1G0)
Full protection scheme

F650BABF1G0HI June 28th 
2002

1.11 2.00 New model F2G0 (inputs and outputs board type 2) F650BABF2G0HI October 14th 
2002

1.13 2.20 Snapshot Events included (New and All)
Oscillography up to 4 records. Maximum 70 cycles at 64 samples 
per cycle, trip programmable via PLC.
Broken Conductor protection function included.
Boot program updated through F650PC program

ALL December 
20th 2002

1.14 2.20 DNP 3.0 Level 2 protocol included, over TCP/IP and UDP/IP
IRIG_B synchronization

ALL January 22nd 
2003

1.20 2.25 Programmable Graphical display
Calibration included to improve measurement accuracy

ALL January 28th 
2003

1.30 2.25 Sensitive ground directional unit
Isolated Ground directional unit (in 5th current transformer)
Energy measurements

ALL March 31st 
2003

1.31 2.25 Enhancements in 60 Hz measurements
Extended Settings Range in Negative Sequence Overcurrent 
function (46)

ALL April 9th 2003

1.33 2.30 Forward Power function (32FP)
Demand

ALL May 9th 2003

1.44 2.30 51PL function included (besides existing 51PH)
Control Events
Alarms
ModBus over TCP/IP

ALL July 24th 2003

1.48 2.30 Changes in 67 units in reverse mode
ModBus TCP/IP enhancement

ALL September 
5th 2003

1.50 2.30 PROTECTION
The following operation curves have been added to F650 
functionality:
IEC Long-Time Inverse
IEC Short-Time Inverse
ANSI Extremely Inverse
ANSI Very Inverse
ANSI Normally Inverse
ANSI Moderately Inverse
Rectifier Curve
User Curve A/B/C/D - Flex Curve™
Note: User Curves allow the user to program any non-standard 
curve type by selecting, point by point, the Operation time.

HARDWARE
Voltage Range:Voltage Metering Range expanded from (2 to 200 
Volts) to (2 to 275V)
CIO Module: For those applications requiring a high number of 
inputs and outputs, F650 units can be connected to a CIO module 
(Remote CAN Bus I/O module) for using up to 2 additional boards.

COMMUNICATIONS
ModBus Protocol:
ModBus User Map
Virtual Inputs (control over internal logic variables, which can be 
used in the configurable logic).
DNP 3.0 Protocol
New Metering scale factors
Switchgear bits mapped to binary points
Possibility of restricting the binary points map by setting

USER INTERFACE
HMI Configurable Main Screen:
The main screen offers the possibility to select the initial logo, a 
simplified Metering screen showing primary values, or both.
Snapshot Events:
Possibility of viewing snapshot events from the relay display in 
models without graphical display.

ALL October 31st 
2003
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FIRMWARE 
VERSION

BOOT 
PROGRAM 
VERSION

CHANGES DESCRIPTION MODELS DATE

1.61 2.35 COMMUNICATIONS
Configuration:
LED Reset by communications using the configurable logic

METERING
Monitoring of phasor measurements in module and argument
REGISTER
Snapshot Events:
Possibility of reading the Snapshot events in Binary and ASCII 
format via ModBus
Oscillography:
The oscillography function has been improved to offer the 
possibility of creating up to a maximum of 20 oscillography records, 
with possibility to create concatenated oscillographies.
Oscillography records can be obtained via communications using 
serial messaging (ModBus) or Ethernet (TCP/IP or TFTP).
Fault Report:
This version incorporates the tool to visualize and store the 
information from the last ten faults produced. This report can be 
shown on the relay display. The fault report will be available on the 
relay display and via communications, either on ModBus (serial) or 
TCP/IP.
Data Logger:
It allows registering 16 channels among all the available analog 
measures in the relay. The information provided by the data logger 
can be obtained via TCP/IP.

USER INTERFACE
Fault Report screen on HMI:
Fault report information on display, selectable by setting

WEB SERVER
Web server tool has been upgraded to provide visualization of:

Snapshot Events
Control Events
Alarms
Oscillography
Fault report
Data Logger
Metering

ALL April 30th 
2004

1.62 2.35 Internal file management enhancement.
IP Address maintenance after firmware upgrading.
Latched Virtual Inputs maintenance after powering off and on the 
relay.

ALL June 24th 
2004

1.70 2.35 Multilingual relay (French and English available) F650BABF1G0HIF
F650MFDF2G1LOF
F650MFCF1G1LOF

August 5th 
2004
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FIRMWARE 
VERSION

BOOT 
PROGRAM 
VERSION

CHANGES DESCRIPTION MODELS DATE

1.72 2.35 COMMUNICATIONS
Multimaster DNP (3 masters)

METERING
Measurement enhancement

PROTECTION
Sensitive Directional Power unit is included (32)

REGISTER
Snapshot Events: Possibility to be enabled and disabled by setting.
In previous versions snapshot event generation was enabled by 
default and fixed for all elements.
Using the “config file converter” tool the snapshot event settings will 
be included but to their default value (disabled), user must set the 
snapshot event generation to the desired value. Notice that having 
snapshot event to disabled no internal signals will be recorded in 
the snapshot event buffer.

USER INTERFACE
HMI
Enhanced HMI meeting EnerVista 650 Setup structure.
Multilingual Option available: The relay can be ordered in 
languages different from English, the relay always has English as 
default
Languages Available now:
French/English (F in ordering code request)
English/English  (former ordering code)

ENERVISTA 650 Setup
Multilingual unit (French and English available).
WEB SERVER
Multilingual visualization of snapshot events, control events, 
oscillography, fault recorder, data logger, metering.

ALL November 
26th 2004

1.80 2.35 USER INTERFACE
HMI: 

New languages available: Russian and Spanish.
Russian/English (P in ordering code, basic display only)
Spanish/English (S in ordering code)

ENERVISTA 650 Setup
New languages available: Russian and Spanish.
Passwords included in EnerVista 650 Setup (different from the 
HMI ones).

WEB SERVER
Multilingual visualization of snapshot events, control events, 
oscillography, fault recorder, data logger, metering. New 
languages available: Russian and Spanish.
Visualization Enhancement.

COMMUNICATIONS
Modbus TCP communications enhacement.
External CAN interruptions management enhancement.

METERING
Decimal point included in PT and CT ratios.
Power Factor measurement enhancement.

PROTECTION
Function 48 included.
I2/I1 setting to select the minimum inhibition current level of the 
unit .
TOC operation level at 1.03  times the pickup (1.05 in previous 
releases).
Neutral units measures management enhancement.
Startup Enhancement.

REGISTER
Time Stamp for switchgear control events enhancement.

ALL March 1st 
2005
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FIRMWARE 
VERSION

BOOT 
PROGRAM 
VERSION

CHANGES DESCRIPTION MODELS DATE

2.00 3.00 HARDWARE: 
New options for Real Serial Comm. Board 1:
C: Cable remote CAN bus I/O
M: RS485 + cable remote CAN bus I/O

New options for Rear Ethernet Comm. Board 2:
E: Redundant 10/100 Base TX

New options for I/O Boards (available for slot G and CIO 
modules):
4: 32 digital inputs
5: 16 digital inputs + 8 analog inputs

COMMUNICATIONS
Protocol IEC 61850
GSSE
Client/server implementation.
SNTP Synchronization (Clock time obtained over an Ethernet 
network)

ALL June 30th, 
2005

1.82 4.00 File system management enhancement in boot code 4.00
Measurements enhancement in 1.82 firmware version

All models, 
excepting Options 4 
and 5 for I/O boards.
Option 6 for IEC 
61850 protocol

October 17th 
2005

2.20 4.00 USER INTERFACE
ENERVISTA 650 Setup·

- Data Logger visualization changes.·
- File name available in "Config file converter" tool.

COMMUNICATIONS·
- DNP Scale factor correction.·
- IRIGB synchronization:

- Date and time synchronization available.
- 980 ms delay correction.

INPUTS/OUTPUTS·
- Inputs Activation/Deactivation correction.·
- Voltage threshold setting range from 20 to 230 Vdc.·
- Debounce time settings:

- Timestamp before debounce time
- Setting range from 1 to 50 ms.

METERING·
- Power calculations using ARON method.·
- New measurements provided when using Delta connection 
and VN as auxiliary voltage input:

- Neutral voltage available.
- Phase to ground voltages available.
- Single phase power measurements available.

PROTECTION·
- Neutral, ground and sensitive ground directional units 

available with delta connection and VN as auxiliary voltage 
input.·

- Minor changes in Forward Power elements.

REGISTER·
- Ground current available in Fault report.·
- Corrected 150 ms delay in Snapshot events measurements.

All models, 
excepting Options 4 
and 5 for I/O boards.
Option 6 for IEC 
61850 protocol

November 
25th 2005
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C.1.2 GE MULTILIN WARRANTY

GE MULTILIN RELAY WARRANTY

GE Power Management, S.A. (GE Multilin) warrants each relay it manufactures to be free from defects in
material and workmanship under normal use and service for a period of 24 months from date of shipment from
factory.

In the event of a failure covered by warranty, GE Multilin will undertake to repair or replace the relay providing
the warrantor determined that it is defective and it is returned with all transportation charges prepaid to an
authorized service center or the factory. Repairs or replacement under warranty will be made without charge.

Warranty shall not apply to any relay, which has been subject to misuse, negligence, accident, incorrect
installation, or use not in accordance with instructions nor any unit that has been altered outside a GE Multilin
authorized factory outlet.

GE Multilin is not liable for special, indirect or consequential damages or for loss of profit or for expenses
sustained as a result of a relay malfunction, incorrect application or adjustment.

For complete text of Warranty (including limitations and disclaimers), refer to GE Multilin Standard Conditions
of Sale.
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